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Section 1
Introduction

This manual describes the switch management tools which include the SANbox® 
Manager application (version 1.05) and the Command Line Interface (CLI) for the 
SANbox2®-8c and SANbox2-16 Fibre Channel switches (firmware version 1.5.1).

The SANbox Manager switch management application is the primary focus of this 
manual which is organized as follows:

Section 1 describes the intended audience for this manual, related 
materials, and technical support.
Section 2 describes how to use SANbox Manager, its menus, and its 
displays.
Section 3 describes fabric management tasks.
Section 5 describes switch management tasks.
Section 4 describes port and device management tasks.
Appendix A describes the Telnet command line interface.
Appendix B describes the optional performance monitoring application, 
Fabric View.
Appendix C describes the SANbox Manager error messages.

A glossary of terms and an index are also provided.

1.1
Intended Audience

This manual introduces the switch management products and explains their 
installation and use. It is intended for users responsible for installing and using 
network management tools.

1.2
Related Materials

Refer to the following manuals for switch hardware and installation information:

SANbox2-16 Fibre Channel Switch Installation Guide, publication number 
59021-05.
SANbox2-8c Fibre Channel Switch Installation Guide, publication number 
59042-02.
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1.3
Technical Support

Customers should contact their authorized maintenance provider for technical 
support of their QLogic switch products. QLogic-direct customers may contact 
QLogic Technical Support; others will be redirected to their authorized 
maintenance provider.

Visit the QLogic switch support Web site listed in Contact Information for the latest 
firmware and software updates.

1.3.1
Availability

QLogic Technical Support is available from 7:00 AM to 7:00 PM Central Standard 
Time, Monday through Friday, excluding QLogic-observed holidays.

1.3.2
Training

QLogic offers the following technical training courses:

Switch Certification
HBA Certification

Each course is available at the training facility in Eden Prairie, MN or at your local 
facility. All courses include a Fibre Channel overview and sections on installation, 
maintenance, and topology solutions. Each student receives a set of manuals and 
a CD-ROM containing course training materials. Upon successful completion of 
the training, QLogic awards a certificate identifying the student as a Certified 
SANbox™ or SANblade™ Professional.

1.3.3
Contact Information

Address: QLogic Switch Products Inc.
6321 Bury Drive
Eden Prairie, Minnesota 55346
USA

Telephone: +1 952-932-4040

Fax: +1 952-932-4018

Email:
Technical Service
Technical Training

support@qlogic.com
tech.training@qlogic.com

Switch Support Web Site: support.qlogic.com

support.qlogic.com
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Section 2
Using SANbox Manager

This section describes how to use the SANbox Manager application and its 
menus. The following topics are covered:

Installing SANbox Manager
Starting SANbox Manager
Exiting SANbox Manager
Changing the password for the default fabric view file
Setting SANbox Manager user preferences
Using online help
SANbox Manager user interface
Using the topology display
Using the faceplate display

2.1
Installing SANbox Manager

The SANbox Manager application requires a management workstation with the 
following characteristics:

Table 2-1  Management Workstation Requirements

Operating System Windows® NT, 2000, 95/98
Linux® 6.2 Red Hat®
Solaris™

Memory 128 MB or more

Disk Space 150 MB per installation

Processor 300 MHz or faster

Hardware CD-ROM drive, RS-232 serial port, RJ-45 Ethernet port

Internet Browser Microsoft® Internet Explorer® or Netscape Navigator®
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Your switch was shipped with either a SANsurfer Management Suite Disk or a 
SANbox2 Installation Disk. Refer to the following installation instructions that 
correspond to your situation:

SANsurfer Management Suite Disk - Windows Installation
SANsurfer Management Suite Disk - Linux Installation
SANsurfer Management Suite Disk - Solaris Installation
SANbox2 Installation Disk - Windows Installation
SANbox2 Installation Disk - Linux Installation
SANbox2 Installation Disk - Solaris Installation

2.1.1
SANsurfer Management Suite Disk - Windows Installation

To install the SANbox Manager application on Windows from the SANsurfer® 
Management Suite Disk, do the following:

1. Close all programs currently running, and Insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If the 
SANsurfer Management Suite start page does not open in your default 
browser, do the following:
a. Using Windows Explorer, double-click the drive letter which contains 

the SANsurfer Management Suite Disk. 
b. Locate and double-click the Start_Here.htm file to open the SANsurfer 

Management Suite start page in your default browser.
2. On the SANsurfer Management Suite start page, choose the SANbox 

Switch Software button.
3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 

area. 
4. In the Windows column, choose the SANbox Manager link to open the File 

Download window.
5. You have a choice of running the installation file from the CD-ROM or 

downloading the installation file to your hard drive. Choose one of the 
following:

Open the installation file from the CD-ROM and follow the SANbox 
Manager installation instructions.
Specify a location in which to save the 
sansurfer_windows_install.exe file, and choose the Save button. 
Double-click the saved sansurfer_windows_install.exe file and 
follow the SANbox Manager installation instructions.
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2.1.2
SANsurfer Management Suite Disk - Linux Installation

To install the SANbox Manager application on Linux from the SANsurfer 
Management Suite Disk, do the following:

1. Close all programs currently running, and insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If a file browser 
window opens showing icons for the contents of the CD-ROM, double-click 
the Start_Here.htm file to open the SANsurfer Management Suite start 
page. If a file browser does not open, double-click the CD-ROM icon on the 
to open the browser. If there is no CD-ROM icon, do the following:
a. Open an xterm or other terminal window.
b. Mount the CD-ROM. From a shell prompt, enter the following 

command:
mount /mnt/cdrom

c. Execute your web browser to view the Start_Here.htm document 
using one of the following commands:
$mozilla file:/mnt/cdrom/Start_Here.htm

or
$netscape file:/mnt/cdrom/Start_Here.htm

d. The SANsurfer Management Suite start page opens in your default 
browser.

2. On the SANsurfer Management Suite start page, choose the SANbox 
Switch Software button.

3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 
area. 

4. In the Linux column, choose the SANbox Manager link to open the Save As 
window.

5. Enter a path name to save the sansurfer_linux_install.bin file, and choose 
the Save button.

6. Open a terminal window for the directory in which the 
sansurfer_linux_install.bin file was saved, and enter the following 
command and press the Enter key: 

chmod +x sansurfer_linux_install.bin

7. Enter the following command:
./sansurfer_linux_install.bin

8. Press the Enter key, and follow the SANbox Manager installation 
instructions.
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2.1.3
SANsurfer Management Suite Disk - Solaris Installation

To install the SANbox Manager application on Solaris from the SANsurfer 
Management Suite CD-ROM, do the following:

1. Close all programs currently running, and insert the SANsurfer Management 
Suite Disk into the management workstation CD-ROM drive. If the 
SANsurfer Management Suite start page does not open in your default 
browser, do the following: 
a. Right-click the to open the Workshops Menu.
b. Point to and select Files, then select File Manager.
c. In File Manager, double-click the CD-ROM icon, and then double-click 

the Sansurfer folder.
d. In the Sansurfer folder, double-click the Start_Here.htm file to open 

the SANsurfer Management Suite start page in your default browser.
2. On the SANsurfer Management Suite start page, choose the SANbox 

Switch Software button.
3. On the SANbox Switch Software page, scroll to the SANbox2 (2Gb) Series 

area.
4. In the Solaris column, choose the SANbox Manager link to open the Save 

As window.
5. Enter a path name to save the sansurfer_solaris_install.pkg file and 

choose the Save button.
6. Open a terminal window for the directory in which the 

sansurfer_solaris_install.pkg file was saved, and enter the following 
command: 

chmod +x sansurfer_solaris_install.pkg

7. Press the Enter key.
8. Enter the following command:

./sansurfer_solaris_install.pkg

9. Press the Enter key, and follow the SANbox Manager installation 
instructions.

Note: If you download SANbox Manager from a server, be sure the 
downloaded file has execute permission before installing. 
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2.1.4
SANbox2 Installation Disk - Windows Installation

To install the SANbox Manager application on Windows from the SANbox2 
Installation Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Using Windows Explorer, double-click the drive letter which contains the 
SANbox2 Installation Disk.

3. Double click the SANbox_Manager folder, then double click the Windows 
folder.

4. Double click the executable file and follow the SANbox Manager installation 
instructions.

2.1.5
SANbox2 Installation Disk - Linux Installation

To install the SANbox Manager application on Linux from the SANbox2 Installation 
Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Open the File Manager and double-click on the CD-ROM icon.
3. Double click the SANbox_Manager folder, then double click the Linux folder.
4. Double click the executable file and follow the SANbox Manager installation 

instructions.

2.1.6
SANbox2 Installation Disk - Solaris Installation

To install the SANbox Manager application on Solaris from the SANbox2 
Installation Disk, do the following:

1. Close all programs currently running, and insert the SANbox2 Installation 
Disk into the management workstation CD-ROM drive.

2. Open a terminal window. If the disk isn’t already mounted, enter the 
following command:

mount /mnt/cdrom

3. Move the directory on the disk that contains the executable. Enter the 
following command:

cd cdrom/cdrom0/sanbox~1/solaris

4. Run the executable and follow the SANbox Manager installation instructions. 
Enter the following command:

pkgadd -d sol_pkg



2 – Using SANbox Manager
Starting SANbox Manager

2-6 59022-05 B

Q

2.2
Starting SANbox Manager

To start the SANbox Manager application for the first time, choose one of the 
following methods:

For a Windows platform, double-click the SANbox Manager shortcut, or 
select SANbox Manager from Start menu, depending on how you installed 
the SANbox Manager application. From a command line, you can enter the 
SANbox_Manager command:
> <install_directory>/SANbox_Manager/sanbox_manager

For a Linux platform, enter the SANbox_Manager command with an optional 
switch IP address and account name:
# /SANbox_Manager/SANbox_Manager [ip_address] [account_name]

For a Solaris platform, enter the SANbox_Manager command with an 
optional switch IP address and account name:
/usr/opt/QLGCsol/bin/SANbox_Manager[ip_address][account_name]

The SANbox Manager application opens with the display shown in Figure 2-1.

Figure 2-1   SANbox Manager Window
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If the default fabric view file exists, the system prompts you to enter the file 
password as shown in Figure 2-2. Enter the password and choose the Load View 
File button to open the SANbox Manager application and load a previously saved 
set of fabrics. Otherwise, choose the Continue Without Loading button to open 
an empty fabric view. Choose the Add button to open the Add a New Fabric 
window shown in Figure 2-3.

Figure 2-2   Load Default Fabric View File Window

To start using the SANbox Manager application, do the following to add a fabric:

1. Open the Fabric menu and select Add Fabric to open the Add a New Fabric 
window as shown in Figure 2-3.

Figure 2-3   Add a New Fabric Window

2. Enter a fabric name and the IP address of the switch through which to 
manage the fabric.
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3. Enter an account name and a password. The factory account name is 
"admin" and the factory password is "password". If security is turned off 
(default), you are not required to enter an account name or password. This 
account name is for the switch and is stored in the switch firmware. Refer to 
the User Command on page A-68 for more information.

4. Choose the Add Fabric button.

2.3
Exiting SANbox Manager

When exiting SANbox Manager, the current fabric view is saved to the default 
fabric view file (fc_view.dft). A password is required to save the default fabric view 
file the first time you exit SANbox Manager. When you exit subsequent sessions, 
SANbox Manager closes and saves the default fabric view file automatically 
without having to enter a password.

In your next session, SANbox Manager opens the default fabric view file 
automatically after entering its password. To prevent SANbox Manager from 
automatically loading and saving the default fabric view file between SANbox 
Manager sessions, set the View File Auto Save and Load preferences setting to 
Disable (Enable is the default). Refer to ”Setting Preferences” on page 2-10 for 
more information.

To exit a SANbox Manager application session, open the File menu and select 
Exit. If you have made changes to the view, the system will prompt you to enter a 
password with which to protect the default fabric view file as shown in Figure 2-4. 
Choose one of the following:

Enter a password and choose the Save View File button to save the current 
set of fabrics in the default fabric view file (fc_view.dft) in the working 
directory.
Choose the Exit Without Saving button to exit the application without 
saving the current fabrics to the default fabric view file.
Choose the Cancel Exit button to cancel the exit operation.

Note: A switch supports a combined maximum of 15 logins. This includes 
SANbox Manager inband and out-of-band logins, Application 
Programming Interface (API) inband and out-of-band logins, and 
Telnet logins. Of this 15, there can be a combined maximum of 10 
SANbox Manager and API logins. Additional logins will be refused.
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Figure 2-4   Save Current Fabric View Window

If the default fabric view file was saved with a password, the next time you open 
the SANbox Manager application, you will be prompted for the password in the 
Load Default Fabric View File window as shown in Figure 2-2. Your fabric opens 
after entering the password.

2.4
Uninstalling SANbox Manager

A program to uninstall SANbox Manager was installed as part of the SANbox 
Manager installation process. The Uninstaller Data folder in the Install folder 
contains the uninstall program (Uninstall SANbox Manager). Also, a shortcut/link 
to the uninstall program was installed in the installation directory during the 
SANbox Manager installation process. The default installation directory is 
/QLogic_Corporation/SANbox_Manager.

To uninstall the SANbox Manager application:

1. Browse for the uninstall program file or the shortcut/link that points to the 
uninstall program file. The uninstall program shortcut is in the same folder as 
the program shortcut (Start menu, program group, on, or user specified) that 
is used to start the SANbox Manager application.

2. Double-click the uninstall program file or shortcut/link, and follow the 
instructions to uninstall the SANbox Manager application.

Note: For UNIX uninstalls, execute the link to Uninstall_SANbox_Manager. If 
no links were created during the installation, run: 
$INSTALL_DIR/UninstallerData/Uninstall_SANbox_Manager. Where 
INSTALL_DIR is the directory selected for installation.
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2.5
Changing Default File Password

To change the password for the default fabric view file, do the following:

1. Open the File menu and select Change Default File Password to open the 
Set New Password window as shown in Figure 2-5.

Figure 2-5   Set New Password Window

2. Enter the new password in the Default File Password field.
3. Re-enter the same password in the Re-enter Password to Confirm field.
4. Choose the OK button to save the changes.

2.6
Setting Preferences

Using the Preferences settings, you can:

Change the location of the working directory in which to save files
Change the location of the browser used to view the online help.
Choose the fabric discovery interval. The fabric discovery interval is how 
often the SANbox Manager application receives information from the fabric. 
Choose 30, 45, or 60 seconds.
Enable or disable the default view file auto save and load feature. Refer to 
”Starting SANbox Manager” on page 2-6 for more information on the default 
fabric view file. 
Choose the default port view when opening the faceplate display. Refer to 
”Monitoring Port Status” on page 5-2 for more information on port views.
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Figure 2-6   Preferences Window

To set user preferences for your SANbox Manager sessions, do the following: 

1. Open the File menu, and select Preferences to open the Preferences 
window.

2. Enter or browse for paths to the working directory and browser.
3. In the Application-wide Options area, choose the polling frequency, enable 

or disable the View File Auto Save and Load feature, and choose the initial 
port view when entering the faceplate display.

4. Choose the Apply button to save the changes.

2.7
Using Online Help

Online help is available for the SANbox Manager application and its functions. 
The two ways to open the online help file are: open the Help menu and select 
Help Topics, or choose the Help button in the tool bar.

2.8
Viewing Software Version and Copyright Information

To view SANbox Manager software version and copyright information, open the 
Help menu and select About.... 
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2.9
SANbox Manager User Interface

The SANbox Manager application uses two basic displays to manage the fabric 
and individual switches: the topology display and the faceplate display. The 
topology display shows all switches that are able to communicate and all 
connections between switches. The faceplate display shows the front of a single 
switch and its ports. Both displays share some common elements as shown in 
Figure 2-7.

Figure 2-7   SANbox Manager Display Elements
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2.9.1
Menu Bar

The Menu Bar presents the SANbox Manager menus as shown in Figure 2-8. The 
menus and the tasks offered in them vary depending on the display. For example, 
the Port menu and many of the Switch menu selections, shown in gray, appear 
only in the faceplate display.

Figure 2-8   SANbox Manager Menu Structure
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Some menu selections have shortcut keys as shown in Table 2-2.

In addition to the menu bar, both the topology and faceplate displays have context 
sensitive menus that pop up when you click in the graphic window with the right 
mouse button. Refer to ”Opening the Faceplate Display and Popup Menus” on 
page 2-18 for more information about these popup menus.

2.9.2
Tool Bar

The tool bar consists of a row of graphical buttons that you can use to access 
SANbox Manager functions as shown in Table 2-3. The tool bar buttons are an 
alternative method to using the menu bar. The tool bar can be relocated in the 
display by clicking and dragging the handle at the left edge of the tool bar.

Table 2-2  Menu Shortcut Keys

Shortcut Key Menu Selection

F5 key View>Refresh

Ctrl+O File>Open View File

Table 2-3  Tool Bar Buttons

Tool Bar Button Description

Add Fabric button - adds a new fabric. 

Open View File button - opens an existing fabric view file. 

Save View As button - saves the current fabric view to a file.

Refresh button - updates the topology or faceplate display with 
current information.

Help Topics button - opens the online help file.

Edit Zoning button - opens the Edit Zoning window (available only 
in faceplate display).
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2.9.3
Fabric Tree

The fabric tree lists the managed fabrics and their switches as shown in 
Figure 2-9. The window width can be adjusted by clicking and dragging the 
moveable window border. An entry handle located to the left of an entry in the tree 
indicates that the entry can be expanded. Click this handle or double-click the 
entry to expand or contract a fabric tree entry. A fabric entry expands to show its 
member switches.

Figure 2-9   Fabric Tree

Each fabric tree entry has a small icon next to it that uses color to indicate 
operational status.

A green icon indicates normal operation.
A red icon indicates a potential failure.
A blue icon indicates that a switch is unknown, unreachable, unmanageable, 
or a switch with security enabled when the fabric management switch has 
security disabled.
A yellow icon indicates that a switch is operational with errors.

The fabric tree provides access to the topology and faceplate displays for any 
fabric or switch.

To open the topology display from the fabric tree, click a fabric entry.
To open the faceplate display from the fabric tree, click a switch entry.
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2.9.4
Graphic Window

The graphic window presents graphic information about fabrics and switches such 
as the fabric topology and the switch faceplate. The window length can be 
adjusted by clicking and dragging the window border that it shares with the data 
window.

2.9.5
Data Window and Tabs

The data window presents a table of data and statistics associated with the 
selected tab. Use the scroll bar to browse through the data. The window length 
can be adjusted by clicking and dragging the border that it shares with the graphic 
window. 

Adjust the column width by moving the pointer over the column heading border 
shared by two columns until a right/left arrow graphic is displayed. Click and drag 
the arrow to the desired width.

The data window tabs present options for the type of information to display in the 
data window. These options vary depending on the display.

2.9.6
Working Status Indicator

The working status indicator, located in the lower right corner of SANbox Manager 
window, shows when the management workstation is exchanging information with 
the fabric. As conditions change, the fabric forwards this information to the 
management workstation where it is reflected in the various displays.
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2.10
Using the Topology Display

The topology display shown in Figure 2-10 receives information from the selected 
fabric and displays its topology. Switches and inter-switch links (ISL) appear in the 
graphic window and use color to indicate status. Consider the following topology 
display features:

Switch and link status
Working with switches and links
Topology data windows

Figure 2-10   Topology Display

2.10.1
Switch and Link Status

Switch icon shape and color provide information about the switch and its 
operational state. Lines represent links between switches. The topology display 
uses green to indicate normal operation, yellow to indicate operational with errors, 
red to indicate a potential failure, and blue to indicate unknown, unreachable, or 
unmanageable. Refer to ”Fabric Status” on page 3-7 for more information about 
topology display icons.
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2.10.2
Working with Switches and Links

Switch and link icons are selectable and moveable, and serve as access points for 
other displays and menus. You select switches and links to display information 
about them, modify their configuration, or delete them from the display. The 
context-sensitive popup menus are accessible through the switch and link icons.

2.10.2.1
Selecting Switches and Links

Selected switch icons are highlighted in blue. Selected ISLs are displayed as a 
heavier line. You can select switches and links in the following ways. 

To select a switch or a link, click the icon or link.
To select multiple switches or links, hold down the Control key and select.
To select all switches or links, right-click anywhere in the graphic window 
background. Select Select All Switches or Select All Links from the popup 
menu.

To cancel a selection, press and hold the Control key, and select the item again. 
To cancel all selections, click in the graphic window background.

2.10.2.2
Arranging Switches in the Display

You can arrange individual switch icons in the topology display or allow SANbox 
Manager to arrange all switch icons for you:

To move an individual switch icon, click and drag the icon to another location 
in the graphic window. Links stretch or contract to remain connected.
To arrange all switch icons in the topology display automatically, open the 
View menu and select Layout Topology.

By default, the Toggle Auto Layout box in the View menu is checked which 
causes SANbox Manager to arrange the icons when you select Layout 
Topology.

You can save a custom arrangement, or layout, and restore that layout during a 
SANbox Manager session. Begin by arranging the icons, then open the View 
menu and select Remember Layout. To restore the saved layout, open the View 
menu, uncheck the Toggle Auto Layout box, and select Layout Topology.

2.10.2.3
Opening the Faceplate Display and Popup Menus

The faceplate display shows the front of a single switch and its ports. 

To open the faceplate display when viewing the topology display, click the 
switch entry/icon in the fabric tree, or double-click the switch graphic.
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To open the fabric popup menu when viewing the topology display, right-click 
the graphic window background. The fabric popup menu presents selections 
to refresh the fabric, select all switches, select all links, or layout topology.
To open the switch popup menu when viewing the topology display, 
right-click the switch icon in the graphic window. The switch popup menu 
presents selections to refresh the switch, delete the switch from the display, 
open the Switch Properties window, or open the Network Properties window.
To open the link popup menu, right-click the link. The Link popup menu 
presents a selection to delete the link from the display.
To open a faceplate display popup menu, right-click the faceplate graphic in 
the graphic window. The faceplate popup menu presents the following:

Refresh the switch
Select all ports
Manage switch properties
Manage network properties
Extend credits
Manage port properties
Run the port loopback tests.

2.10.3
Topology Data Windows

The topology display provides the following data windows corresponding to the 
data window tabs:

Name Server – displays all devices logged with the name server and their 
addresses within the current fabric configuration. Refer to ”Name Server 
Data Window” on page 4-3 for more information.
Active Zoneset – displays the active zone set for the fabric including zones 
and their member ports. Refer to ”Active Zone Set Data Window” on 
page 3-9 for more information about this data window. Refer to ”Zoning a 
Fabric” on page 3-10 for information about zone sets and zones.
Switch – displays current network and switch configuration data for the 
selected switches. Refer to ”Switch Data Window” on page 4-4 for more 
information.
Link – displays information about inter-switch links. Refer to ”Link Data 
Window” on page 4-6 for more information.
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2.11
Using the Faceplate Display

The faceplate display shown in Figure 2-11 displays the switch name and 
operational state, and port status. Consider the following functional elements of 
the faceplate display:

Port views and status
Working with ports
Faceplate data windows

Figure 2-11   Faceplate Display

2.11.1
Port Views and Status

Port color and text provides information about the port and its operational state. 
Green indicates active; gray indicates inactive. The faceplate display provides the 
following views of port status corresponding to the View menu options in the 
faceplate display. Refer to ”Monitoring Port Status” on page 5-2 for more 
information about these displays.

Port mode
Port state
Port speed
Port media
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2.11.2
Working with Ports

Ports are selectable and serve as access points for other displays and menus. 
You select ports to display information about them in the data window or to modify 
them. Context sensitive popup menus and properties windows are accessible 
through the faceplate and port icons.

2.11.2.1
Selecting Ports

You can select ports in the following ways. Selected ports are highlighted in blue.

To select a port, click the port in the faceplate display.
To select a range of consecutive ports, select a port, then press and hold the 
shift key and select another port. The application selects both end ports and 
all ports in between in port number sequence.
To select several non-consecutive ports, hold the Control key while 
selecting.
To select all ports, right-click anywhere in the graphic window. Select Select 
All Ports from the popup menu.

To cancel a selection, press and hold the Control key and select it again.

2.11.2.2
Opening Popup Menus

Using the right mouse button, you can open the faceplate popup menu. This 
popup menu presents several selections to manage the switch and its ports.

To open the popup menu, right-click anywhere in the graphic window. If no 
ports are selected, the corresponding tasks will be unavailable in the menu.
To select one or more ports and open the Port popup menu, right-click a 
port.
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2.11.3
Faceplate Data Windows

The faceplate display provides the following data windows corresponding to the 
data window tabs:

Name Server – displays all devices connected to the switch that are logged 
with the name server.
Switch – displays current switch configuration data.
Port Statistics – displays port performance data for the selected ports.
Port Information – displays information for the selected ports.
Configured Zonesets – displays all zone sets, zones, and zone membership 
in the zoning database.
Alarm Log – displays the switch alarm log.
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Section 3
Managing Fabrics

This section describes the following tasks that manage fabrics:

Security
Managing the fabric database
Displaying fabric information
Zoning a fabric

3.1
Security

The components of security are:

User authentication
Inter-Switch link security
Inband management 

3.1.1
User Authentication

User Authentication security pertains to gaining access to a switch after entering a 
valid account name/password combination. User Authentication security is “switch 
level” security in that it pertains to only that switch. When using the command line 
interface, the user must be authenticated before gaining access to a switch. If an 
invalid account name/password combination is entered, that user can not access 
the switch, and thus can not gain access to the fabric. 

To enable User Authentication security, set the Security Enabled parameter to 
True using the Set Setup System command. Refer to the ”Set Setup Command” 
on page A-39 for information. All switches in the fabric should be configured with 
the same security setting (enabled/true or disabled/false). The User 
Authentication security is disabled by default.

If User Authentication security is enabled and a valid account name/password 
combination is entered, that user can access the switch but can not execute any 
command that exceeds their authority (privileges) level. If User Authentication 
security is disabled and a valid account name/password combination is entered, 
that user has access to all switches in the fabric and can execute all commands 
(both user and admin), regardless of their authority (privileges) level.

The valid account name/password/system privileges combinations are set up by 
the system administrator, and define which set of system commands each user 
may execute. 
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Once access is gained to the entry switch in a fabric, that user may access all 
switches in that fabric (if ISL Security is not disabled). Refer to ”Inter-Switch Link 
Security” on page 3-2 for more information.

3.1.2
Inter-Switch Link Security

Inter-Switch Link security pertains to whether the switches in the fabric are 
configured to permit access to each switch in that fabric. Inter-Switch Link security 
enables inter-switch links with FC-SW-2 compliant switches, SANbox2 switches 
only, or none regardless of switch type. ISL security should be thought of as the 
parameter with Any, Ours and None being the values. The three Secularity 
parameters are:

Any - links with any FC-SW-2 compliant switch
Ours - links only with another SANbox2 switch 
None - the port will not establish an ISL link

Refer to the ”Set Config Command” on page A-26 for more ISL security 
information and a Set Config Port example.

3.1.3
Inband Management

Inband management is the ability to manage switches across inter-switch links 
using SANbox Manager, SNMP, IPFC, management server, or the application 
programming interface. The switch comes from the factory with inband 
management enabled. If you disable inband management on a particular switch, 
you can no longer communicate with that switch by means other than a direct 
Ethernet or serial connection. 

To enable Inband Management using SANbox Manager, check the Enable radio 
button on the Switch Properties window. Refer to ”Switch Properties” on 
page 4-13 for more information. To enable Inband Management using the 
command line interface, set the InbandEnabled parameter to True in the Set 
Config Switch command. Refer to the in the ”Set Config Command” on page A-26 
for more ISL security information and a Set Config Port example.
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3.2
Managing the Fabric Database

A fabric database contains the set of fabrics that you have added during a 
SANbox Manager session. Initially, the SANbox Manager application opens with 
an empty fabric database.

3.2.1
Adding a Fabric

To add a fabric to the database, do the following:

1. Open the Fabric menu and select Add Fabric to open the Add a New Fabric 
window as shown in Figure 3-1.

Figure 3-1   Add a New Fabric Window

2. Enter a fabric name (optional) and the IP address of the switch through 
which to manage the fabric.

3. Enter an account name and password. The factory account name and 
password are (admin, password). The password is for the switch and is 
stored in the switch firmware. If security is turned off (default), you are not 
required to enter an account name or password. Refer to ”Security” on 
page 3-1. Refer to the Set Setup Command on page A-39 for account name, 
password, and security information.

4. Choose the Add Fabric button.

Note: A switch supports a combined maximum of 15 logins. This 
includes SANbox Manager inband and out-of-band logins, 
Application Programming Interface (API) inband and out-of-band 
logins, and Telnet logins. Of this 15, there can be a combined 
maximum of 10 SANbox Manager and API logins. Additional 
logins will be refused.
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3.2.2
Removing a Fabric

To delete a fabric file from the database, do the following:

1. Select a fabric in the fabric tree.
2. Open the Fabric menu and select Remove Fabric.

3.2.3
Opening a Fabric View File

To open an existing view file, do the following:

1. Open the File menu, and select Open View File, or choose the Open 
button. If the fabric you are currently has changed, you will be prompted to 
save the changes to the view file before opening a different view file.

2. In the Open View window, enter the name of the file to open.
3. Enter a file password, if necessary.
4. Choose the Load View File button. If the fabric has changed, you will be 

prompted to save before opening the new view. 

3.2.4
Saving a Fabric View File

To save a view file, do the following:

1. Open the File menu, and select Save View As.
2. In the Save View window, enter a new file name.
3. Enter a file password, if necessary. 
4. Choose the OK button.

3.2.5
Rediscovering a Fabric

After making changes to or deleting switches from a fabric view, it may be helpful 
to again view the actual fabric configuration. The rediscover fabric option clears 
out the current fabric information being displayed, and rediscovers all switch 
information. To rediscover a fabric, open the Fabric menu, and select Rediscover 
Fabric.
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3.2.6
Adding a New Switch to a Fabric

If there are no special conditions to be configured for the new switch, simply plug 
in the switch and the switch becomes functional with the default fabric 
configuration. The default fabric configuration settings are:

Fabric zoning is sent to the switch from the fabric.
All ports will be GL_Ports.
The default IP address 10.0.0.1 is assigned to the switch without a gateway 
or boot protocol configured (RARP, BOOTP, and DHCP).

If you are adding a new switch to a fabric and do not want to accept the default 
fabric configuration, do the following: 

1. If the switch is not new, reset the switch to the factory configuration before 
adding the switch to the fabric by selecting Restore Factory Defaults in the 
Switch menu.

2. If you want to manage the switch through the Ethernet port, you must first 
configure the IP address using the Network Properties window.

3. Configure any special switch settings. Consider configuring the Default 
Visibility setting to None in the Zoning Config window to prevent 
communication with other switches in the fabric until the new switch is 
configured.

4. Plug in the inter-switch links (ISL), but do not connect the devices. 
5. Configure the port types for the new switch (GL_Port, TL_Port, Donor) using 

the Port Properties window. 
6. Connect the devices to the switch.
7. Make any necessary zoning changes using the Edit Zoning window.

3.2.7
Replacing a Failed Switch

The archive/restore works for all switches. However, the Restore menu item is not 
available for the inband switches. You can only restore a switch out-of-band (the 
connection switch). Use the following procedure to replace a failed switch for 
which an archive is available. 

1. At the failed switch:
a. Turn off the power and disconnect the AC cords.
b. Note port locations and remove the interconnection cables and SFPs.
c. Remove the failed switch.
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2. At the replacement switch:
a. Mount the switch in the location where the failed switch was removed.
b. Install the SFPs using the same ports as were used on the failed 

switch.

c. Attach the AC cords and power up the switch.
3. Select the failed switch in the topology display. Open the Switch menu and 

select Delete.
4. Restore the configuration from the failed switch to the replacement switch:

a. Open the faceplate display for the replacement switch. Open the 
Switch menu and select Restore.

b. In the Restore window, enter the archive file from the failed switch or 
browse for the file.

c. Choose the Restore button.
5. Reconnect the inter-switch links, target devices, and initiator devices to the 

replacement switch using the same ports as were used on the failed switch.
6. Reset the replacement switch to activate the configuration formerly 

possessed by the failed switch including the domain ID and the zoning 
database. Open the Switch menu and select Reset Switch.

3.2.8
Deleting Switches and Links

The SANbox Manager application does not automatically delete switches or links 
that have failed or have been physically removed from the Fibre Channel network. 
In these cases, you can delete switches and links to bring the display up to date. If 
you delete a switch or a link that is still active, the SANbox Manager application 
will restore it automatically. You can also refresh the display. To delete a switch 
from the topology display, do the following:

1. Select one or more switches in the topology display.
2. Open the Switch menu and select Delete.
To delete a link, do the following:

1. Select one or more links in the topology display.
2. Open the Switch menu and select Delete.

CAUTION! Do not reconnect inter-switch links, target devices, and 
initiator devices at this time. Doing so could invalidate 
the fabric zoning configuration.



3 – Managing Fabrics
Displaying Fabric Information

59022-05 B 3-7

Q

3.3
Displaying Fabric Information

The topology display is your primary tool for monitoring a fabric. The graphics 
window of the topology display provides status information for switches, 
inter-switch links, and the Ethernet connection to the management workstation.

The data window tabs show name server, switch, and active zone set information. 
The Active Zoneset tab shows the zone definitions for the active zone set. Refer 
to ”Name Server Data Window” on page 4-3 and ”Switch Data Window” on 
page 4-4 for information about the Name Server and Switch data windows.

3.3.1
Fabric Status

The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the display status, or you can refresh the display at any time. To refresh 
the topology display, do one of the following:

Choose the Refresh button.
Open the View menu and select Refresh.
Press the F5 key.
Right-click anywhere in the background of the topology display and select 
Refresh Fabric from the popup menu.

The topology display uses switch and status icons to provide status information 
about switches, inter-switch links, and the Ethernet connection. The switch status 
icons, displayed on the left side of a switch, vary in shape and color. Switches 
controlled by an Ethernet Internet Protocol have a colored Ethernet icon displayed 
on the right side of the switch. A green Ethernet icon indicates normal operation, 
yellow indicates operational with errors, and red indicates a potential failure. 
Table 3-1 shows the different switch icons and their meanings.
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Table 3-1  Topology Display Switch and Status Icons 

Switch Icon Description

SANbox2-8c/16 Switch

SANbox2-8c Switch

Non-QLogic Switch, or a QLogic Switch with different 
security than the fabric management switch.

Normal (Green)

Operational with errors (Yellow)

Potential failure (Red)

Switch management communication unknown, 
unreachable, or unmanageable (Blue)

Fabric Management Switch
Ethernet connection normal (Green)

Fabric Management Switch
Ethernet connection critical (Red)

Fabric Management Switch
Ethernet connection warning (Yellow)
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3.3.2
Active Zone Set Data Window

The Active Zoneset data window displays the zone membership for the active 
zone set that resides on the fabric management switch. The active zone set is the 
same on all switches in the fabric – you can confirm this by adding a fabric 
through another switch and comparing Active Zone Set displays.

To open the Active Zoneset data window, choose the Active Zoneset tab below 
the data window in the topology display. Refer to ”Configured Zonesets Data 
Window” on page 4-7 for information about the zone set definitions on a particular 
switch. Refer to ”Zoning a Fabric” on page 3-10 for more information about zone 
sets and zones.

The Active Zoneset data window, shown in Figure 3-2, uses display conventions 
for expanding and contracting entries that are similar to the fabric tree. An entry 
handle located to the left of an entry in the tree indicates that the entry can be 
expanded. Click this handle or double-click the following entries:

A zone set entry expands to show its member zones.
A zone entry expands to show its member ports/devices.
WWN and FC devices that are zoned, but no longer part of the fabric, are 
grayed-out.

Figure 3-2   Active Zone Set Data Window

Active Zoneset 
Data Window
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3.4
Zoning a Fabric

Zoning enables you to divide the ports and devices of the fabric into zones for 
more efficient and secure communication among functionally grouped nodes. This 
subsection addresses the following topics:

Zoning concepts
Using the Zoning Config window
Restoring default zoning
Using the Edit Zoning window
Merging fabrics and zoning
Managing zone sets
Managing zones
Managing aliases

3.4.1
Zoning Concepts

The following zoning concepts provide some context for the zoning tasks 
described in this section:

Zones
Aliases
Zone sets
Zoning database
Zoning configuration

3.4.1.1
Zones

A zone is a named group of ports or devices that can communicate with each 
other. Membership in a zone can be defined by port number, device Fibre 
Channel address, or device World Wide Name (WWN). Zone members can 
communicate only with members of the same zone.

Three types of zones are supported. The following zone types define increasingly 
restrictive levels of communication.

Soft zone
Access Control List (ACL) - hard zone
Virtual Private Fabric (VPF) - hard zone
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3.4.1.1.1
Soft Zones

Soft zoning divides the fabric for purposes of controlling discovery. Members of 
the same soft zone automatically discover and communicate freely with all other 
members of the same zone. The soft zone boundary is not secure; traffic across 
soft zones can occur if addressed correctly. Soft zones that include members from 
multiple switches need not include the ports of the inter-switch links. Soft zone 
boundaries yield to ACL and VPF zone boundaries. Soft zones can overlap; that 
is, a port can be a member of more than one soft zone. Zone membership can be 
defined by Fibre Channel address, port ID and domain ID, worldwide name, or a 
combination. Soft zoning supports all port modes.

3.4.1.1.2
Access Control List Hard Zones

Access Control List (ACL) zoning divides the fabric for purposes of controlling 
discovery and inbound traffic. ACL zoning is a type of hard zoning that is 
hardware enforced. This type of zoning is useful for controlling access to certain 
devices without totally isolating them from the fabric. Members can communicate 
with each other and transmit outside the ACL zone, but cannot receive inbound 
traffic from outside the zone. The ACL zone boundary is secure against inbound 
traffic. ACL zones can overlap; that is, a port can be a member of more than one 
ACL zone. ACL zones that include members from multiple switches need not 
include the ports of the inter-switch links. ACL zone boundaries supersede soft 
zone boundaries, but yield to VPF zone boundaries. Membership can be defined 
only by port ID and domain ID. ACL zoning supports all port modes except 
TL_Ports.

3.4.1.1.3
Virtual Private Fabric Hard Zones

Virtual Private Fabric (VPF) zoning divides the fabric for purposes of controlling 
discovery and both inbound and outbound traffic. This type of zoning is useful for 
providing security and reserving paths between devices to guarantee bandwidth. 
VPF zoning is a type of hard zoning that is hardware enforced. Members can only 
transmit to and receive from members of the same VPF zone. The VPF zone 
boundary is secure against both inbound and outbound traffic. VPF zones that 
include members from multiple switches must include the ports of the inter-switch 
links. VPF zones cannot overlap; that is, a port can be a member of only one VPF 
zone. VPF zone boundaries supersede both soft and ACL zone boundaries. 
Membership can be defined only by port ID and domain ID. VPF zoning supports 
all port modes.
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3.4.1.2
Aliases

To make it easier to add a group of ports or devices to one or more zones, you can 
create an alias. An alias is a named set of ports or devices that are grouped 
together for convenience. Unlike zones, aliases impose no communication 
restrictions between its members. You can add an alias to one or more zones. 
However, you cannot add a zone to an alias, nor can an alias be a member of 
another alias.

3.4.1.3
Zone Sets

A zone set is a named group of zones. A zone can be a member of more than one 
zone set. All zones that are not members of a zone set belong to the orphan zone 
set. The orphan zone set is saved on the switch. Each switch in the fabric 
maintains its own zoning database containing one or more zone sets. This zoning 
database resides in non-volatile or permanent memory and is therefore retained 
after a reset. Refer to ”Configured Zonesets Data Window” on page 4-7 for 
information about displaying the zoning database.

To apply zoning to a fabric, choose a zone set and activate it. When you activate a 
zone set, the switch distributes that zone set to every switch in the fabric. This 
zone set is known as the active zone set. Refer to ”Active Zone Set Data Window” 
on page 3-9 for information about displaying the active zone set.

3.4.1.4
Zoning Database

Each switch has its own zoning database. The zoning database is made up of all 
aliases, zones, and zone sets that have been created on the switch or received 
from other switches. The switch maintains two copies of the zoning database: one 
copy is maintained in temporary memory for editing purposes; the second copy is 
maintained in permanent memory. Zoning database edits are made on an 
individual switch basis and are not propagated to other switches in the fabric when 
saved. The zoning limits for a fabric are as follows:

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID and port number pairs or Fibre Channel addresses to define 
their membership. Be sure to reconfigure zones that are affected by a 
domain ID change. To prevent zoning definitions from becoming invalid 
when the membership is defined by domain ID/port number or Fibre 
Channel address, you must lock domain IDs. Refer to ”Domain ID and 
Domain ID Lock” on page 4-14 and ”Set Config Command” on 
page A-26 for more information.
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Maximum number of zonesets is 256
Maximum number of zones per zone set is 256
Maximum total number of zones is 1000
Maximum number of aliases is 256
Maximum number of members per zone is 2000
Maximum number of members per alias is 2000
Maximum total number of zone and alias members is 2000

3.4.1.5
Zoning Configuration

You can set the Auto Save and Default Visibility zoning configuration parameters 
using SANbox Manager or the Set Config Zoning command. The Auto Save 
parameter determines whether changes to the active zone set that a switch 
receives from other switches in the fabric will be saved to permanent memory on 
that switch. The Default Visibility parameter permits or prohibits communication 
between switches when there is no active zone set. Refer to ”Using the Zoning 
Config Window” on page 3-13 for information about zoning configuration using 
SANbox Manager. Refer also to the Set Config Command on page A-26 for 
information about zoning configuration using the CLI.

3.4.2
Using the Zoning Config Window

Use the Zoning Config window to change the Auto Save and Default Visibility 
configuration parameters. In the faceplate display, open the Zoning menu and 
select Edit Zoning Config to open the Zoning Config window shown in 
Figure 3-3. After making changes, choose the OK button to put the new values 
into effect.

Figure 3-3   Zoning Config Window
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3.4.2.1
Auto Save

The Auto Save parameter determines whether changes to the active zone set that 
a switch receives from other switches in the fabric will be saved to permanent 
memory on that switch. Changes are saved when an updated zone set is 
activated. Zoning changes are always saved to temporary memory. However, if 
Auto Save is enabled, the switch firmware saves changes to the active zone set in 
both temporary and permanent memory. If Auto Save is disabled, changes to the 
active zone set are stored only in temporary memory.

3.4.2.2
Default Visibility

Default visibility determines the level of communication that is permitted among 
ports/devices when there is no active zone set. The default visibility parameter 
can be set differently on each switch. When default visibility is enabled (ALL) on a 
switch, all ports/devices on the switch can communicate with all ports on switches 
that also have default visibility enabled. When Default Visibility is disabled 
(NONE) on a switch, none of the ports/devices on that switch can communicate 
with any other port/device in the fabric.

3.4.3
Restoring Default Zoning

Restoring the default zoning clears the switch of all zoning definitions.

To restore the default zoning for a switch:

1. In the faceplate display, open the Zoning menu and select Restore Default 
Zoning.

2. Choose the OK button to confirm that you want to restore default zoning and 
save changes to the zoning database.

CAUTION! This command will deactivate the active zone set.
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3.4.4
Merging Fabrics and Zoning

If you join two fabrics with an inter-switch link, the active zone sets from the two 
fabrics attempt to merge. The fabrics may consist of a single switch or many 
switches already connected together. The switches in the two fabrics attempt to 
create a new active zone set containing the union of each fabric's active zone set. 
The propagation of zoning information only affects the active zone set, not the 
configured zone sets.

3.4.4.1
Zone Merge Failure

If a zone merge is unsuccessful, the inter-switch links between the fabrics will 
isolate due to a zone merge failure, which will generate an alarm log entry. The 
reason for the E_Port isolation can also be determined by viewing the port 
information. Refer to ”Port Information Data Window” on page 5-7and the ”Show 
Command” on page A-44(Port keyword).

A zone merge will fail if the two active zone sets have member zones with 
identical names that differ in content or type. For example, consider Fabric A and 
Fabric B each with a zone named “ZN1” in its active zone set. Fabric A "ZN1" 
contains a member specified by Domain ID 1 and Port 1; Fabric B “ZN1” contains 
a member specified by Domain ID 1 and Port 2. In this case, the merge will fail 
and the inter-switch links between the fabrics will isolate.

3.4.4.2
Zone Merge Failure Recovery

When a zone merge failure occurs, the conflict that caused the failure must be 
resolved. You can correct a failure due to a zone conflict by deactivating one of 
the active zone sets or editing the conflicting zones so that their membership is 
the same. You can deactivate the active zone set on one switch if the active zone 
set on the other switch accurately defines your zoning needs. If not, you must edit 
the zone memberships, and reactivate the zone sets. Refer to ”Managing Zones” 
on page 3-20 for information about adding and removing zone members. After 
correcting the zone membership, reset the isolated ports to allow the fabrics to 
join. Refer to ”Resetting a Port” on page 5-13.
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3.4.5
Using the Edit Zoning Window

To edit the zoning database for a particular switch, open the Zoning menu from 
the faceplate display and select Edit Zoning to open the Edit Zoning window 
shown in Figure 3-4. Changes can only be made to inactive zone sets, which are 
stored in flash (non-volatile) memory and retained after resetting a switch.

The Edit Zoning window has a Zone Sets tree on the left and a Port/Device (or 
members) tree on the right. Both trees use display conventions similar to the 
fabric tree for expanding and contracting zone sets, zones, and ports. An 
expanded port shows the port Fibre Channel address; an expanded address 
shows the port worldwide name. You can select zone sets, zones, and ports in the 
following ways:

Click a zone, zone set, or port icon.
Right-click to select a zone set or zone, and open the corresponding popup 
menu.
Hold down the Shift key while clicking several consecutive icons.
Hold down the Control key while clicking several non-consecutive icons. 

Figure 3-4   Edit Zoning Window

Port/Device 
Tree

Zone Sets 
Tree
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Using tool bar buttons, popup menus, or a drag-and-drop method, you can create 
and manage zone sets and zones in the zoning database. The Apply button 
saves changes to the zoning database without closing the window. The OK button 
saves the zoning changes to the database and closes the window. Table 3-2 
describes the zoning tool bar operations:

Table 3-2  Edit Zoning Window Tool Bar Buttons

Tool Bar Button Description

Create Zone Set button - create a new zone set

Create Zone button - create a new zone

Create Alias button - create another name for a set of objects

Add Member button - add the selected zone to a zone set, or 
add the selected port to a zone

Remove Member button - delete the selected zone from a zone 
set, or delete the selected port from a zone
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3.4.6
Managing Zone Sets

Zoning a fabric involves creating a zone set, creating zones as zone set members, 
then adding devices as zone members. The zoning database supports multiple 
zone sets to serve the different security and access needs of your storage area 
network, but only one zone set can be active at one time. Managing zone sets 
consists of the following tasks:

Creating zone sets
Activating and deactivating zone sets
Copying a zone to a zone set
Removing a zone from one zone set or from all zone sets
Removing a zone set
Removing all zoning definitions

3.4.6.1
Creating a Zone Set

To create a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Zone Set to open the Create Zone 
Set window.

3. Enter a name for the zone set, and choose the OK button. The new zone set 
name is displayed in the Zone Sets window. A zone set name must begin 
with a letter and be no longer than 64 characters. Valid characters are 0-9, 
A-Z, a-z, _, and -.

4. To create new zones in a zone set, do one of the following:
Right-click a zone set and select Create A Zone from the popup menu. 
In the Create a Zone window, enter a name for the new zone, and 
choose the OK button. The new zone name is displayed in the Zone 
Sets window.
Copy an existing zone by dragging a zone into the new zone set. Refer 
to ”Copying a Zone to a Zone Set” on page 3-19.

5. Choose the Apply button to save changes to the zoning database.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.
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3.4.6.2
Activating and Deactivating a Zone Set

You must activate a zone set to apply its zoning definitions to the fabric. Only one 
zone set can be active at one time. When you activate a zone set, the switch 
distributes that zone set to the temporary zoning database on every switch in the 
fabric. If Auto Save is enabled, the new active zone set is saved in the permanent 
zoning database also. Refer to ”Auto Save” on page 3-14.

The purpose of the deactivate function is to suspend all fabric zoning which 
results in free communication fabric wide or no communication depending on the 
default visibility setting. Refer to ”Default Visibility” on page 3-14 for more 
information. It is not necessary to deactivate the active zone set before activating 
a new one.

To activate a zone set, open the Zoning menu and select Activate Zone Set 
to open the Activate Zone Set window. Select a zone set from the Select 
Zone Set pull-down menu, and choose the Activate button.
To deactivate the active zone set, open the Zoning menu, select Deactivate 
Zone Set. Acknowledge the warning about traffic disruption, and choose the 
Yes button to confirm that you want to deactivate the active zone set.

3.4.6.3
Copying a Zone to a Zone Set

To copy an existing zone and its membership from one zone set to another, select 
the zone and drag it to the chosen zone set. Choose the Apply button to save 
changes to the zoning database.

3.4.6.4
Removing a Zone from a Zone Set or from All Zone Sets

You can remove a zone from a zone set or from all zone sets in the database.

1. In the Faceplate Display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window.

2. In the Zone Sets tree, select the zone(s) to be removed.
3. Open the Edit menu, and select Remove to remove the zone from the zone 

set, or select Remove from All Zones to remove the zone from all zone 
sets.

4. Choose the Apply button to save changes to the zoning database.
Alternatively, you may use shortcut menus to remove a zone from a zone set or 
from all zone sets in the database.
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3.4.6.5
Removing a Zone Set

Removing a zone set from the database affects the member zones in the following 
ways.

Member zones that are members of other zone sets are not affected.
Member zones that are not members of other zone sets become members 
of the orphan zone set. The orphan zone set is saved on the switch.

To delete a zone set from the database, do the following:

1. In the faceplate display, open the Zoning menu and select Edit Zoning to 
open the Edit Zoning window.

2. In the Zone Sets tree, select the zone set to be removed.
3. Open the Edit menu, and select Remove to remove the zone set.
4. Choose the Apply button to save changes to the zoning database.
Alternatively, you may use shortcut menus to remove a zone set from the 
database. 

3.4.6.6
Removing All Zoning Definitions

To clear all zone and zone set definitions from the zoning database, choose one of 
the following:

Open the Edit menu and select Remove All. In the Remove All window, 
choose the Yes button to confirm that you want to delete all zones and zone 
sets. 
Right-click the Zone Sets heading at the top of the Zone Sets tree, and 
select Clear Zoning from the popup menu. Choose the Yes button to 
confirm that you want to delete all zone sets and zones.

3.4.7
Managing Zones

Managing zones involves the following:

Creating a zone in a zone set
Adding zone members
Renaming a zone or a zone set
Removing a zone member
Removing a zone from a zone set
Removing a zone from all zone sets
Changing zone types



3 – Managing Fabrics
Zoning a Fabric

59022-05 B 3-21

Q

3.4.7.1
Creating a Zone in a Zone Set

When a zone is created, its zone type is soft. To change the zone type to a hard 
zone, refer to ”Changing Zone Types” on page 3-23 for more information. Refer to 
”Zones” on page 3-10 for information on zone types (soft and hard). To create a 
zone in a zone set, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window. 

2. Open the Edit menu and select Create a Zone. 
3. In the Create a Zone window, enter a name for the new zone, and choose 

the OK button. The new zone name is displayed in the Zone Sets window. A 
zone name must begin with a letter and be no longer than 64 characters. 
Valid characters are 0-9, A-Z, a-z, _, and -.

4. To add ports or devices to the zone, do one of the following:
In the zone set tree, select the zone set. In the graphic window, select 
the port to add to the zone. Open the Edit menu and select Add 
Members. 
Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree, and drag it into the zone.
Select a port by port number, Fibre Channel address, or worldwide 
name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.

5. Choose the Apply button to save changes to the zoning database.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.

Note: If you enter the name of a zone that already exists in the 
database, the SANbox Manager application will create a copy of 
that zone and its membership in the zone set.
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3.4.7.2
Adding Zone Members

Adding a zone member to a zone will affect every zone set in which that zone is a 
member. To add member ports/devices to a zone, do one of the following:

Select a port by port number, Fibre Channel address, or worldwide name in 
the Port/Device tree, and drag it into the zone. To select and drag multiple 
ports/devices, press and hold the Control key while dragging.
Select one or more ports by port number, Fibre Channel address, or 
worldwide name in the Port/Device tree. Right-click the zone and select Add 
Zone Members from the popup menu.

Choose the Apply button to save changes to the zoning database.

3.4.7.3
Renaming a Zone or a Zone Set

To rename a zone, do the following:

1. In the Zone Sets tree of the Edit Zoning window, click the zone/zone set to 
be renamed.

2. Open the Edit menu and select Rename.
3. In the Rename Zone/Rename Zone Set window, enter a new name for the 

zone/zone set.
4. Choose the OK button.

3.4.7.4
Removing a Zone Member

Removing a zone member will affect every zone and zone set in which that zone 
is a member. To remove a member from a zone:

1. In the Edit Zoning window, select the zone member to be removed.
2. Open the Edit menu and select Remove.
3. Choose the OK button to save changes and close the Edit Zoning window.

Note: Domain ID conflicts can result in automatic reassignment of switch 
domain IDs. These reassignments are not reflected in zones that use 
domain ID/port number pair to define their membership. Be sure to 
reconfigure zones that are affected by a domain ID change.
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3.4.7.5
Removing a Zone from a Zone Set

Removing a zone from a zone set will affect every zone set in which that zone is a 
member. Zones that are no longer members of any zone set are moved to the 
orphan zone set. The orphan zone set is saved on the switch. To delete a zone 
from a zone set:

1. In the Edit Zoning window, select the zone to be removed.
2. Open the Edit menu and select Remove.
3. Choose the OK button to save changes and close the Edit Zoning window.

3.4.7.6
Removing a Zone from All Zone Sets

Zones that are no longer members of any zone set are moved to the orphan zone 
set. The orphan zone set is saved on the switch. To delete a zone from all zone 
sets, do the following:

1. In the Edit Zoning window, select the zone to be removed.
2. Open the Edit menu and select Remove Zone from All Sets.
3. Choose the OK button to save changes and close the Edit Zoning window.

3.4.7.7
Changing Zone Types

To change a zone type, do the following:

1. In the faceplate display, select the switch with the zone type to change.
2. Choose the Zoning button to open the Edit Zoning window.
3. In the Zone Sets tree, select the zone to change.
4. Open the Edit menu and select Set Zone Type to open the Set Zone Type 

window.
5. Open the Zone Type pull-down menu and select Soft, ACL, or VPF. 

Soft zoning is the least restrictive type of zoning. 
ACL zoning is hard zoning and is enforced by hardware and defines 
access to a given port. ACL zones need not include inter-switch links.
VPF zoning is hard zoning that defines ports that can communicate 
with each other. VPF zones must include inter-switch links.
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3.4.8
Managing Aliases

An alias is a collection of objects that can be zoned together. An alias is not a 
zone, and can not have a zone or another alias as a member.

3.4.8.1
Creating an Alias

To create an alias, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. Open the Edit menu, and select Create Alias to open the Create Alias 
window.

3. Enter a name for the alias, and choose the OK button. The alias name is 
displayed in the Zone Sets window. An alias name must begin with a letter 
and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, 
and -.

4. Choose the OK button to save the alias name to the zoning database.

Note: Changes that you make to the zoning database are limited to the 
managed switch and do not propagate to the rest of the fabric. To 
distribute changes to configured zone sets fabric wide, you must edit 
the zoning databases on the individual switches.
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3.4.8.2
Adding a Member to an Alias

The three ways to add a member to an alias are:

Drag-and-drop method.
Select the alias in the left pane and the member in the right pane to add to 
that alias, and choose the Insert button.
Select the alias in the left pane and the member in the right pane to add to 
that alias, and open the Edit menu and select Add Members.

To add a member to an alias using the drag-and-drop method, do the following:

1. In the right pane, click and hold down the mouse button on the member to 
be added to the alias.

2. Drag the selected member from the right pane to the alias in the left pane.
To add a member to an alias using the menu options, do the following:

1. Open the Zoning menu, and select Edit Zoning to open the Edit Zoning 
window.

2. In the left pane, select an alias.
3. In the right pane, select the member to add to the selected alias.
4. Choose one of the following: 

Open the Edit menu and select Add Members.
Choose the Insert button.

5. Choose the OK button to save changes and close the Edit Zoning window.

3.4.8.3
Removing an Alias from All Zones

To remove an alias from all zones, do the following:

1. In the Zone Sets tree in the Edit Zoning window, select the alias to be 
removed.

2. Open the Edit menu, and select Remove Alias from All Zones.
3. Choose the Yes button in the Remove window.
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Notes
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Section 4
Managing Switches

This section describes the following tasks that manage switches in the fabric.

Displaying switch information
Managing alarms
Exporting name server information to a file
Paging a switch
Resetting a switch
Setting the date and time
Setting temperature thresholds
Configuring a switch
Archiving a switch
Restoring a switch
Managing firmware
Restoring the factory default configuration

4.1
Displaying Switch Information

The faceplate display and data windows provide the following specific switch 
information:

Hardware status
Name server information
Switch specifications and addresses
Configuration parameters
Performance statistics
Configured zone sets
Alarm log information

Figure 4-1 shows the faceplate display for the SANbox2-8c and SANbox2-16 
switches.
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Figure 4-1   Faceplate Display

The fabric updates the topology and faceplate displays by forwarding changes in 
status to the management workstation as they occur. You can allow the fabric to 
update the switch status, or you can refresh the display at any time. To refresh 
switch status in the display, do one of the following:

Choose the Refresh button.
Open the View menu and select Refresh.
Press the F5 key.
Right-click a switch in the topology display and select Refresh Switch from 
the popup menu.
Right-click in the graphic window of the faceplate display, and select 
Refresh Switch from the popup menu.
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4.1.1
Displaying Hardware Status

A switch is equipped with the following chassis LEDs that provide hardware status 
information:

Chassis Over Temperature LED - indicates air temperature inside the 
switch.
Fan Fail LED - indicates operational status of both fans. 
Heartbeat LED - indicates the status of the internal switch processor and the 
results of Power On Self Tests (POSTs).
Input Power LED - indicates the voltage status at the switch logic circuitry.

In the SANbox2-16 faceplate display, you can display a summary of this status 
information by placing the cursor on the chassis LED cluster as shown in 
Figure 4-2. Refer to the installation guide for your switch for more information 
about the chassis LEDs.

Figure 4-2   Faceplate Display - Chassis LED Cluster

4.1.2
Name Server Data Window

The Name Server data window displays information about the devices that are 
logged into the fabric. Choose the Name Server tab below the data window to 
display name server information for all devices that are logged into the selected 
fabric. To narrow the display to devices that are logged into specific switches, 
select one or more switches in the fabric tree or the topology display. Refer to 
Table 4-1 for a description of the entries in the Name Server data window. Refer to 
”Exporting Name Server Information to a File” on page 4-11 for exporting name 
server information.
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4.1.3
Switch Data Window

The Switch data window displays current network and switch information for the 
selected switches. Refer to ”Configuring a Switch” on page 4-12 for more 
information about the Switch data window. To open the Switch data window, select 
one or more switches in the topology display and choose the Switch tab below 
the window. You can also open the Switch data window in the faceplate display. 
Table 4-2 describes the Switch data window entries.

Table 4-1  Name Server Data Window Entries

Entry Description

Dev Device number in the fabric

Switch Switch name

Port Port number (0–8 or 0–15)

Address Fibre Channel address

Type Node type

Node WWN Node worldwide name

Port WWN Port worldwide name

Vendor Host Bus Adapter/Device Vendor

FC-4 Types Device Fibre Channel protocol types

Active Zones The active zone to which the device belongs

Table 4-2  Switch Data Window Entries 

Entry Description

FcAddress Switch Fibre Channel address

World Wide Name Switch worldwide name

Reason for Status Additional status information

User Name Account name

Login Level Authority level

Security Enabled Enforcement of account names and authority

Vendor Switch manufacturer

Flash Version Active Flash
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Inactive Flash Version Inactive firmware version

PROM/Flasher Version Firmware version

MAC Address Media Access Control address

IP Address Internet Protocol Address

Subnet Mask Mask that determines the IP address subnet

Gateway Gateway address

Negotiated Domain ID The domain ID currently being used by the fabric

Configured Domain ID The domain ID defined by network administrator

Domain ID Lock Domain ID lock status. Prevents (True) or permits 
(False) dynamic domain ID reassignment.

Number of Ports Number of ports on the switch

Switch Type Switch model

Operational State Switch operational state: Online, Offline, Diagnostic

Administrative State Current switch administrative state

Configured Admin State Switch administrative state that is stored in the switch 
configuration

MFS Timeout Multi frame sequencing timeout value

RA Timeout Resource allocation timeout value

RT Timeout Receiver transmitter timeout value

ED Timeout Error detect timeout value

Zoning Merge Mode Active zone set merge or all zone set merge

Zoning Merge Auto Save Zoning auto save status. Saves zoning updates in 
temporary and permanent memory (True) or only in 
temporary memory (False).

Zoning Default Visibility Zoning visibility status. Permits (All) or prevents 
(None) communication with other switches in the 
absence of an active zone set.

Temperature Internal switch temperature °C

Fan 1 Status Fan status

Fan 2 Status Fan status

Table 4-2  Switch Data Window Entries (Continued)

Entry Description
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4.1.4
Link Data Window

The Link data window displays information about all switch links in the fabric or 
selected links. This information includes the switch name, the port number at the 
end of each link, and the link status. To open the Link data window, choose the 
Link tab below the window.

4.1.5
Port Statistics Data Window

The Port Statistics data window displays port performance data for the selected 
ports. To open the Port Statistics data window, choose the Port Stats tab below 
the data window in the faceplate display. Refer to Table 5-5 for a description of the 
Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. 
Choose the Clear Baseline button to set the current baseline.

Fan 3 Status Fan status

Power Supply 1 Status Power supply 1 status

Power Supply 2 Status Power supply 2 status

Beacon Status Beacon status. Switch LEDs are blinking (On) or not 
(off).

Broadcast Support Broadcast support status. Broadcast support is 
enabled or disabled (default).

Inband Enabled Inband management status. Permits (True) or 
prevents (False) a switch from being managed over 
an ISL.

Switch Date Date and time reported by the switch

Table 4-2  Switch Data Window Entries (Continued)

Entry Description
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4.1.6
Port Information Data Window

The Port Information data window displays port detail information for the selected 
ports. To open the Port Statistics data window, choose the Port Info tab below the 
data window in the faceplate display. Refer to Table 5-6 for a description of the 
Port Information data window entries.

4.1.7
Configured Zonesets Data Window

The Configured Zonesets data window displays all zone sets, zones, and zone 
membership in the zoning database, as shown in Figure 4-3. To open the 
Configured Zonesets data window, choose the Configured Zonesets tab below 
the data window in the faceplate display.

The Configured Zonesets data window uses display conventions for expanding 
and contracting entries that are similar to the fabric tree. An entry handle located 
to the left of an entry in the tree indicates that the entry can be expanded. Click 
this handle or double-click the following entries to expand or contract them:

A zone set entry expands to show its member zones.
A zone entry expands to show its members by port number, worldwide 
name, or Fibre Channel address.

Figure 4-3   Configured Zonesets Data Window
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4.1.8
Alarm Log Data Window

The Alarm Log data window displays switch event information. To open the Alarm 
Log data window, choose the Alarm Log tab below the data window in the 
faceplate display.

4.2
Managing Alarms

You can configure the switch to generate and log alarms. Display the Alarm Log 
by choosing the Alarm Log tab in the faceplate display. Refer to ”Alarm Log Data 
Window” on page 4-8 for information about the alarm log. You can also export the 
alarm log to a file in .XML format.

4.2.1
Configuring Alarms

Configuring an alarm involves choosing an event type, rising and falling 
thresholds, a sampling interval, and finally enabling or disabling the alarm. To 
configure alarms, do the following:

1. In the faceplate display, open the Switch menu and select Configure Alarm 
Thresholds.

Table 4-3  Alarm Log Data Window Entries

Entry Description

Time Stamp The time the event occurred.

Alarm Type The configured alarm type.

Description Additional information about the alarm.
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2. The Alarm Threshold Configuration window shown in Figure 4-4 prompts 
you to enable or disable all alarms, select an event, set thresholds, set a 
sampling interval and enable or disable an individual alarm.

Figure 4-4.  Alarm Threshold Configuration Window

3. Check the Enable All Alarm Thresholds box to enable monitoring for all 
the individual alarm types that are enabled. The Enable All Alarm 
Thresholds box is the master control for the individual alarms. For example, 
the switch will monitor CRC errors only if both the CRC Error Enable box 
and the Enable All Alarm Thresholds box are checked.

4. Select an event type from the Alarm Threshold pull-down menu. Choose 
from the following options:

CRC error monitoring
Decode error monitoring
ISL monitoring
Login monitoring
Logout monitoring
Loss of signal monitoring

5. Enter a value for the falling threshold. A falling threshold alarm is generated 
when the event count descends below the falling threshold.
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6. Enter a value for the rising threshold. A rising threshold alarm is generated 
when the event count exceeds the rising threshold. The switch will not 
generate another rising threshold alarm for that event until the count 
descends below the falling threshold and rises again above the rising 
threshold. Consider the example in Figure 4-5.

Figure 4-5   Alarm Threshold Example

7. Enter a sample interval in seconds. The sample interval defines the period of 
time in which to count events.

8. Check the Enable box to make the alarm eligible for use. Repeat steps 4 
through 8 for each alarm you want to configure or enable. You must also 
check the Enable All Alarm Thresholds box, which is the master control for 
all alarm configurations.

9. Choose the OK button to save all changes.

4.2.2
Exporting Alarm Log Information to a File

To save the switch alarm log to a file, open the faceplate display and do the 
following:

1. Open the Switch menu and select Export Alarm Log.
2. In the Save window, enter a file name.
3. Choose the Save button.

Rising 
Threshold

Falling 
Threshold

Event 
Count

Sample Interval

Generate falling 
threshold alarm; 
eligibility is reset

Generate rising 
threshold alarm; 
eligibility ends

Generate rising 
threshold alarm; 
eligibility ends
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4.3
Exporting Name Server Information to a File

To save name server information to a file, open the topology display and do the 
following:

1. Select one or more switches. If no switches are selected, name server 
information is gathered for the all switches.

2. Open the Switch menu and select Export Name Server. 
3. In the Save window, enter a file name.
4. Choose the Save button.

4.4
Paging a Switch

You can use the beacon feature to page a switch. The beacon feature causes all 
port Logged-In LEDs to flash, making it easier to recognize. To page a switch, 
open the Switch menu in the faceplate display and enable the Toggle Beacon 
selection. To cancel the beacon, reselect Toggle Beacon.

4.5
Setting the Date and Time

To set the date and time on a switch, do the following:

1. Select a switch in the topology display, and open the faceplate display.
2. Open the Switch menu, and select Set Date/Time....
3. Enter the year, month, day and time in the Switch Date and Time window, 

then click OK. The new date and time take effect immediately.
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4.6
Setting Temperature Thresholds

You can set temperature thresholds by which the switch will generate an alarm or 
place the switch offline. The Temperature Thresholds dialog shown in Figure 4-6 
prompts you to enter a warning threshold and a failure threshold temperature in 
°C.

If the switch internal temperature exceeds the warning threshold, the switch 
generates an alarm.
If the switch internal temperature exceeds the failure threshold and the 
Enable Temperature Failure Port Shutdown box is checked, the switch 
generates an alarm and places all ports offline.

Figure 4-6   Temperature Thresholds

4.7
Resetting a Switch

Resetting a switch reboots the switch using configuration parameters in memory. 
You can reset a switch in the following ways:

Select the switch to be reset in the fabric tree. Open the Switch menu and 
select Reset Switch.
Open a Telnet session and enter the Reset Switch command.
Power cycle the switch.

4.8
Configuring a Switch

Switch configuration is divided into two areas: chassis configuration and network 
configuration. Chassis configuration specifies switch-wide Fibre Channel settings. 
Network configuration specifies Ethernet and SNMP settings.

To open the Switch Properties window, open the Switch menu and select Switch 
Properties. You may also right-click a switch graphic in the topology display or 
faceplate display, and select Switch Properties from the popup menu.



4 – Managing Switches
Configuring a Switch

59022-05 B 4-13

Q

4.8.1
Switch Properties

Use the Switch Properties window to change the chassis name, administrative 
state, domain ID, to enable or disable broadcast support, and to enable or disable 
inband management. Broadcast support provides support for TCP/IP. The timeout 
values are displayed for reference purposes only when the switch is online; they 
become active when the switch is taken offline. After making changes, choose the 
OK button to put the new values into effect.

Figure 4-7   Switch Properties Window

4.8.1.1
Symbolic Name

A user-defined name of up to 63 characters that identifies the switch.
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4.8.1.2
Switch Administrative States

The switch administrative state determines the operational state of the switch and 
its ports. The switch administrative state exists in two forms: the configured 
administrative state and the current administrative state.

The configured administrative state is the state that is saved in the switch 
configuration and is preserved across switch resets. SANbox Manager 
always makes changes to the configured administrative state.
The current administrative state is the state that is applied to the switch for 
temporary purposes and is not retained across switch resets. The current 
administrative state is set using the Set Switch command. Refer to the ”Set 
Command” on page A-24.

Table 4-4 describes the administrative state values.

4.8.1.3
Domain ID and Domain ID Lock

The domain ID is a unique Fibre Channel identifier for the switch. The Fibre 
Channel address consists of the domain ID, port ID, and the Arbitrated Loop 
Physical Address (ALPA). The maximum number of switches within a fabric is 239 
with each switch having a unique domain ID.

Switches come from the factory with the domain IDs unlocked. This means that if 
there is a domain ID conflict in the fabric, the switch with the highest principal 
priority, or the principal switch, will reassign any domain ID conflicts and establish 
the fabric. If you lock the domain ID on a switch and a domain ID conflict occurs, 
one of the switches will isolate as a separate fabric and the Logged-In LEDs on 
both switches will flash to show the affected ports. Refer to the ”Set Config 
Command” on page A-26 for information about the switch keyword and the 
Domain ID Lock and Principal Priority parameters.

Table 4-4  Switch Administrative States

Parameter Description

Online The switch is available

Offline The switch is unavailable

Diagnostics The switch is in diagnostics mode and is unavailable.
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If you connect a new switch to an existing fabric with its domain ID unlocked, and 
a domain conflict occurs, the new switch will isolate as a separate fabric. 
However, you can remedy this by resetting the new switch or taking it offline then 
back online. The principal switch will reassign the domain ID and the switch will 
join the fabric.

4.8.1.4
Broadcast Support

Broadcast is supported on the SANbox2 which allows for TCP/IP support. 
Broadcast is implemented using the proposed standard specified in Multi-Switch 
Broadcast for FC-SW-3, T11 Presentation Number T11/02-031v0. FSPF is used 
to setup a fabric spanning tree used in transmission of broadcast frames. 
Broadcast frames are retransmitted on all ISLs indicated in the spanning tree and 
all online F/FL_Ports. Broadcast zoning is supported with Access Control List 
(ACL) and Virtual Private Fabric (VPF) hard zones. When a broadcast frame is 
received, these hard zones are enforced at the F/FL_Port. If the originator of the 
broadcast is in a hard zone, the frame is retransmitted on all online F/FL_Ports 
within the hard zone. If the originator of the broadcast frame is not in a hard zone, 
the frame is retransmitted on online F/FL_Ports that are not in a hard zone.

4.8.1.5
Inband Management

Inband management is the ability to manage switches across inter-switch links 
using SANbox Manager, SNMP, IPFC, management server, or the application 
programming interface. The switch comes from the factory with inband 
management enabled. If you disable inband management on a particular switch, 
you can no longer communicate with that switch by means other than a direct 
Ethernet or serial connection.

Note: Domain ID reassignment is not reflected in zoning that is defined by 
domain ID and port number pair. You must reconfigure zones that are 
affected by domain ID reassignment.
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4.8.1.6
Timeout Values

The switch timeout values determine the timeout values for all ports on the switch. 
Table 4-5 describes the switch timeout parameters. The R_A_TOV, R_T_TOV, or 
E_D_TOV values must be the same for all switches in the fabric. 

Note: Timeout values can be changed only if the switch is offline.

Table 4-5  Timeout Values

Parameter Description

R_A_TOV Resource Allocation Timeout: Represents the maximum time a 
frame could be delayed in the Fabric and still be delivered. The 
default is 10000 milliseconds.

R_T_TOV Receiver Transmitter Timeout: The amount of time that Sync 
may be lost between two ports before Link Failure is detected. 
The default is 100 milliseconds.

E_D_TOV Error Detect Timeout: Represents the maximum round trip time 
that an operation between two N_Ports could require. The 
default is 2000 milliseconds.
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4.8.2
Network Properties

Use the Network Properties window shown in Figure 4-8 to change IP and SNMP 
configuration parameters. After making changes, choose the OK button to put the 
new values into effect. To open the Network Properties window, open the Switch 
menu and select Network Properties.

Figure 4-8   Network Properties Window

Note: Since Read Community, Trap Community, and Write Community 
settings are like passwords, they are write-only fields; the current 
settings are not displayed. 
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4.8.2.1
IP Configuration

The IP configuration identifies the switch on the Ethernet network and determines 
the network discovery to use. Table 4-6 describes the IP configuration 
parameters.

Table 4-6  IP Configuration Parameters

 Parameter Description

Network 
Discovery

Choose one of the following methods by which to assign the IP 
address:

Static - Use the IP configuration parameters entered in the 
Switch Properties window.
BootP - Acquires the IP configuration from a BootP server.
RARP (Reverse Address Resolution Protocol) - Acquires the IP 
address from an RARP server. An RARP request is broadcast 
with up to three retries, each at 5 second intervals. If no IP 
address is obtained, the switch reverts to the previously 
configured IP address. 
DHCP (Dynamic Host Configuration Protocol) - Acquires the IP 
configuration from a DHCP server. If no satisfactory lease is 
obtained, the DHCP client attempts to use the previously 
configured lease. If the previous lease cannot be used, no IP 
address will be assigned to this switch in order to avoid an IP 
address conflict. The DHCP server must then be made available. 

If a BootP, RARP, or DHCP server is not available, the switch will 
boot. However, you will be unable to manage the switch through the 
Ethernet connection. To manage a switch under these 
circumstances, the connection must be made through the serial port 
or inband through another switch.

IP Address Internet Protocol (IP) address for the Ethernet port. The default and 
maintenance mode value is 10.0.0.1.

Subnet mask Subnet mask address for the Ethernet port. The default and 
maintenance mode value is 255.0.0.0.

Gateway IP gateway address. The default and maintenance mode value is 
10.0.0.254.
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4.8.2.2
SNMP Configuration

The SNMP configuration defines how authentication traps are managed. 
Table 4-7 describes the SNMP configuration parameters.

Table 4-7  SNMP Configuration Parameters

 Parameter Description

Proxy Enabled Checkbox to enable or disable SNMP communication with other 
switches in the fabric.

Contact Specifies the name (up to 32 characters) of the person who is to be 
contacted to respond to trap events. The default is “undefined”.

Read 
Community

Read community password (up to 32 characters) that authorizes an 
SNMP agent to read information from the switch. This is a write-only 
field. The value on the switch and the SNMP management server 
must be the same. The default is “public”.

Trap Community Trap community password (up to 32 characters) that authorizes an 
SNMP agent to receive traps. This is a write-only field. The value on 
the switch and the SNMP management server must be the same. 
The default is “public”.

Location Specifies the switch location. The default is "undefined".

Authentication 
Trap

Enables or disables the reporting of SNMP authentication failures. If 
enabled, a notification trap is sent when incorrect community string 
values are used. The default value is "False".

Write 
Community

Write community password (up to 32 characters) that authorizes an 
SNMP agent to write information to the switch. This is a write-only 
field. The value on the switch and the SNMP management server 
must be the same. The default is “private”.
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4.8.2.3
SNMP Trap Configuration

The SNMP trap configuration defines how traps are set. Choose from the tabs 
Trap1 – Trap 5 and configure the trap. Table 4-8 describes the SNMP 
configuration parameters.

4.8.2.4
Remote Logging

The Remote Logging (syslog) feature enables saving of the log information to a 
remote host that supports the syslog protocol. When enabled, the log entries are 
sent to the syslog host at the IP address that you specify in the Logging Host IP 
Address field. Log entries are saved in the internal switch log whether this feature 
is enabled or not.

To save log information to a remote host, you must edit the syslog.conf file and 
then restart the syslog daemon. The syslog.conf file on the remote host must 
contain an entry that specifies the name of the log file in which to save error 
messages. Add the following line to the syslog.conf file. A <tab> separates the 
selector field (local0.info) and action field which contains the log file path name 
(/var/adm/messages/messages.name).

local0.info <tab> /var/adm/messages.name

Table 4-8  SNMP Trap Configuration Parameters 

 Parameter Description

Trap Version Specifies the SNMP version (1 or 2) with which to format traps.

Trap Enabled Check box to enable or disable the trap.

Trap Address Specifies the IP address to which SNMP traps are sent. A maximum 
of 5 trap addresses are supported. The default address for trap 1 is 
10.0.0.254. The default address for traps 2–5 is 0.0.0.0.

Trap Port The port number on which the trap is sent.

Trap Severity Specifies a severity level to assign to the trap. Open the pull-down 
menu and choose a level. Traps must be enabled to access this 
pull-down menu. Trap severity levels include Unknown, Emergency, 
Alert, Critical, Error, Warning, Notify, Info, Debug, and Mark.
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4.8.3
Configuration Backup

Changes made to the switch since it was manufactured can be saved to a file in 
non-volatile memory. However the backup is lost if the switch is reset. Use the 
FTP User Images procedures to save the configdata file to the workstation. (In 
FTP, no directory listing is available. The configuration backup file is always 
named configdata.) Refer to the ”Config Command” on page A-7 for information 
about backing up a configuration.

4.8.4
Configuration Restore

Switch configurations can be “cloned” to easily propagate an identical 
configuration to other switches. Use the FTP User Images procedures with the 
Put command to send the previously saved (using config backup) configdata file 
to the switch. Use the Config Restore command to return the switch configuration 
to the previously saved configuration. The switch is automatically reset upon a 
successful restore. Refer to the ”Config Command” on page A-7 for information 
about restoring a configuration.

4.9
Archiving a Switch

You can create an .XML archive file containing the configuration parameters. 
Archived parameters include the following:

Switch properties and statistics
IP configuration
SNMP configuration
Port properties and statistics
Alarm configuration
Zoning configuration

This archive file can be used to restore the configuration on the same switch or on 
a replacement switch. You can also use the archive file as a template for 
configuring new switches to add to a fabric. Security settings and user account 
information are not archived. The archive can be used later to restore the switch. 
Refer to ”Restoring a Switch” on page 4-22 for more information.

To archive a switch, do the following:

1. Open the Switch menu and select Archive. 
2. In the Save window, enter a file name.
3. Choose the Save button.
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4.10
Restoring a Switch

Restoring a switch loads the archived switch configuration parameters to the 
switch. The switch configuration must be archived before it can be restored. 
Furthermore, the switch archive must be compatible with the switch to be 
restored; that is, you cannot restore a SANbox2-8c switch with a SANbox2-16 
archive. Refer to ”Archiving a Switch” on page 4-21 for more information.

To restore a switch, do the following:

1. Log in to the fabric through the switch you want to restore. You cannot 
restore a switch over an ISL.

2. Open the Switch menu and select Restore.
3. In the Restore window, enter the archive file name or browse for the file. This 

archive file must be one that was produced by the SANbox Manager Archive 
function. Configuration backup files created with the Config Backup 
command are not compatible with the SANbox Manager Restore function.

4. Choose the Restore button.

4.11
Managing Firmware

The switch memory is partitioned for two firmware images. This can be useful 
when upgrading so that both the old an new firmware can be maintained on the 
switch. When you install new firmware, the currently active firmware is preserved 
and the new firmware becomes the second image or the fallback version. You 
have the ability to activate either firmware image. If you activate the fallback 
firmware, the current firmware becomes the fallback version.

Note: To provide consistent performance throughout the fabric, ensure that 
all switches are running the same version of firmware.



4 – Managing Switches
Restoring the Factory Default Configuration

59022-05 B 4-23

Q

4.11.1
Installing Firmware

Installing firmware involves loading the firmware image file on the switch, 
unpacking the image file, and resetting the switch. SANbox Manager does this in 
one operation and prompts you to reset the switch to activate the new firmware. 
To install firmware, do the following:

1. In the faceplate display, open the Switch menu and select Load Firmware.
2. In the Firmware Upload window, choose the Select button to browse and 

select the firmware file to be uploaded.
3. Choose the Start button to begin the firmware load process.
4. When the loading is complete, choose the Close button to close the 

Firmware Upload window.
5. The application prompts you to reset the switch. Choose the OK button to 

reset the switch and activate the new firmware.

4.11.2
Activating the Fallback Firmware

To activate the fallback firmware, do the following:

1. In the faceplate display, open the Switch menu and select Firmware 
Fallback.

2. The Firmware Fallback window displays the file name of the current 
firmware and the fallback firmware versions. Choose the Yes button to 
select the fallback firmware or No to cancel.

3. The application prompts you to reset the switch. Choose the OK button to 
reset the switch and activate the new fallback firmware.

4.12
Restoring the Factory Default Configuration

You can restore the switch and port configuration settings to the factory default 
values. To restore the factory configuration on a switch, open the Switch menu 
and select Restore Factory Defaults. Table 4-9 lists the factory default switch 
configuration settings.

Restoring the switch to the factory default configuration does not restore the 
account name and password settings. To restore the user accounts, you must 
select Reset Password File option in maintenance menu. Refer to "Recovering a 
Switch" in the Installation Guide for your switch.
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Table 4-9  Factory Default Configuration Settings 

Setting Value

Chassis name SANbox2

Administrative state Online

Domain ID 1

Domain ID Lock Disable

Inband Management Enable

Broadcast Support Enable

Resource Allocation Timeout (RA TOV) 10000 milliseconds

Receiver Transmitter Timeout (RT TOV) 100 milliseconds

Error Detect Timeout (ED TOV) 2000 milliseconds

IP address 10.0.0.1

Subnet mask address 255.0.0.0

Gateway address 10.0.0.254

Boot method Static

Enable Remote Logging False

Logging host IP address 10.0.0.254

Contact Undefined

Location Undefined

Trap enabled False

Trap port 162

Trap address Trap 1: 10.0.0.254; Traps 2-5: 0.0.0.0

Trap community Public

Read community Public

Write community Private

Port state Online

Port speed Auto-detect

Port mode GL
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Section 5
Managing Ports

This section describes the following tasks that manage ports and devices:

Displaying port information
Configuring ports
Testing ports

5.1
Displaying Port Information

Port information is available primarily in the faceplate display shown in Figure 5-1. 
The faceplate display data windows provide information and statistics for switches 
and ports. Use the topology display to show the status information for links 
between switches.

Figure 5-1   Faceplate Display - Port Information
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5.1.1
Monitoring Port Status

The faceplate display provides the following port related information:

Port mode
Port operational state
Port speed
Port media

To display port number and status information for a port, position the cursor over a 
port on the faceplate display. The status information changes depending on the 
View menu option selected.

5.1.1.1
Displaying Port Modes

To display port mode status, from the faceplate display, open the View menu, and 
select View Port Modes. Table 5-1 lists the possible port modes and their 
meanings.

Table 5-1  Port Modes

Mode Description

F Fabric port

FL Fabric loop port

TL Translated loop port

G Generic port

GL Generic fabric loop port

E Expansion port

D Donor port
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5.1.1.2
Displaying Port Operational States

To display the operational state on each port in the faceplate display, open the 
View menu and select View Port States. Table 5-2 lists the possible operational 
states and their meanings. The port operational state refers to actual port state 
and not the administrative state you may have assigned.

5.1.1.3
Displaying Port Speeds

To display the speed of each port in the faceplate display, open the View menu 
and select View Port Speeds. Table 5-3 lists the possible speeds.

Table 5-2  Port Operational States

State Description

On Online – port is active and ready to send data. 

Ia Inactive – port operational state is offline, but administrative state is 
online. 

Off Offline – port is active, can receive signal, but cannot accept a device 
login.

Tst Diagnostics – port is in diagnostics mode in preparation for testing

Dn Down – the port is inactive or shut off, not receiving a signal, and can’t 
be logged in.

Table 5-3  Port Speeds

State Description

Au Auto-detect

1Gb 1 Gbps transmission speed.

2Gb 2 Gbps transmission speed.
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5.1.1.4
Displaying Transceiver Media Status

To display transceiver media status, open the View menu and select View Port 
Media. Table 5-2 lists the possible media states and their meanings.

5.1.2
Port Statistics Data Window

The Port Statistics data window displays statistics about port performance. To 
open the Port Statistics window, select one or more ports in the faceplate display 
and choose the Port Stats tab below the data window. Table 5-5 describes the 
Port Statistics data window entries.

The Statistics pull-down menu is available on the Port Statistics data window, and 
provides different ways to view detailed port information. Choose the down arrow 
to open the pull-down menu. Open the pull-down menu and select Absolute to 
view the total count of statistics since the last switch reset. Select Rate to view the 
number of statistics counted per second over the polling period. Select Baseline 
to view the total count of statistics since the last time the baseline was set. When 
viewing baseline statistics, choose the Clear Baseline button to set the current 
baseline.

Table 5-4  Transceiver Media View

Media Icon Description

Optical SFP, Online (Green)

Optical SFP, Offline (Gray)

None Empty port, no transceiver installed

Table 5-5  Port Statistics Data Window Entries 

Entry Description

Start Time The beginning of the period over which the statistics apply. The 
start time for the Absolute view is not applicable. The start time 
for the Rate view is the beginning of polling interval. The start 
time for the Baseline view is the last time the baseline was set.

End Time The last time the statistics were updated on the display.

Total Time Total time period from start time to end time.

Login Count Number of logins that have occurred on the switch.



5 – Managing Ports
Displaying Port Information

59022-05 B 5-5

Q

Logout Count Number of logouts that have occurred on the switch.

Al Init Count Number of times the port entered the initialization state.

Invalid Destination 
Address

Number of address identifiers (S_ID, D_ID) found to be in 
error.

Total LIP Received Number of loop initialization primative frames received.

LIP F7F7 Count A loop initialization primative frame used to acquire an AL_PA.

LIP F8F7 Count Currently not used.

LIP F7AIPs Count This LIP is used to reinitialize the loop. An L_port, identified by 
AL_PS, may have noticed a performance degradation and is 
trying to restore the loop.

LIP F8AIPs Count This LIP denotes a loop failure detected by the L_port 
identified by AL_PS.

LIP AIPdAIPs Count Number of F7, AL_PS LIPs, or AL_PD (vendor specific) resets, 
performed.

Class 2 In Frames Number of class 2 frames received by this port.

Class 2 Out Frames Number of class 2 frames transmitted by this port.

Class 2 Words In Number of class 2 words received by this port.

Class 2 Words Out Number of class 2 words transmitted by this port.

Class 3 In Frames Number of class 3 frames received by this port.

Class 3 Out Frames Number of class 3 frames transmitted by this port.

Class 3 Words In Number of class 3 words received by this port.

Class 3 Words Out Number of class 3 words transmitted by this port.

Decode Error Count Number of invalid transmission words detected during 
decoding. Decoding is from the 10-bit characters and special K 
characters.

Loss Of Sync Count Number of synchronization losses (>100 ms) detected by this 
port. A loss of synchronization is detected by receipt of an 
invalid transmission word.

Invalid CRC Count Number of invalid Cyclic Redundancy Check (CRC) frames 
detected.

Tx Wait Count Number of times the port entered a wait state because it was 
out of buffer-to-buffer credits.

Table 5-5  Port Statistics Data Window Entries (Continued)

Entry Description
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Class 3 Toss Count Number of class 2 and class 3 sequences that were discarded 
by this port. A sequence can be discarded because of 
detection of a missing frame (based on SEQ_CNT), detection 
of an E_D_TOV timeout, receiving a reject frame, receiving 
frames for a stopped sequence, or other causes.

FReject Count Number of frames, from devices, that have been rejected. 
Frames can be rejected for any of a large number of reasons.

FBusy Count Number of class 2 and class 3 fabric busy (F_BSY) frames 
generated by this port in response to incoming frames. This 
usually indicates a busy condition on the fabric or N_port that 
is preventing delivery of this frame.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization for a period of time greater 
than the value of R_T_TOV or by loss of signal while not in the 
offline state. A loss of signal causes the switch to attempt to 
re-establish the link. If the link is not re-established by the time 
specified by R_T_TOV, a link failure is counted. A link reset is 
performed after a link failure.

Primitive Sequence 
Errors

Number of bad primitives received by the port.

Rx Link Resets Number of link reset primatives received from an attached 
device.

Tx Link Resets Number of link reset primatives sent from this port to an 
attached port.

Rx Offline Sequences Number of offline sequence primitives received by the port.

Tx Offline Sequences Number of offline primitives transmitted by the port.

Total Errors Total number of primitive and non-primitive port link errors.

Total Tx Frames Total number of frames transmitted by the port.

Total Rx Frames Total number of frames received by the port.

Total Tx Words Total number of words transmitted by the port.

Total Rx Words Total number of words received by the port.

Total Link Resets Number of link-reset primitives the transmitted by the port.

Total Offline 
Sequences

Total number of offline sequences transmitted and received by 
the port.

Table 5-5  Port Statistics Data Window Entries (Continued)

Entry Description
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5.1.3
Port Information Data Window

The Port Information data window displays port detail information for the selected 
port. To open the Port Information data window, choose the Port Info tab below 
the data window in the faceplate display.

Table 5-6  Port Information Data Window Entries

Entry Description

Port Address Port Fibre Channel address.

Administrative Port Mode The port mode before auto-configuration 
occurs.

Operational Port Mode The current port mode.

Administrative Port State Current port administrative state.

Operational Port State Port operational state: online, offline, 
diagnostics, or down.

Configured Administrative Port State Port administrative state that is stored in 
the switch configuration.

Logged In Indicates whether logged in or not.

E Port Connection Status Whether E_Port connection is enabled.

E Port Isolation Reason Why E_Port is isolated. 

MFS Mode Port tuning indicator.

I/O Stream Guard Whether RSCN suppression is enabled or 
disabled.

Administrative Port Speed The speed requested by the user.

Operational Port Speed The speed actually being used by the port.

BB Credits Whether buffer-to-buffer credits have been 
set.

Ext Credits Requested Whether extended credits have been 
requested for ports.

Medium The transceiver type.
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5.1.4
Name Server Data Window

The Name Server data window displays information about the port and the 
connected device. To open the Name Server data window, select one or more 
switches in the topology display and choose the Name Server tab below the data 
window. You can also open the Name Server data window in the faceplate display. 
Refer to Table 4-1 for a description of the Name Server data window entries.

5.2
Configuring Ports

The port settings or characteristics are configured using the Port Properties 
window shown in Figure 5-2. To open the Port Properties window, select one or 
more ports, open the Port menu and select Port Properties.

Figure 5-2   Port Properties Window

The Port Properties window displays the switch name and the selected port(s). 
Use the Port Properties window to change the following parameters:

Port state
Port speed
Port buffer credits
I/O Stream Guard (RSCN Suppression)
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5.2.1
Changing Port Administrative States

The port administrative state determines the operational state of a port. The port 
administrative state exists in two forms: the configured administrative state and 
the current administrative state.

The configured administrative state is the state that is saved in the switch 
configuration and is preserved across switch resets. SANbox Manager 
always makes changes to the configured administrative state.
The current administrative state is the state that is applied to the port for 
temporary purposes and is not preserved across switch resets. The current 
administrative state is set using the Set Port command. ”Set Port Command” 
on page A-38.

Table 5-7 describes the port administrative states. To change port administrative 
state, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties to open the Port Properties 

window.
3. Choose the Port States radio button that corresponds to the port state you 

want.
4. Choose the OK button to write the new port state to the switch.

5.2.2
Changing Port Speeds

The SANbox2 switch ports are capable of transmitting and receiving at 1 or 2 
Gbps. The ports can be configured for either transmission speed or to sense the 
transmission speed of the device to which it is connected. Table 5-8 describes the 
port speeds. To change the port speed, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties.
3. Choose the radio button that corresponds to the port speed you want.

Table 5-7  Port Administrative States

State Description

Online Activates and prepares port to send data. 

Offline Prevents port from receiving signal and accepting a device login. 

Diagnostics Prepares port for testing and prevents the port from accepting a 
device login.
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4. Choose the Apply button to write the new port speed to the switch.

5.2.3
Changing Port Modes

The SANbox2 switch ports support both public and private devices as single 
devices or in loops. The ports can be configured to self-discover the proper mode 
to match the device or switch to which it is connected. Table 5-9 describes the port 
modes. To change the port mode, do the following:

1. Select one or more ports in the faceplate display.
2. Open the Port menu and select Port Properties to open the Port Properties 

window.
3. Choose the Port Modes radio button that corresponds to the port mode you 

want.
4. Choose the OK button to write the new port mode to the switch.

Table 5-8  Port Speeds

State Description

Auto-Detect Matches the transmission speed of the connected device. This is the 
default. 

1Gb Sets the transmission speed to 1 Gbps.

2Gb Sets the transmission speed to 2 Gbps.

Table 5-9  Port Modes

State Description

F_Port Fabric port - Supports a single public device (N_Port).

FL_Port Fabric loop port - Supports a loop of up to 126 public devices (NL_Port).

TL_Port Translated loop port - Supports a loop of up to 124 private target devices 
capable of communicating with up to 63 off-loop initiator devices. Refer to 
the SANbox2-8c or SANbox2-16 Installation Guide for more information 
about TL_Ports.

G_Port Generic port - Self discovers as an F_Port or an E_Port.

GL_Port Generic loop port - Self discovers as an F_Port, FL_Port, or an E_Port. 
GL_Port is the default port mode. A single device on a public loop will 
attempt to configure as an F_Port first, then if that fails, as an FL_Port.

Donor Donor port - Allows buffer credits to used by another port.
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5.2.4
Changing Buffer-to-Buffer Credits

Each port has a receive buffer capacity of 12 Fibre Channel frames or credits 
which is equal to approximately 24K bytes. SANbox2 switches negotiate with 
other switches to resolve differences in the number of port buffer credits. 
However, some non-QLogic switches do not negotiate and will isolate when 
connected. To remedy this situation, disconnect the switches, reset the SANbox2 
port, then reconfigure the SANbox2 port to match the number of port buffer credits 
on the other switch. To change port buffer credits, do the following:

1. Determine the number of credits per port for the non-QLogic switch:
If the credits per port is less than 12, proceed to step 2.
If the credits per port is greater than 12, you must extend credits for the 
affected SANbox2 port to increase the number of credits to match that 
of the non-standard switch. Refer to ”Extending Port Credits” on 
page 5-11.

2. Select the ports in the faceplate display that are to serve as links to the 
non-QLogic switch.

3. Open the Port menu and select Port Properties.
4. In the E_Port BB Credits field, enter the number of credits per port of the 

non-standard switch and choose the OK button.
5. Connect the switches.

5.2.5
I/O Stream Guard

The I/O Stream Guard feature suppresses the generation of Registered State 
Control Notification (RSCN) messages on a port basis. Choose Enable in the Port 
Properties window to suppress the generation of RSCN messages for the 
selected port.

5.2.6
Extending Port Credits

Each port is supported by a data buffer with a 12 credit capacity; that is, 12 
maximum sized frames. For fibre optic cables, this enables full bandwidth service 
over a distance of 20 kilometers at 1 Gbps (0.6 credits/Km), or 10 kilometers at 2 
Gbps (1.2 credits/Km). Longer distances can be spanned at full bandwidth by 
borrowing credits from designated donor ports thus pooling the buffer capacities. 
This is called credit extension. Each donor port contributes 11 credits to the pool 
from which the recipient ports can draw. For example, one donor port contributes 
11 credits to the pool from which a recipient draws for a total of 23 credits (11+12). 
This provides approximately 38 Km at 1 Gbps (23÷0.6) or 19 Km at 2 Gbps 
(23÷1.2).

To extend port buffer credits, do the following:
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1. In the faceplate display, select the ports that are to serve as donor ports. 
Open the Port menu and select Port Properties. In the Port Properties 
window, choose the Donor radio button and choose OK.

2. In the faceplate display, select the recipient ports. Recipient ports must be 
configured as G_Ports or F_Ports. Open the Port menu and select 
Extended Credits. This opens the Extended Credits window shown in 
Figure 5-3.

3. Distribute the borrowed credits by incrementing the Ext Credits Requested 
field for the recipient ports up to the total credits in the pool. Choose OK. If 
you exceed this total, a message will be entered in the alarm log indicating 
that some recipient ports did not receive the requested credits.

Figure 5-3   Extended Credits Window

Note: Donor ports cannot transmit or receive data.
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4. To confirm that the requested credits were received, reopen the Extended 
Credits window and match the number of credits in the "Ext Credits 
Requested" column with the number in the "Donated to Port" column.

5.2.7
Resetting a Port

The Reset Port option reinitializes the port using configuration parameters in 
memory. To reset a port, do the following:

1. In the Faceplate Display, select the port(s) to be reset. 
2. Open the Port menu and select Reset Port.

5.3
Testing Ports

The port loopback tests verify correct port operation by sending a frame out 
through the loop, and then verifying that the frame received matches the frame 
that was sent. Only one port can be tested at a time for each type of test. The Port 
Loopback Test window shown in Figure 5-4 presents the following tests:

SerDes level (Internal) - The SerDes level test verifies port circuitry. The 
SerDes level test sends a test frame from the ASIC through the SerDes chip 
and back to the ASIC for the selected ports. The port passes the test if the 
frame that was sent by the ASIC matches the test frame that was received. 
This test disrupts communication on the selected port.
SFP level (External) - The SFP level test also verifies port circuitry. The 
SFP level test sends a test frame from the ASIC through the SerDes chip, 
through the SFP transceiver fitted with a loopback plug, and back to the 
ASIC for the selected ports. The port passes the test if the test frame that 
was sent by the ASIC matches the test frame that was received. This test 
disrupts communication on the selected port.
Node-to-Node (Online) - The Node-to-Node test verifies communications 
between the port and its device node or device loop. The port being tested 
must be online and connected to a remote device. The port passes the test if 
the frame that was sent by the ASIC matches the frame that was received. 
This test does not disrupt communication on the selected port.

Note: As credits are used, the Logged-In LEDs on the corresponding donor 
ports illuminate continuously. In addition, donor port Activity LEDs will 
reflect the same traffic as the recipient port. Donor ports whose credits 
are being used are unavailable to devices that are connected to them.
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Figure 5-4   Port Loopback Test Window

To run the internal, external, or online port loopback test on a port, do the 
following:

1. In the faceplate display, select the port to be tested.
2. Open the Port menu and select Port Loopback Test to open the Port 

Loopback Test window.
3. In the Test Selection area, choose the radio button for the type of loopback 

test to be run (Internal, External, or Online). If you choose the internal or 
external test, SANbox Manager will prompt you to confirm that the port state 
needs to be changed to the diagnostic state. Choose the OK button and 
SANbox Manager will change the port state.

4. Enter the frame count, frame size, and choose a test pattern radio button. 
You may use the default pattern or enter an 8-digit pattern (hex). For online 
test, you can select the Terminate Test Upon Error check box if you want 
the test to stop should it encounter an error.

Note: The SerDes (Internal) and SFP (External) level tests disrupt 
communication on the selected port. The Node-to-Node (Online) level 
test does not disrupt communication, because the requires that the port 
be online.
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5. Choose the Start Test button to begin the test. The Test Results area 
displays the test status, number of frames sent, and number of errors found.

6. To test another port, open the Select Port pull-down menu and select 
another port (number) and test type (Internal, External, or Online) in the Test 
Selection area.

7. Choose the Start Test button to begin the next test. Observe the results in 
the Test Results area.
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Notes
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Appendix A
Command Line Interface

Each switch contains a Telnet server. This server allows a Telnet client to establish 
a Telnet session with the switch to retrieve information or to configure parameters 
using the Command Line Interface (CLI). The CLI enables you to perform a 
variety of fabric and switch management tasks through an Ethernet or a serial port 
connection.

A.1
Logging On to a Switch

To log on to a switch using Telnet, open a command line window on the 
management workstation and enter the Telnet command followed by the switch IP 
address:

/> telnet 123.45.67.89

A Telnet window opens prompting you for a login. Enter an account name and 
password. Switches come from the factory with the following user account already 
defined:

Account name: admin
Password: password
Authority: Admin

This user account provides full access to the switch and its configuration. After 
planning your fabric management needs and creating your own user accounts, 
consider changing the password for this account. Refer to ”Commands” on 
page A-3 for more information about authority levels. Refer to the ”User 
Command” on page A-68 for information about creating user accounts.

Note: A switch supports a combined maximum of 15 logins. This includes 
SANbox Manager inband and out-of-band logins, Application 
Programming Interface (API) inband and out-of-band logins and Telnet 
logins. Of this 15, there can be a combined maximum of 10 SANbox 
Manager and API logins. Additional logins will be refused.
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A.2
Command Syntax

The command syntax is as follows:

command
keyword
keyword [value]
keyword [value1] [value2]

The Command is followed by one or more keywords. Consider the following rules 
and conventions:

Commands and keywords are lowercase and case sensitive.
Commands with keywords require one of those keywords.
Required keyword values appear in standard font: [value]. Optional values 
are shown in italics: [value].
Underlined portions of the keyword in the command format indicate the 
abbreviated form that can be used. For example the Delete keyword can be 
abbreviated Del.

Note: All examples are for a SANbox2-16 switch.
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A.3
Commands

The command set provides for User and Admin authority levels.

User authority grants viewing access to the fabric and switches using the 
Show command and other read-only commands.
Admin authority includes the User authority and grants permission to use the 
Admin command. The Admin Start command opens an admin session which 
provides access to the commands that change switch and fabric 
configurations. Refer to the ”Admin Command” on page A-4.

The commands and their page numbers are listed by authority level in Table A-1.

Note: Admin authority is enforced only if fabric security is enabled. By 
default, fabric security is disabled. Refer to ”Set Setup Command” on 
page A-39 (System keyword) for more about setting fabric security.

Table A-1. Commands Listed by Authority Level

User Authority Commands Admin Authority Command

Help
History
Ping
Ps
Quit
Show
Show Config
Show Log
Show Perf
Show Setup
Uptime
Whoami

(A-11)
(A-12)
(A-16)
(A-17)
(A-18)
(A-44)
(A-54)
(A-57)
(A-59)
(A-61)
(A-67)
(A-70)

Admin (A-4)

Admin Session Commands

Alias1

Config1

Date1

Fallback
Image
Lip
Passwd
Reset
Set1

Set Config
Set Log
Set Port
Set Setup
Shutdown
Test
User1

Zone1

Zoneset1

Zoning1

1Some keywords are available with User authority.

(A-5) 

(A-7) 

(A-9) 

(A-10)
(A-13)
(A-14)
(A-15)
(A-19)
(A-24) 

(A-26)
(A-35)
(A-38)
(A-39)
(A-63)
(A-64)
(A-68) 

(A-71) 

(A-75) 

(A-78) 
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Admin Command
Opens and closes an Admin session. The Admin session provides commands 
that change the fabric and switch configurations. Only one Admin session can be 
open on the switch at any time. An inactive Admin session will time out after a 
period of time which can be changed using the Set Setup System command. 
Refer to the ”Set Setup Command” on page A-39.

Authority Admin
Syntax admin

start (or begin)
end (stop)
cancel

Keywords start (or begin)
Opens the admin session.

end (or stop)
Closes the admin session. The Logout, Shutdown, and Reset Switch commands 
will also end an admin session.

cancel
Terminates an Admin session opened by another user. Use this keyword with care 
because it terminates the Admin session without warning the other user and 
without saving pending changes.

Notes Closing a Telnet window during an admin session does not release the session. In 
this case, you must either wait for the admin session to time out, or use the Admin 
Cancel command.

Examples The following example shows how to open and close an Admin session:
SANbox2 #> admin start

SANbox2 (admin) #>

.

.

.

SANbox2 (admin) #> admin end
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Alias Command
Creates a named set of ports/devices. Aliases make it easier to assign a set of 
ports/devices to many zones. An alias can not have a zone or another alias as a 
member.

Authority Admin
Syntax alias

add [alias] [members]
copy [alias_source] [alias_destination]
create [alias]
delete [alias]
list
members [alias]
remove [alias] [members]
rename [alias_old] [alias_new]

Keywords add [alias] [members]
Specifies one or more ports/devices given by [members] to add to the alias named 
[alias]. An alias can have a maximum of 2000 members. [members] can have one 
of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.

The application verifies that the [alias] format is correct, but does not validate that 
such a port/device exists.
copy [alias_source] [alias_destination]
Creates a new alias named [alias_destination] and copies the membership into it 
from the alias given by [alias_source].
create [alias]
Creates an alias with the name given by [alias]. An alias name must begin with a 
letter and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, 
and -. The zoning database supports a maximum of 256 aliases.
delete [alias]
Deletes the specified alias given by [alias] from the zoning database. If the alias is 
a member of the active zone set, the alias will not be removed from the active 
zone set until the active zone set is deactivated.
list
Displays a list of all aliases. This keyword is valid for User authority and does not 
require a zoning edit session or an admin session. 
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members [alias]
Displays all members of the alias given by [alias]. This keyword is available with 
User authority and does not require a zoning edit session or an admin session.
remove [alias] [members]
Removes the ports/devices given by [members] from the alias given by [alias]. 
[members] can have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) for the device with 
the format xx:xx:xx:xx:xx:xx:xx:xx.

rename [alias_old] [alias_new]
Renames the alias given by [alias_old] to the alias given by [alias_new].
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Config Command
Manages the Fibre Channel configurations on a switch. For information about 
setting the port and switch configurations, refer to the ”Set Config Command” on 
page A-26.

Authority Admin for all keywords except List
Syntax config

activate [config]
backup
cancel
copy [config_source] [config_destination]
delete [config]
edit [config]
list
restore
save [config]

Keywords activate [config]
Activates the configuration given by [config]. If you omit the configuration, the 
currently active configuration is used. Only one configuration can be active at a 
time.
backup
Creates a file named configdata, which contains the system configuration 
information. To download this file, open an FTP session, log in with account 
name/password of “images” for both, and type “get configdata”.
cancel
Terminates the current configuration edit session without saving changes that 
were made.
copy [config_source] [config_destination]
Copies the configuration given by [config_source] to the configuration given by 
[config_destination]. The switch supports up to 10 configurations including the 
default configuration.
delete [config]
Deletes the specified configuration file where [config] is a file name.
edit [config]
Opens an edit session for the configuration given by [config]. If you omit the 
configuration name, the currently active configuration is used.
list
Displays a list of all available configurations. This keyword is available with User 
authority.
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restore
Restores configuration settings to an out-of-band switch from a backup file named 
configdata, which must be first uploaded on the switch using FTP. You create the 
backup file using the Config Backup command. Use FTP to load the backup file 
on a switch, then enter the Config Restore command.

save [config]
Saves changes made during a configuration edit session in the configuration 
given by [config]. If you omit the configuration name value, the configuration you 
chose for the Config Edit command is used. The switch supports up to 10 
configurations including the default configuration.

Notes If you edit the active configuration, changes will be held in suspense until you 
reactivate the configuration or activate another configuration.

Examples The following shows an example of how to open and close a Config Edit session:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

.

.

.

SANbox2 (admin-config) #> config cancel

  Configuration mode will be canceled. Please confirm (y/n): [n] y

SANbox2 (admin) #> admin end

Note: Configuration archive files created with the SANbox Manager Archive 
function are not compatible with the Config Restore command.
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Date Command
This command displays or sets the system date and time. To set the date and time 
the information string must be provided in this format: MMDDhhmmCCYY. The 
new date and time takes effect immediately.

Authority Admin to change the date; User to display the date.
Syntax date

[MMDDhhmmCCYY]
Keywords [MMDDhhmmCCYY]

Specifies the date – this requires an admin session. If you omit 
[MMDDhhmmCCYY], the current date is displayed – this is available with User 
authority.

Examples The following is an example of the Date command:
SANbox2 #> date

  Mon Apr 07 07:51:24 2003
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Fallback Command
Loads the fallback version of the firmware from switch memory. The switch stores 
two versions of the firmware. This command alternately activates the two 
versions.

Authority Admin
Syntax fallback
Notes The Show Switch command displays the available firmware versions and 

the currently active version.
After executing the Fallback command, reset the switch for the firmware to 
be placed in effect.

Examples The following is an example of the Fallback command:
SANbox2 #> admin start

SANbox2 (admin) #> fallback

  Reverting to previous software image.  Please confirm (y/n): [n] y

SANbox2 #> admin end
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Help Command
Displays a brief description of the specified command and its keywords.

Authority User

Syntax help [command] [keyword]
Keywords [command]

Displays a summary of the command given by [command] and its keywords. If you 
omit [command], the system displays all available commands from which to 
choose.
[keyword]
Displays a summary of the keyword given by [keyword] belonging to the 
command given by [command]. If you omit [keyword], the system displays the 
available keywords for the specified command.
all
Displays a list of all available commands (including command variations).

Examples The following is an example of the Help Set command:
SANbox2 #> help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set alarm

    set beacon

    set blade

    set config blade

    set config port

    set config ports

    set config switch

    set config threshold

    set config zoning

    set log

    set pagebreak

    set port

    set setup snmp

    set setup system

    set switch

The following is an example of the Help Set Beacon command:
SANbox2 #> help set beacon

set beacon On | Off

This command allows the LEDs on the front of the switch to flash.

The On option will start and the Off option will stop the flashing.
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History Command
Displays a numbered list of the previously entered commands from which you can 
re-execute selected commands.

Authority User
Syntax history
Notes Use the History command to provide context for the ! command:

Enter ![command] to re-enter the most recent execution of that command.
Enter ![line number] to re-execute the corresponding command from the 
History display
Enter ![partial command string] to re-execute a command that matches the 
command string.
Enter !! to re-execute the most recent command.

Examples The following is an example of the History command:
SANbox2 #> history

   1 show switch

   2 date

   3 help set

   4 history

SANbox2 #> !3

help set

set SET_OPTIONS

There are many attributes that can be set.

Type help with one of the following to get more information:

    set alarm

    set beacon

    set blade

    set config blade

    set config port

    set config ports

    set config switch

    set config threshold

    set config zoning

    set log

    set pagebreak

    set port

    set setup snmp

    set setup system

    set switch



A – Command Line Interface
Image Command

59022-05 B A-13

Q

Image Command
Manages and installs switch firmware.

Authority Admin

Syntax image
cleanup
fetch [account_name] [ip_address] [file_source] [file_destination]
list
unpack [file]

Keywords cleanup
Removes all firmware image files from the switch. All firmware image files are 
removed automatically each time the switch is reset.
fetch [account_name] [ip_address] [file_source] [file_destination]
Retrieves image file given by [file_source] and stores it on the switch with the file 
name given by [file_destination]. The image file is retrieved from the device with 
the IP address given by [ip_address] and an account name given by 
[account_name]. If an account name needs a password to access the device, the 
system will prompt you for it.
list
Displays the list of image files that reside on the switch.
unpack [file]
Installs the firmware file given by [file]. After unpacking the file, a message 
appears confirming successful unpacking. The switch must be reset for the new 
firmware to take effect.

Notes To provide consistent performance throughout the fabric, ensure that all switches 
are running the same version of firmware.
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Lip Command
Reinitializes the specified loop port.

Authority Admin

Syntax lip [port_number]
Keywords [port_number]

The number of the port to be reinitialized.
Examples The following is an example of the Lip command:

SANbox2 (admin) #> lip 2
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Passwd Command
Changes a user account’s password.

Authority Admin to change another account’s password; User to change your own.

Syntax passwd [account_name]
Keywords [account_name]

The user account name. You must open an admin session to change the 
password for an account name other than your own. If you omit [account_name], 
you will be prompted to change the password for the current account name.

Examples The following is an example of the Passwd command:
SANbox2 (admin) #> passwd user2

      Press 'q' and the ENTER key to abort this command.

  account OLD password               :

  account NEW password (4-20 chars)  :

  please confirm account NEW password:

  password has been changed.
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Ping Command
Initiates an attempt to communicate with another switch in the fabric and reports 
the result.

Authority User
Syntax ping

ip_address
Keywords ip_address

The IP address of the switch to query.

Examples The following is an example of a successful Ping command:
SANbox2 #> ping 10.20.11.57

  Ping command issued. Waiting for response...

SANbox2 #>

  Response successfully received from 10.20.11.57.

This following is an example of an unsuccessful Ping command:
SANbox2 #> ping 10.20.10.100

  Ping command issued. Waiting for response...

  Alarm Msg: [day month date time year][A4101][0xdd0090e8.289][cmon: unable to send 
ping to IP address 10.20.11.100]

  No response from 10.20.10.100. Unreachable.
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Ps Command
Displays current system process information.

Authority User

Syntax ps
Examples The following is an example of the Ps command:

SANbox2 #> ps

PID  PPID %CPU     TIME     ELAPSED COMMAND

298   292  0.0 00:00:00 59:42       cns

299   292  0.0 00:00:00 59:42       ens

300   292  0.0 00:00:00 59:42       dlog

301   292  0.3 00:00:53 59:42       ds

302   292  0.2 00:00:29 59:42       mgmtApp

303   292  0.0 00:00:02 59:42       nserver

304   292  0.0 00:00:00 59:42       mserver

305   292  0.1 00:00:15 59:42       util

306   292  0.0 00:00:04 59:42       eport

307   292  1.2 00:02:53 59:41       PortApp

308   292  0.0 00:00:01 59:41       zoning

309   292  0.0 00:00:00 59:41       diagApp
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Quit Command
Closes the Telnet session.

Authority User

Syntax quit, exit, or logout
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Reset Command
Resets the switch configuration parameters.

Authority Admin

Syntax reset
config [config_name]
factory
port [port_number]
snmp
switch (default)
system
zoning

Keywords config [config_name]
Resets the configuration given by [config_name] to the factory default values for 
switch, port, alarm threshold, and zoning configuration. This keyword clears all 
zoning definitions. If [config_name] does not exist on the switch, a configuration 
with that name will be created. If you omit [config_name], the active configuration 
is reset. You must activate the configuration or reset the switch for the changes to 
take effect. Refer to Table A-2 through Table A-4 for switch, port, and alarm 
threshold configuration default values.
factory
Resets switch, alarm threshold, zoning, SNMP, zoning configuration, and system 
configuration settings to the factory default values. The switch configuration is 
activated automatically. Refer to Table A-2 through Table A-6.
port [port_number]
Reinitializes the port given by [port_number]. Ports are numbered beginning 
with 0.
snmp
Resets the SNMP configuration settings to the factory default values. Refer to 
Table A-5 for SNMP configuration default values.
switch
Reinitializes the switch. This is the default. This command also closes the Telnet 
session.
system
Resets the system configuration settings to the factory default values. Refer to 
Table A-6 for system configuration default values.
zoning
Clears the zoning database and deactivates the active zone set. The zoning 
configuration values (autosave, default visibility) remain unchanged.

Notes The following tables specify the various factory default settings:
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Table A-2. Switch Configuration Defaults

Parameter Default

Admin State Online

Broadcast Enabled True

InbandEnabled True

Domain ID 1

Domain ID Lock False

Symbolic Name SANbox2

R_T_TOV 100

R_A_TOV 10000

E_D_TOV 2000

FS_TOV 5000

DS_TOV 5000

Principal Priority 254

Configuration Description Undefined

Configuration Last Saved By Initial

Configuration Last Saved On Initial

Table A-3. Port Configuration Defaults 

Parameter Default

Admin State Online

Link Speed Auto

Port Type GL

ISL Security Any

Symbolic Name Port

ALFairness False

DeviceScanEnabled True

ForceOfflineRSCN False

ARB_FF False
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InteropCredit 0

ExtCredit 0

FANEnable True

LCFEnable False

MFSEnable True

MFS_TOV 10

MSEnable True

NoClose False

IOStreamGuard Disabled

VIEnable False

CheckAlps False

Table A-4. Alarm Threshold Configuration Defaults 

Parameter Default

ThresholdMonitoringEnabled False

CRCErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
25
1
10

DecodeErrorsMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
25
0
10

ISLMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
2
0
10

LoginMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

Table A-3. Port Configuration Defaults (Continued)

Parameter Default
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LogoutMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
5
1
10

LOSMonitoringEnabled
RisingTrigger
FallingTrigger
SampleWindow

True
100
5
10

Table A-5. SNMP Configuration Defaults

Parameter Default

Contact Undefined

Location Undefined

Description QLogic SANbox2 FC Switch

Trap [1-5] Address Trap 1: 10.0.0.254; Traps 2–5: 0.0.0.0

Trap [1-5] Port Undefined

Trap [1-5] Severity Warning

Trap [1-5] Version 2

Trap [1-5] Enabled False

ObjectID
1.3.6.1.4.1.1663.1.1.1.1.11 (SANbox2-16) 

AuthFailureTrap False

ProxyEnabled True

Table A-4. Alarm Threshold Configuration Defaults (Continued)

Parameter Default
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Table A-6. System Configuration Defaults

Parameter Default

Ethernet Network Discovery Static

Ethernet Network IP Address 10.0.0.1

Ethernet Network IP Mask 255.0.0.0

Ethernet Gateway Address 10.0.0.254

Admin Timeout 30 minutes

SecurityEnabled False

LocalLogEnabled True

RemotelogEnabled False

RemoteLogHostAddress 10.0.0.254
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Set Command
Sets a variety of switch parameters.

Authority Admin for all keywords except Alarm Clear, Beacon, and Pagebreak which are 
available with User authority.

Syntax set
alarm clear
beacon [state]
config [option]
log [option]
pagebreak [state]
port [option]
setup [option]
switch [state]

Keywords alarm clear
Clears the alarm log. This keyword is available with User authority.
beacon [state]
Enables or disables the flashing of the Logged-In LEDs according to [state]. This 
keyword is available with User authority. [state] can be one of the following:

on
Enables the flashing beacon.
off
Disables the flashing beacon.

config [option]
Sets switch, port, alarm threshold, and zoning configuration parameters. Refer to 
the ”Set Config Command” on page A-26.
log [option]
Specifies the type of entries to be entered in the event log. Refer to the ”Set Log 
Command” on page A-35.
pagebreak [state]
Specifies how much information is displayed on the screen at a time according to 
the value given by [state]. This keyword is available with User authority. [state] can 
be one of the following:

on
Limits the display of information to 20 lines at a time. The page break 
functions affects the following commands: Alias (List, Members), Show 
(Alarm, Log), Zone (List, Members), Zoneset (List, Zones), Zoning (Active, 
List).
off
Allows continuous display of information without a break.
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port [option]
Sets port state and speed for the specified port temporarily until the next switch 
reset or new configuration activation. Refer to the ”Set Port Command” on 
page A-38.
setup [option]
Changes SNMP and system configuration settings. Refer to the ”Set Setup 
Command” on page A-39.
switch [state]
Temporarily changes the administrative state for all ports on the switch to the state 
given by [state]. The previous Set Config Switch settings are restored after a 
switch reset or a reactivation of a switch configuration. [state] can be one of the 
following:

online
Places all ports online
offline
Places all ports offline.
diagnostics
Prepares all ports for testing.

Examples The following examples enables and disables the beacon:
SANbox2 #> set beacon on

  Command succeeded.

SANbox2 $> set beacon off

  Command succeeded.
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Set Config Command
Sets switch, port, alarm threshold, and zoning configuration parameters.

Authority Admin authority and a Config Edit session

Syntax set config
port [port_number]
ports [port_number]
switch
threshold
zoning

Keywords port [port_number]
Initiates an edit session in which to change configuration parameters for the port 
number given by [port_number]. If you omit [port_number], the system begins with 
port 0 and proceeds in order through the last port. For each parameter, enter a 
new value or press the Enter key to accept the current value shown in brackets. 
Enter “q” to cancel the configuration for one port, or “qq” to cancel the 
configuration for all ports. Table A-7 describes the port parameters.
ports [port_number]
Initiates an editing session in which to change configuration parameters for all 
ports based on the configuration for the port given by [port_number]. If you omit 
[port_number], port 0 is used. For each parameter, enter a new value or press the 
Enter key to accept the current value shown in brackets. Enter “q” to cancel the 
configuration. Table A-7 describes the port parameters.

Table A-7. Set Config Port Parameters 

Parameter Description

AdminState Port administrative state: online, offline, 
diagnostics, or down.

LinkSpeed 1Gb/sec, 2 Gb/sec, or Auto

PortType Type of port

ISLSecurity E_Port security. Determines which 
switches a port will establish a link with.

Any - link with any FC-SW-2 compliant 
switch.
Ours - link only with an FC-SW-2 
compliant QLogic switch.
None - reject the link.

SymbolicPortName Descriptive name 

ALFairness Arbitration loop fairness. Enables (True) or 
disables (False) the switch’s priority to 
arbitrate on the loop.
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DeviceScanEnabled Enables (True) or disables (False) the 
scanning of the connected device for FC-4 
descriptor information during login. The 
default is True.

ForceOfflineRSCN Enables (False) or disables (True) the 
immediate transmission of RSCN 
messages when communication between 
a port and its device is interrupted. If 
enabled, the RSCN message is queued 
for 200 ms. The default is False. This 
parameter is ignored if IOStreamGuard is 
enabled.

ARB_FF Use ARB_FF instead of idles on loop 
FCAL option 

InteropCredit Interoperability credit. The number of 
buffer-to-buffer credits per port. 0 means 
the default (12) is unchanged.

ExtCredit Extended credits. The number of port 
buffer credits that this port can acquire 
from donor ports.

FANEnable Fabric address notification. Enables (True) 
or disables (False) the communication of 
the FL_Port address, port name, and node 
name to the logged-in NL_Port.

LCFEnable Link control frame preference, R_CTL = 
0xC 

MFS_TOV MFS limit for camp on

MFSEnable Multi-Frame Sequence bundling

MSEnable Management Server enable on this port

NoClose Don't close unless another device 
arbitrates

IOStreamGuard Enables or disables the suppression of 
RSCN messages

VIEnable Enable VI preference routing

CheckAlps Close before sending frames to new target

Table A-7. Set Config Port Parameters (Continued)

Parameter Description
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switch
Initiates an editing session in which to change switch configuration settings. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets.

Table A-8. Set Config Switch Parameters 

Parameter Description

AdminState Switch administrative state: online, offline, 
or diagnostics

BroadcastEnabled Enables (True) or disables (False) 
forwarding of broadcast frames.

InbandEnabled Enables (True) or disables (False) the 
ability to manage the switch over an ISL.

DefaultDomainID Default domain ID setting

DomainIDLock Prevents (True) or allows (False) dynamic 
reassignment of the domain ID.

SymbolicName Descriptive name

R_T_TOV Receiver Transmitter Timeout Value. 
Specifies the number of milliseconds a 
port is to wait to receive a response from 
another port. The default is 100.

R_A_TOV Resource Allocation Timeout Value. The 
number of milliseconds the switch waits to 
allow two ports to allocate enough 
resources to establish a link. The default is 
10000.

E_D_TOV Error Detect Timeout Value. The number 
of milliseconds a port is to wait for errors to 
clear. The default is 2000.

FS_TOV Fabric Stability Timeout Value. The default 
is 5000 msec.

DS_TOV Distributed Services Timeout Value 
(Management Server, Name Server). The 
default is 5000 msec.
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threshold
Initiates a configuration session by which to generate and log alarms for selected 
events. The system displays each event, its thresholds, and sampling interval one 
line at a time and prompts you for a value. For each parameter, enter a new value 
or press the Enter key to accept the current value shown in brackets. These 
parameters must be saved in a configuration and activated before they will take 
effect. Refer to the ”Config Command” on page A-7 for information about saving 
and activating a configuration. Table A-9 describes the Set Config Threshold 
parameters. The switch will down a port if an alarm condition is not cleared within 
three consecutive sampling intervals (by default 30 seconds). An alarm is cleared 
when the threshold monitoring detects that the error rate has fallen below the 
falling threshold.

PrincipalPriority The priority used in the FC-SW-2 principal 
switch selection algorithm. 1 is high, 255 is 
low.

ConfigDescription The name for the configuration. The 
default is undefined.

Table A-9. Set Config Threshold Parameters 

Parameter Description

Threshold Monitoring Enabled Master enable/disable parameter for all 
events. Enables (True) or disables (False) 
the generation of all enabled event alarms. 
The default is False.

CRCErrorsMonitoringEnabled
DecodeErrorsMonitoringEnabled
ISLMonitoringEnabled
LoginMonitoringEnabled
LogoutMonitoringEnabled
LOSMonitoringEnabled

The event type enable/disable parameter. 
Enables (True) or disables (False) the 
generation of alarms for each of the 
following events:

CRC errors
Decode errors
ISL connection count
Login errors
Logout errors
Loss-of-signal errors

Table A-8. Set Config Switch Parameters (Continued)

Parameter Description
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zoning
Initiates an editing session in which to change switch zoning attributes. The 
system displays each parameter one line at a time and prompts you for a value. 
For each parameter, enter a new value or press the Enter key to accept the 
current value shown in brackets.

Rising Trigger The event count above which a rising 
threshold alarm is logged. The switch will 
not generate another rising threshold 
alarm for that event until the count 
descends below the falling threshold and 
again exceeds the rising threshold.

Falling Trigger The event count below which a falling 
threshold alarm is logged. The switch will 
not generate another falling threshold 
alarm for that event until the count 
exceeds the rising threshold and 
descends again below the falling 
threshold.

Sample Window The period of time in seconds in which to 
count events.

Table A-10. Set Config Zoning Parameters

Parameter Description

AutoSave Enables (True) or disables (False) the 
saving of changes to active zone set in the 
switch’s permanent memory. Changes are 
always saved in the switch’s temporary 
memory.

Default Enables (All) or disables (None) 
communication among the switch’s 
ports/devices and the fabric in the 
absence of an active zone set.

Table A-9. Set Config Threshold Parameters (Continued)

Parameter Description
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Examples The following is an example of the Set Config Port command:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config port 1

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  Configuring Port Number:  1

  ------------------------

  AdminState    (1=Online, 2=Offline, 3=Diagnostics, 4=Down)       [Online]

  LinkSpeed     (1=1Gb/s, 2=2Gb/s, 3=Auto)                         [Auto  ]

  PortType      (TL / GL / G / F / FL / Donor)                     [GL    ]

  ISLSecurity   (Any /  Ours / None)                               [Any   ]

  SymPortName   (string, max=32 chars)                             [Port1 ]

  ALFairness    (True / False)                                     [False ]

  DeviceScanEnable (True / False)                                  [True    ]

  ForceOfflineRSCN (True / False)                                  [False   ]

  ARB_FF        (True / False)                                     [False ]

  InteropCredit (decimal value, 0-255)                             [0     ]

  ExtCredit     (dec value, increments of 11, non-loop only)       [0     ]

  FANEnable     (True / False)                                     [True  ]

  LCFEnable     (True / False)                                     [False ]

  MFSEnable     (True / False)                                     [False ]

  MFS_TOV       (decimal value, 10-20480 msec)                     [640   ]

  MSEnable      (True / False)                                     [True  ]

  NoClose       (True / False)                                     [False ]

  IOStreamGuard (Enable / Disable)                                 [Disable]

  VIEnable      (True / False)                                     [False ]

  CheckAlps     (True / False)                                     [False ]

  

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.
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The following is an example of the Set Config Switch command:
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config switch

  A list of attributes with formatting and default values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  AdminState         (1=Online, 2=Offline, 3=Diagnostics) [Online       ]

  BroadcastEnable    (True / False)                       [False        ]

  InbandEnabled      (True / False)                       [False        ]

  DefaultDomainID    (decimal value, 1-239)               [11           ]

  DomainIDLock       (True / False)                       [True         ]

  SymbolicName       (string, max=32 chars)               [SANbox2 switch]

  R_T_TOV            (decimal value, 1-1000 msec)         [100          ]

  R_A_TOV            (decimal value, 100-100000 msec)     [10000        ]

  E_D_TOV            (decimal value, 10-20000 msec)       [2000         ]

  FS_TOV             (decimal value, 100-100000 msec)     [5000         ]

  DS_TOV             (decimal value, 100-100000 msec)     [5000         ]

  PrincipalPriority  (decimal value, 1-255)               [254          ]

  ConfigDescription  (string, max=32 chars)               [             ]

The following is an example of the Set Config Threshold command:
SANbox2 #> admin start

SANbox2  (admin) #> config edit

SANbox2 (admin-config) #> set config threshold

A list of attributes with formatting and current values will follow.

 Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

 press 'q' or 'Q' and the ENTER key to do so.

  

ThresholdMonitoringEnabled     (True / False)              [True]

  

CRCErrorsMonitoringEnabled     (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [25 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

DecodeErrorsMonitoringEnabled  (True / False)              [True]
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  RisingTrigger                (decimal value, 1-1000)     [200 ]

  FallingTrigger               (decimal value, 0-1000)     [0 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

ISLMonitoringEnabled           (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [2 ]

  FallingTrigger               (decimal value, 0-1000)     [0 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

LoginMonitoringEnabled         (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [5 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

LogoutMonitoringEnabled        (True / False)              [True]

  RisingTrigger                (decimal value, 1-1000)     [5 ]

  FallingTrigger               (decimal value, 0-1000)     [1 ]

  SampleWindow                 (decimal value, 1-1000 sec) [10 ]

  

LOSMonitoringEnabled           (True / False)               [True]

  RisingTrigger                (decimal value, 1-1000)      [100 ]

  FallingTrigger               (decimal value, 0-1000)      [5 ]

  SampleWindow                 (decimal value, 1-1000 sec)  [10 ]

  

Finished configuring attributes.

This configuration must be saved (see config save command) and activated (see 
config activate command) before it can take effect. To discard this configuration 
use the config cancel command.
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The following is an example of the Set Config Zoning command.
SANbox2 #> admin start

SANbox2 (admin) #> config edit

SANbox2 (admin-config) #> set config zoning

A list of attributes with formatting and current values will follow.

Enter a new value or simply press the ENTER key to accept the current value.

If you wish to terminate this process before reaching the end of the list press 'q' 
or 'Q' and the ENTER key to do so.

  AutoSave      (True / False)  [True]

  Default       (All / None)    [All ]

  Finished configuring attributes.

  This configuration must be saved (see config save command) and

  activated (see config activate command) before it can take effect.

  To discard this configuration use the config cancel command.
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Set Log Command
Specifies the type of entries to be entered in the event log. The log is a storage file 
contained on the switch. The log can hold a maximum of 200 entries. When the 
log becomes full, the entries are replaced, starting with the oldest entry, to 
produce a list of the last 200 events which occurred. Log entries are created for 
ports, components, and event severity levels.

Authority Admin
Syntax set log

archive
clear
component [list]
level [level]
port [port_list]
restore
save
start (default)
stop

Keywords archive
Archives the log entries to a file on the switch named logfile that can be 
downloaded from the switch using FTP. To download the log file, open an FTP 
session, log in with account name/password of “images” for both, and type “get 
logfile”.
clear
Clears all log entries.
component [list]
Specifies one or more components to monitor for events. Use spaces to delimit 
values in the list. Choose one or more of the following values:

All
Monitors all components. To maintain optimal switch performance, do not 
use this setting with the Level keyword set to Info.
Chassis
Monitors chassis hardware components such as fans and power supplies.
Eport
Monitors all E_Ports.
Mgmtserver
Monitors management server status.
Nameserver
Monitors name server status.
None
Monitor none of the component events.
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Other
Monitors other miscellaneous events.
Port
Monitors all port events
Switch
Monitors switch management events.
Zoning
Monitors zoning conflict events.

level [level]
Specifies the severity level given by [level] to use in monitoring events for the 
specified components or ports. [level] can be one of the following values:

Critical
Monitors critical events.
Warn
Monitors warning events.
Info
Monitors informational events. To maintain optimal switch performance, do 
not use this setting with the Component keyword set to All.
None
Monitors none of the severity levels.

port [port_list]
Specifies one or more ports to monitor for events. Choose one of the following 
values:

[port_list]
Specifies port or ports to monitor. Use spaces to delimit values in the list. 
Ports are numbered beginning with 0.
All
Specifies all ports.
None
Disables monitoring on all ports.

restore
Returns the port, component, and level settings to the default values.
save
Saves the log settings for the component, level, and port. These settings remain 
in effect after a switch reset. The log settings can be viewed using the Show Log 
Settings command. To export log entries to a file, use the Set Log Archive 
command.
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start
Starts the logging of events based on the Port, Component, and Level keywords 
assigned to the current configuration. The logging continues until you enter the 
Set Log Stop command.
stop
Stops logging of events.

Notes To maintain optimal switch performance, do not set the Component keyword to All 
and the Level keyword to Info at the same time.



A – Command Line Interface
Set Port Command

A-38 59022-05 B

Q

Set Port Command
Sets port state and speed for the specified port temporarily until the next switch 
reset or new configuration activation. This command also clears port counters.

Authority Admin
Syntax set port [port_number]

bypass [alpa]
clear 
enable
speed [transmission_speed]
state [state]

Keywords [port_number]
Specifies the port. Ports are numbered beginning with 0.
bypass [alpa]
Sends a Loop Port Bypass (LPB) to a specific Arbitrated Loop Physical Address 
(ALPA) or to all ALPAs on the arbitrated loop. [alpa] can be a specific ALPA or the 
keyword ALL to choose all ALPAs.
clear
Clears the counters on the specified port.
enable
Sends a Loop Port Enable (LPE) to all ALPAs on the arbitrated loop.
speed [transmission_speed]
Specifies the transmission speed for the specified port. Choose one of the 
following port speed values:

1Gb/s
One gigabit per second.
2Gb/s
Two gigabits per second.
Auto
The port speed is automatically detected.

state [state]
Specifies one of the following administrative states for the specified port:

Online
Places the port online.
Offline
Places the port offline.
Diagnostics
Prepares the port for testing.
Down
Disables the port.
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Set Setup Command
Changes SNMP and system configuration settings. The switch maintains one 
SNMP configuration and one system configuration.

Authority Admin
Syntax set setup

snmp
system

Keywords snmp
Prompts you in a line-by-line fashion to change SNMP configuration settings. 
Table A-11 describes the SNMP fields. For each parameter, enter a new value or 
press the Enter key to accept the current value shown in brackets.

Table A-11. SNMP Configuration Settings

Entry Description

Contact Specifies the name of the person to be contacted to respond to 
trap events. The default is undefined.

Location Specifies the name of the switch location. The default is 
undefined.

Trap [1-5] Address Specifies the workstation IP address to which SNMP traps are 
sent. The default address for trap 1 is 10.0.0.254. The default 
address for traps 2–5 is 0.0.0.0.

Trap [1-5] Port Specifies the workstation port to which SNMP traps are sent.

Trap [1-5] Severity Specifies the severity level to use when monitoring trap events. 
The default is Warning

Trap [1-5] Version Specifies the SNMP version (1 or 2) to use in formatting traps. 
The default is version 2.

Trap [1-5] Enabled Specifies whether traps (event information) are enabled or 
disabled (default).

ReadCommunity Read community password that authorizes an SNMP agent to 
read information from the switch. This is a write-only field. The 
value on the switch and the SNMP management server must 
be the same. The default is “public”.

WriteCommunity Write community password that authorizes an SNMP agent to 
write information to the switch. This is a write-only field. The 
value on the switch and the SNMP management server must 
be the same. The default is “private”.
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system
Prompts you in a line-by-line fashion to change system configuration settings. 
Table A-12 describes the system configuration fields. For each parameter, enter a 
new value or press the Enter key to accept the current value shown in brackets.

TrapCommunity Trap community password that authorizes an SNMP agent to 
receive traps. This is a write-only field. The value on the switch 
and the SNMP management server must be the same. The 
default is “public”.

AuthFailureTrap Enables (True) or disables (False) the generation of traps in 
response to trap authentication failures. The default is False.

ProxyEnabled Enables (True) or disables (False) SNMP communication with 
other switches in the fabric. The default is True.

Table A-12. System Configuration Settings 

Entry Description

Eth0NetworkDiscovery Boot Method (1 - Static, 2 - Bootp, 3 - DHCP, 4 - 
RARP)

Eth0NetworkAddress Internet Protocol (IP) address for the Ethernet port.

Eth0NetworkMask Subnet mask address for the Ethernet port.

Eth0GatewayAddress IP address gateway.

AdminTimeout Specifies the amount of time in minutes the switch 
waits before terminating an idle Admin session. Zero 
(0) disables the time out threshold. The default is 30, 
the maximum is 1440.

TempMonitoringWarning Warning temperature threshold in °C above which a 
warning condition alarm is generated. The default is 
65 °C.

TempMonitoringFailure Failure temperature threshold in °C above which a 
failure condition alarm is generated. The default is 70 
°C.

TempFailurePortShutdown Enables (True) or disables (False) the switch’s ability 
to place all ports offline when the internal temperature 
exceeds the failure threshold. The default is False.

Table A-11. SNMP Configuration Settings

Entry Description
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Notes The two components of security are user authentication and fabric security. The 
user must be authenticated before gaining access to a switch. If an invalid 
account name/password combination is entered, that user can not access the 
switch, and thus can not gain access to the fabric. If security is enabled (True) and 
a valid account name/password combination is entered, that user can access the 
switch but can not execute any command that exceeds their authority (privileges) 
level. If security is disabled (False) and a valid account name/password 
combination is entered, that user has access to all switches in the fabric and can 
execute all commands (both user and admin), regardless of their authority 
(privilege) level.

Examples The following is an example of the Set Setup SNMP command:
SANbox2 #> admin start

SANbox2 (admin) #> set setup snmp

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

  Trap Severity Options

  ---------------------

  unknown, emergency, alert, critical, error, warning, notify, info, debug, mark

  Contact             (string, max=32 chars)       [<sysContact undefined]

  Location            (string, max=32 chars)       [sysLocation undefined]

  Trap1Address        (dot-notated IP Address)     [10.20.71.15      ]

  Trap1Port           (decimal value)              [162              ]

  Trap1Severity       (see allowed options above)  [warning          ]

SecurityEnabled Enables (True) or disables (False) the enforcement of 
account names and passwords. The default is False.

LocalLogEnabled Enables (True) or disables (False) the saving of log 
information on the switch. The default is True.

RemoteLogEnabled Enables (True) or disables (False) the recording of 
the switch event log on a remote host that supports 
the syslog protocol. The default is False.

RemoteLogHostAddress The IP address of the host that will receive the switch 
event log information if remote logging is enabled. 
The default is 10.0.0.254.

Table A-12. System Configuration Settings (Continued)

Entry Description



A – Command Line Interface
Set Setup Command

A-42 59022-05 B

Q

  Trap1Version        (1 / 2)                      [2                ]

  Trap1Enabled        (True / False)               [False            ]

  Trap2Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap2Port           (decimal value)              [162              ]

  Trap2Severity       (see allowed options above)  [warning          ]

  Trap2Version        (1 / 2)                      [2                ]

  Trap2Enabled        (True / False)               [False            ]

  Trap3Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap3Port           (decimal value)              [162              ]

  Trap3Severity       (see allowed options above)  [warning          ]

  Trap3Version        (1 / 2)                      [2                ]

  Trap3Enabled        (True / False)               [False            ]

  Trap4Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap4Port           (decimal value)              [162              ]

  Trap4Severity       (see allowed options above)  [warning          ]

  Trap4Version        (1 / 2)                      [2                ]

  Trap4Enabled        (True / False)               [False            ]

  Trap5Address        (dot-notated IP Address)     [0.0.0.0          ]

  Trap5Port           (decimal value)              [162              ]

  Trap5Severity       (see allowed options above)  [warning          ]

  Trap5Version        (1 / 2)                      [2                ]

  Trap5Enabled        (True / False)               [False            ]

  ReadCommunity       (string, max=32 chars)       [public           ]

  WriteCommunity      (string, max=32 chars)       [private          ]

  TrapCommunity       (string, max=32 chars)       [public           ]

  AuthFailureTrap     (True / False)               [False            ]

  ProxyEnabled        (True / False)               [True             ]
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The following is an example of the Set Setup System command:
SANbox2 (admin) #> set setup system

  A list of attributes with formatting and current values will follow.

  Enter a new value or simply press the ENTER key to accept the current value.

  If you wish to terminate this process before reaching the end of the list

  press 'q' or 'Q' and the ENTER key to do so.

Eth0NetworkDiscovery    (1=Static, 2=Bootp, 3=Dhcp, 4=Rarp)          [Static        ]

Eth0NetworkAddress      (dot-notated IP Address)                     [10.0.0.1      ]

Eth0NetworkMask         (dot-notated IP Address)                     [255.255.255.0 ]

Eth0GatewayAddress      (dot-notated IP Address)                     [10.0.0.254    ]

AdminTimeout            (dec value 0-1440 minutes, 0=never)          [30            ]

TempMonitoringWarning    (dec value 0-100 degrees Celsius)           [65            ]

TempMonitoringFailure    (dec value 0-100 degrees Celsius)           [70            ]

TempFailurePortShutdown  (True / False)                              [False         ]

SecurityEnabled         (True / False)                               [False         ]

LocalLogEnabled         (True / False)                               [True          ]

RemoteLogEnabled        (True / False)                               [False         ]

RemoteLogHostAddress    (dot-notated IP Address)                     [10.0.0.254    ]
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Show Command
Displays fabric, switch, and port operational information.

Authority User

Syntax show
about
alarm
broadcast
chassis
config [option]
domains
donor
fabric
interface
log [option]
lsdb
mem [count]
ns [option]
pagebreak
perf [option]
port [port_number]
post log
setup [option]
steering [domain_id]
support
switch
topology
users
version

Keywords about
Displays an introductory set of information about operational attributes of the 
switch. This keyword is equivalent to the Version keyword.
alarm
Displays the last 200 alarm entries.
broadcast
Displays the broadcast tree information and all ports that are currently transmitting 
and receiving broadcast frames.
chassis
Displays chassis component status and temperature.
config [option]
Displays switch and port configuration attributes. Refer to the ”Show Config 
Command” on page A-54.
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domains
Displays list of each domain and its worldwide name in the fabric.
donor
Displays list of current donor configuration for all ports.
fabric
Displays list of each domain, fabric ID, worldwide name, node IP address, and 
port IP address.
interface
Displays the status of the active network interfaces.
log [option]
Displays log entries. Refer to the ”Show Log Command” on page A-57.
lsdb
Displays Link State database information.
mem [count]
Displays information about memory activity for the number of seconds given by 
[count]. If you omit [count], the value 1 is used. Displayed memory values are in 
1K block units.

ns [option]
Displays name server information for the specified [option]. If you omit [option], 
name server information for the local domain ID is displayed. [option] can have the 
following values:

all
Displays name server information for all switches and ports.
[domain_id]
Displays name server information for the switch given by [domain_id]. 
[domain_id] is a switch domain ID.
[port_id]
Displays name server information for the port given by [port_id]. [port_id] is a 
port Fibre Channel address.

pagebreak
Displays the current pagebreak setting. The pagebreak setting limits the display of 
information to 20 lines (On) or allows the continuous display of information without 
a break (Off).

Note: This keyword will display memory activity updates until [count] is 
reached – it cannot be interrupted. Therefore, avoid using large values 
for [count].
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perf [option]
Displays performance information for all ports. Refer to the ”Show Perf Command” 
on page A-59.
port [port_number]
Displays operational information for the port given by [port_number]. Ports are 
numbered beginning with 0. If the port number is omitted, information is displayed 
for all ports. Table A-13 describes the port parameters.

Table A-13. Show Port Parameters 

Entry Description

AIinit Incremented each time the port begins AL initialization.

AIinitError Number of times the port entered initialization and the 
initialization failed.

ClassXFramesIn Number of class x frames received by this port.

ClassXFramesOut Number of class x frames sent by this port.

ClassXWordsIn Number of class x words received by this port.

ClassXWordsOut Number of class x words sent by this port.

DecodeError Decoding error detected.

FBusy Number of times the switch sent a F_BSY because Class 2 
frame could not be delivered within ED_TOV time. Number of 
class 2 and class 3 fabric busy (F_BSY) frames generated by 
this port in response to incoming frames. This usually 
indicates a busy condition on the fabric or N_Port that is 
preventing delivery of this frame.

Flowerrors Received a frame when there were no available credits.

FReject Number of frames from devices that were rejected.

InvalidCRC Invalid CRC detected.

InvalidDestAddr Invalid destination address detected.

LIP_AL_PD_AL_PS Number of F7, AL_PS LIPs, or AL_PD (vendor specific) 
resets, performed.

LIP_F7_AL_PS This LIP is used to reinitialize the loop. An L_port, identified 
by AL_PS, may have noticed a performance degradation and 
is trying to restore the loop.

LIP_F8_AL_PS This LIP denotes a loop failure detected by the L_port 
identified by AL_PS.
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LIP_F7_F7 A loop initialization primitive frame used to acquire a valid 
AL_PA.

LIP_F8_F7 A loop initialization primitive frame used to indicate that a loop 
failure has been detected at the receiver.

Link Failures Number of optical link failures detected by this port. A link 
failure is a loss of synchronization for a period of time greater 
than the value of R_T_TOV or by loss of signal while not in 
the offline state. A loss of signal causes the switch to attempt 
to re-establish the link. If the link is not re-established by the 
time specified by R_T_TOV, a link failure is counted. A link 
reset is performed after a link failure.

Login Time when the port logged in.

Logout Time when port logged out.

LoopTimeouts A two (2) second timeout as specified by FC-AL-2.

LossOfSync Number of synchronization losses (>100 ms) detected by this 
port. A loss of synchronization is detected by receipt of an 
invalid transmission word.

PrimSeqErrors Primitive sequence errors detected.

RxLinkResets Number of link reset primitives received from an attached 
device.

RxOfflineSeq Number of offline sequences received. An OLS is issued for 
link initialization, a Receive & Recognize Not_Operational 
(NOS) state, or to enter the offline state.

TotalErrors Total number of errors detected.

TotalLIPsRecvd Number of loop initialization primitive frames received by this 
port.

TotalLinkResets Total number of link reset primatives. 

TotalOfflineSeq Total number of Offline Sequences issued by this port. 

TotalRxFrames Total number of frames received by this port.

TotalRxWords Total number of words received by this port.

TotalTxFrames Total number of frames issued by this port.

TotalTxWords Total number of words issued by this port.

TxLinkResets Number of Link Resets issued by this port.

Table A-13. Show Port Parameters (Continued)

Entry Description
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post log
Displays the Power On Self Test (POST) log which contains results from the 
POST.
setup [option]
Displays setup attributes for the system, SNMP, and the switch manufacturer. 
Refer to the ”Show Setup Command” on page A-61.
steering [domain_id]
Displays the routes that data takes to the switch given by [domain_id]. If you omit 
[domain_id], the system displays routes for all switches in the fabric.
support
Executes a series of commands that display a complete description of the switch, 
its configuration, and operation. The display can be captured from the screen and 
used for diagnosing problems. This keyword is intended for use at the request of 
your authorized maintenance provider. The commands that are executed include 
the following:

Date
Alias List
Config List
Date
History
Ps
Show (About, Alarm, Backtrace, Chassis, Config Port, Config Switch, Config 
Threshold, Dev, Dev Settings, Domains, Donor, Fabric, Log, Log Settings, 
Lsdb, Mem, Ns, Perf, Port, Setup Mfg, Setup Snmp, Setup System, 
Steering, Switch, Topology, Users)
Uptime
User Accounts
Whoami
Zoneset (Active, List)
Zoning (History, Limits, List)

TxOfflineSeq Total number of Offline Sequences issued by this port. 

TxWait Time waiting to transmit when blocked with no credit. 
Measured in FC Word times.

Table A-13. Show Port Parameters (Continued)

Entry Description
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switch
Displays switch operational information.
topology
Displays all connected devices.
users
Displays a list of logged-in users. This is equivalent to the User List command.
version
Displays an introductory set of information about operational attributes of the 
switch. This keyword is equivalent to the About keyword.

Examples The following is an example of the Show Chassis command:
SANbox2 #> show chassis

    Chassis Information

  -------------------

  BoardTemp (1) - Degrees Celsius   32

  BoardTemp (2) - Degrees Celsius   36

  FanStatus (1)                     Good

  FanStatus (2)                     Good

  PowerSupplyStatus (1)             Good

  PowerSupplyStatus (2)             Good

The following is an example of the Show Domains command:
SANbox2 #> show domains

  Principal switch is (local): 10:00:00:c0:dd:00:90:6b

  Domain ID List:

        Domain 22 (0x16)        WWN = 10:00:00:c0:dd:00:90:6b

The following is an example of the Show Fabric command:
SANbox2 #> show fabric

Switch     ID     WWN                       Eth0IPAddress

------     --     ---                       -------------

1 (0x1)    fffc01 10:00:00:c0:dd:00:bd:ec   10.20.68.107

4 (0x4)    fffc04 10:00:00:c0:dd:00:80:21   10.20.68.14



A – Command Line Interface
Show Command

A-50 59022-05 B

Q

The following is an example of the Show NS (local domain) command:
SANbox2 #> show ns

Seq Domain     Port    Port

No  ID         ID      Type  COS  PortWWN                   NodeWWN

--- ------     ------  ----  ---  -------                   -------

1   99 (0x63)  630425  NL    3    21:00:00:20:37:d9:4b:2a   20:00:00:20:37:d9:4b:2a

2   99 (0x63)  6304e8  NL    3    21:00:00:20:37:d9:4b:2f   20:00:00:20:37:d9:4b:2f

3   99 (0x63)  6304ef  NL    3    21:00:00:20:37:d9:4f:46   20:00:00:20:37:d9:4f:46

The following is an example of the Show NS Domain_ID command:
  SANbox2-32 #> show ns 102

  Seq Domain    Port   Port

  No  ID        ID     Type COS PortWWN                 NodeWWN

  --- ------    ------ ---- --- -------                 -------

  1   102 (0x66) 6606dc NL   3   21:00:00:20:37:19:1f:7c 20:00:00:20:37:19:1f:7c

  2   102 (0x66) 6606e0 NL   3   21:00:00:20:37:19:1d:c8 20:00:00:20:37:19:1d:c8

  3   102 (0x66) 6606e1 NL   3   21:00:00:20:37:19:1d:33 20:00:00:20:37:19:1d:33

  4   102 (0x66) 6606e2 NL   3   21:00:00:20:37:19:1f:95 20:00:00:20:37:19:1f:95

  5   102 (0x66) 6606e4 NL   3   21:00:00:20:37:19:1f:a5 20:00:00:20:37:19:1f:a5

  6   102 (0x66) 6606e8 NL   3   21:00:00:20:37:19:1d:9b 20:00:00:20:37:19:1d:9b

  7   102 (0x66) 6606ef NL   3   21:00:00:20:37:19:1f:90 20:00:00:20:37:19:1f:90

The following is an example of the Show Interface command:
SANbox2 #> show interface

eth0      Link encap:Ethernet  HWaddr 00:C0:DD:00:BD:ED

          inet addr:10.20.68.107  Bcast:10.20.68.255  Mask:255.255.255.0

          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

          RX packets:4712 errors:0 dropped:0 overruns:0 frame:0

          TX packets:3000 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:100

          RX bytes:415313 (405.5 Kb)  TX bytes:716751 (699.9 Kb)

          Interrupt:11 Base address:0xfcc0

lo        Link encap:Local Loopback

          inet addr:127.0.0.1  Mask:255.0.0.0

          UP LOOPBACK RUNNING  MTU:16436  Metric:1

          RX packets:304 errors:0 dropped:0 overruns:0 frame:0

          TX packets:304 errors:0 dropped:0 overruns:0 carrier:0

          collisions:0 txqueuelen:0

          RX bytes:20116 (19.6 Kb)  TX bytes:20116 (19.6 Kb)
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The following is an example of the Show Port command:
SANbox2 #> show port 1

Port Number: 1

  ------------

  AdminState       Online              PortID           640100

  AsicNumber       0                   PortWWN

  AsicPort         1                   RunningType      Donor

  ConfigType       Donor               SFPPartNumber    PL-XPL-00-S23-00

  DiagStatus       Passed              SFPRevision

  EpConnState      None                SFPType          100-M5-SN-I

  EpIsoReason      NotApplicable       SFPVendor        PICOLIGHT

  LinkSpeed        2Gb/s               SFPVendorID      00850400

  LinkState        Active              SymbolicName     Port1

  LoginStatus      LoggedIn            SyncStatus       SyncLost

  MaxCredit        0                   XmitterEnabled   False

  OperationalState Online

  ALInit          0         FlowErrors      0         PrimSeqErrors   0

  ALInitError     0         FReject         0         RxLinkResets    0

  Class2FramesIn  0         InvalidCRC      0         RxOfflineSeq    0

  Class2FramesOut 0         InvalidDestAddr 0         TotalErrors     0

  Class2WordsIn   0         LIP_AL_PD_AL_PS 0         TotalLIPsRecvd  0

  Class2WordsOut  0         LIP_F7_AL_PS    0         TotalLinkResets 0

  Class3FramesIn  0         LIP_F7_F7       0         TotalOfflineSeq 0

  Class3FramesOut 0         LIP_F8_AL_PS    0         TotalRxFrames   0

  Class3Toss      0         LIP_F8_F7       0         TotalRxWords    0

  Class3WordsIn   0         LinkFailures    0         TotalTxFrames   0

  Class3WordsOut  0         Login           0         TotalTxWords    0

  DecodeErrors    0         Logout          0         TxLinkResets    0

  EpConnects      0         LoopTimeouts    0         TxOfflineSeq    0

  FBusy           0         LossOfSync      0         TxWaits         0
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The following is an example of the Show Switch command:
  SANbox2 #> show switch

  Switch Information

  ------------------

  SymbolicName                      SANbox2-203

  SwitchWWN                         10:00:00:c0:dd:00:b8:b5

  SwitchType                        SANbox2-16

  PromVersion                       V0.1-5-18  (day month date time year)

  CreditPool                        0

  DomainID                          3

  FirstPortAddress                  640000

  FlashSize - MBytes                128

  LogLevel                          Info

  MaxPorts                          16

  NumberOfResets                    127

  ReasonForLastReset                NormalReset

  SWImageVersion (1) - build date   V1.5-6-16  (day month date time year)

  SWImageVersion (2) - build date   V1.5-6-18  (day month date time year)

  ActiveConfiguration               default

  ActiveSWImage                     2

  AdminState                        Online

  AdminModeActive                   False

  BeaconOnStatus                    False

  OperationalState                  Online

  PrincipalSwitchRole               False

  BoardTemp (1) - Degrees Celsius   32

  BoardTemp (2) - Degrees Celsius   36

  SwitchDiagnosticsStatus           Passed

  SwitchTemperatureStatus           Normal

The following is an example of the Show Topology command:
SANbox2 #> show topology

Unique ID Key

-------------

A = ALPA,  D = Domain ID,  P = Port ID

Port   Local Local                    Remote  Remote                    Unique

Number Type  PortWWN                  Type    NodeWWN                   ID

------ ----- -------                  ------  -------                   ------

5      F     20:05:00:c0:dd:00:bd:ec   N      20:00:00:00:c9:22:1e:93   010500 P

10     E     20:0a:00:c0:dd:00:bd:ec   E      10:00:00:c0:dd:00:80:21   4(0x4) D 
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The following is an example of the Show Topology command for port 4:
SANbox2  #> show topology 4

  Local Link Information

  ----------------------

  PortNumber 4

  PortID     010400

  PortWWN    20:04:00:c0:dd:00:90:f3

  PortType   F

  Remote Link Information

  -----------------------

  Device 0

    PortID      010400

    PortWWN     21:00:00:e0:8b:07:a8:bc

    NodeWWN     20:00:00:e0:8b:07:a8:bc

    PortType    N

    Description (NULL)

    IPAddress   0.0.0.0

The following is an example of the Show Version command:
SANbox2 #> show version

SystemDescription  QLogic SANbox2 FC Switch

Eth0NetworkAddress 10.0.0.1 (use 'set setup system' to update)

MACAddress         12:34:56:78:ab:cd

WorldWideName      10:00:00:c0:dd:00:90:a4

SymbolicName       SANbox2

SWImageVersion     V1.5.1-1-12

SWImageBuiltDate   day month date time year

DiagnosticsStatus  Passed

SecurityEnabled    False
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Show Config Command
Displays switch, port, alarm threshold, and zoning attributes for the current 
configuration.

Authority User
Syntax show config

port [port_number]
switch
threshold
zoning

Keywords port [port_number]
Displays configuration parameters for the port number given by [port_number]. 
Ports are numbered beginning with 0. If [port_number] is omitted, all ports are 
specified.
switch
Displays configuration parameters for the switch.
threshold
Displays alarm threshold parameters for the switch.
zoning
Displays zoning configuration parameters for the switch.

Examples The following is an example of the Show Config Port command:
SANbox2 #> show config port 3

  Configuration Name: default

  -------------------

  Port Number: 3

  ------------

  AdminState           Online

  LinkSpeed            Auto

  PortType             GL

  ISLSecurity          Any

  SymbolicName         Port3

  ALFairness           False

  DeviceScanEnabled    True

  ForceOfflineRSCN     False

  ARB_FF               False

  InteropCredit        0

  ExtCredit            0

  FANEnable            False

  LCFEnable            False

  MFSEnable            False

  MFS_TOV              640

  MSEnable             False
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  NoClose              False

  IOStreamGuard        False

  VIEnable             False

  CheckAlps            False

The following is an example of the Show Config Switch command:
SANbox2 #> show config switch

  Configuration Name: default

  -------------------

  Switch Configuration Information

  --------------------------------

  AdminState            Online

  BroadcastEnabled      True

  InbandEnabled         True

  DomainID              100 (0x64)

  DomainIDLock          False

  SymbolicName          SANbox2 N_11.107

  R_T_TOV               100

  R_A_TOV               10000

  E_D_TOV               2000

  FS_TOV                5000

  DS_TOV                5000

  PrincipalPriority     254

  ConfigDescription     QLogic SANbox2 FC Switch

  ConfigLastSavedBy     guest@IB-session10

  ConfigLastSavedOn     day month date time year

The following is an example of the Show Config Threshold command:
  SANbox2 #> show config threshold

  Configuration Name: default

  ------------

  

  Threshold Configuration Information

  -----------------------------------

  ThresholdMonitoringEnabled    True

  CRCErrorsMonitoringEnabled    True

  RisingTrigger                 25

  FallingTrigger                1

  SampleWindow                  10

  DecodeErrorsMonitoringEnabled True

  RisingTrigger                 25
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  FallingTrigger                0

  SampleWindow                  10

  ISLMonitoringEnabled          True

  RisingTrigger                 2

  FallingTrigger                0

  SampleWindow                  10

  LoginMonitoringEnabled        True

  RisingTrigger                 5

  FallingTrigger                1

  SampleWindow                  10

  LogoutMonitoringEnabled       True

  RisingTrigger                 5

  FallingTrigger                1

  SampleWindow                  10

  LOSMonitoringEnabled          True

  RisingTrigger                 100

  FallingTrigger                5

  SampleWindow                  10

The following is an example of the Show Config Zoning command:
SANbox2 #> show config zoning

 Configuration Name: default

  -------------------

  Zoning Configuration Information

  --------------------------------

  AutoSave              True

  Default               All
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Show Log Command
Displays the contents of the log or the parameters used to create entries in the 
log. The log contains a maximum of 200 entries. When the log reaches its entry 
capacity, subsequent entries overwrite the existing entries, beginning with the 
oldest.

Authority User
Syntax show log

component
level
options
port
settings

Keywords component
Displays the components currently being monitored for events.
level
Displays the event severity level needed to create an entry in the log. If the 
severity level occurs on a port or on a component which is not defined, no entry is 
made in the log.
options
Displays the options used to set the component and log level attributes.
port
Displays the ports being monitored for events. If an event occurs which is of the 
defined level and on a defined component, but not on a defined port, no entry is 
made in the log.
settings
Displays the current settings for component, level and port. This command is 
equivalent to executing the following commands separately: Show Log 
Component, Show Log Level, and Show Log Port.

Examples The following is an example of the Show Log Component command:
SANbox2 #> show log component

  Current settings for log

  ------------------------

  component  Eport

The following is an example of the Show Log Level command:
SANbox2 #> show log level

  Current settings for log

  ------------------------

  level      Info
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The following is an example of the Show Log Options command:
SANbox2 #> show log options

  Allowed options for log

  -----------------------

  component All,None,NameServer,MgmtServer,Zoning,Switch,
             Chassis,Blade,Port,Eport,Snmp,Other

  level      Critical,Warn,Info,None

The following is an example of the Show Log command:
[327][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Eport

 State = E_A0_GET_DOMAIN_ID]

   [328][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][FSPF

 PortUp state=0]

   [329][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

ing init hello]

   [330][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Proc

essing EFP, oxid= 0x8]

   [331][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Epor

t State = E_A2_IDLE]

   [332][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][EFP,

 WWN= 0x100000c0dd00b845, len= 0x30]

   [333][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

ing LSU oxid= 0xc: type= 1]

   [334][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Send

 Zone Merge Request]

   [335][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][LSDB

 Xchg timer set]

   [336][day month date time year][I][Eport:0xdd00b8b6.304.4 Port: 0/8][Sett

ing attribute Oper.UserPort.0.8.EpConnState Connected]
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Show Perf Command
Displays port performance in frames/second and bytes/second. If you omit the 
keyword, the command displays data transmitted (out), data received (in), and 
total data transmitted and received in frames/second and bytes per second.

Authority User
Syntax show perf

byte
inbyte
outbyte
frame
inframe
outframe
errors

Keywords [none]
Displays instantaneous performance data in bytes and frames for all ports.
byte
Displays continuous performance data in total bytes/second transmitted and 
received for all ports. Type “q” and press the Enter key to stop the display.
inbyte
Displays continuous performance data in bytes/second received for all ports. Type 
“q” and press the Enter key to stop the display.
outbyte
Displays continuous performance data in bytes/second transmitted for all ports. 
Type “q” and press the Enter key to stop the display.
frame
Displays continuous performance data in total frames/second transmitted and 
received for all ports. Type “q” and press the Enter key to stop the display.
inframe
Displays continuous performance data in frames/second received for all ports. 
Type “q” and press the Enter key to stop the display.
outframe
Displays continuous performance data in frames/second transmitted for all ports. 
Type “q” and press the Enter key to stop the display.
errors
Displays continuous error counts for all ports. Type “q” and press the Enter key to 
stop the display.
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Examples The following is an example of the Show Perf command:
SANbox2 #> show perf

Port   Bytes/s    Bytes/s    Bytes/s    Frames/s   Frames/s   Frames/s

  Number   (in)       (out)    (total)      (in)       (out)    (total)

  ------ -------    -------    -------    --------   --------   --------

  0      0          0          0          0          0          0

  1      0          0          0          0          0          0

  2      0          0          0          0          0          0

  3      0          0          0          0          0          0

  4      0          0          0          0          0          0

  5      0          0          0          0          0          0

  6      0          0          0          0          0          0

  7      0          0          0          0          0          0

  8      7K         136M       136M       245        68K        68K

  9      58K        0          58K        1K         0          1K

  10     0          0          0          0          0          0

  11     0          0          0          0          0          0

  12     0          0          0          0          0          0

  13     0          0          0          0          0          0

  14     0          7K         7K         0          245        245

  15     136M       58K        136M       68K        1K         70K

The following is an example of the Show Perf Byte command:
SANbox2 #> show perf byte

Displaying bytes/sec (total)...  (Press 'q' and the ENTER key to stop display)

  0    1    2    3    4    5    6    7    8    9    10   11   12   13   14   15

  --------------------------------------------------------------------------------

  0    0    0    0    0    0    0    0    137M 58K  0    0    0    0    8K   137M

  0    0    0    0    0    0    0    0    136M 58K  0    0    0    0    8K   136M

  0    0    0    0    0    0    0    0    135M 58K  0    0    0    0    7K   135M

  0    0    0    0    0    0    0    0    137M 58K  0    0    0    0    8K   137M

  0    0    0    0    0    0    0    0    136M 58K  0    0    0    0    7K   136M

  0    0    0    0    0    0    0    0    137M 58K  0    0    0    0    8K   137M

  0    0    0    0    0    0    0    0    136M 58K  0    0    0    0    8K   136M

  0    0    0    0    0    0    0    0    136M 58K  0    0    0    0    7K   136M

q
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Show Setup Command
Displays the current SNMP and system settings.

Authority User

Syntax show setup
mfg
snmp
system

Keywords mfg
Displays manufacturing information about the switch.
snmp
Displays the current SNMP settings.
system
Displays the current system settings.

Examples The following is an example of the Show Setup Mfg command:
SANbox2 #> show setup mfg

    Manufacturing Information

  -------------------------

  BrandName                QLogic

  BuildDate                Unknown

  ChassisPartNumber        Unknown

  ChassisSerialNumber      0

  CPUBoardSerialNumber     000603949

  MACAddress               00:c0:dd:00:90:aa

  PlanarPartNumber         Unknown

  SwitchSymbolicName       SANbox2

  SwitchWWN                10:00:00:c0:dd:00:90:ab

  SystemDescription        QLogic SANbox2 FC Switch

  SystemObjectID           1.3.6.1.4.1.1663.1.1.1.1.11

The following is an example of the Show Setup Snmp command:
SANbox2 #> show setup snmp

  SNMP Information

  ----------------

  Contact               <sysContact undefined>

  Location              N_107 System Test Lab

  Description           QLogic SANbox2 FC Switch

  Trap1Address          10.0.0.254

  Trap1Port             162

  Trap1Severity         warning

  Trap1Version          2

  Trap1Enabled          False
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  Trap2Address          0.0.0.0

  Trap2Port             162

  Trap2Severity         warning

  Trap2Version          2

  Trap2Enabled          False

  Trap3Address          0.0.0.0

  Trap3Port             162

  Trap3Severity         warning

  Trap3Version          2

  Trap3Enabled          False

  Trap4Address          0.0.0.0

  Trap4Port             162

  Trap4Severity         warning

  Trap4Version          2

  Trap4Enabled          False

  Trap5Address          0.0.0.0

  Trap5Port             162

  Trap5Severity         warning

  Trap5Version          2

  Trap5Enabled          False

  ObjectID              1.3.6.1.4.1.1663.1.1.1.1.11

  AuthFailureTrap       True

  ProxyEnabled          True

The following is an example of the Show Setup System command:
SANbox2 #> show setup system

  System Information

  ------------------

  Eth0NetworkDiscovery     Static

  Eth0NetworkAddress       10.20.11.32

  Eth0NetworkMask          255.255.252.0

  Eth0GatewayAddress       10.20.8.254

  AdminTimeout             30

  TempMonitoringWarning    65

  TempMonitoringFailure    70

  TempFailurePortShutdown  False

  SecurityEnabled          False

  LocalLogEnabled          True

  RemoteLogEnabled         False

  RemoteLogHostAddress     10.0.0.254
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Shutdown Command
Terminates all data transfers on the switch at convenient points and closes the 
Telnet session. Always power cycle the switch after entering this command.

Authority Admin
Syntax shutdown
Notes Always use this command to effect an orderly shut down before removing power 

from the switch. Failure to do so could corrupt the flash memory and the switch 
configuration.
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Test Command
Tests ports using internal (SerDes level), external (SFP), and online loopback 
tests. Internal and external tests require that the port be placed in diagnostic 
mode. Refer to the ”Set Command” on page A-24 for information about changing 
the port administrative state. While the test is running, the remaining ports on the 
switch remain fully operational.

Authority Admin
Syntax test

port [port_number] [test_type]
cancel
status

Keywords port [port_number] [test_type]
Tests the port given by [port_number] using the test given by [test_type]. If you 
omit [test_type], Internal is used. [test_type] can have the following values:

internal 
Tests the SerDes. This is the default. The port must be in diagnostics mode 
to perform this test.
external
Tests both the SerDes and SFP. The port must be in diagnostics mode to 
perform this test, and a loopback plug must be installed in the SFP.
online
Tests one online port.

cancel
Cancels the online test in progress.
status
Displays the status of a test in progress, or if there is no test in progress, the 
status of the test that was executed last.

Examples To run an internal (SerDes) or external (SFP) port test, do the following:

1. To start an admin session, enter the following command and press the Enter 
key.

admin start

2. Place the port in Diagnostics mode, enter the following command (x = port 
number) and press the Enter key.

set port x state diagnostics

3. Choose the type of port loopback test to run:
To run an internal loopback test, enter the following:

test x internal
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To run an external loopback test, insert a loopback plug into the SFP 
on the selected port, then enter the following command:

test x external

4. A series of test parameters are displayed on the screen. Press the Enter key 
to accept each default parameter value, or type a new value for each 
parameter and press the Enter key. The TestLength parameter is the 
number of frames sent, the FrameSize (256 byte maximum in some cases) 
parameter is the number of bytes in each frame, and the DataPattern 
parameter is the pattern in the payload.

5. After the test type has been chosen and the command executed, a message 
on the screen will appear detailing the test results.

6. After the test is run, put the port back into online state by entering the 
following command (x = port number) and pressing the Enter key. 

set port x state online

7. To verify port is back online, enter the following command and press the 
Enter key. The contents of the AdminState field should display be “Online”.

show port x

The online loopback (node-to-node) test can test only one port at a time, and that 
port must be online and connected to a remote device. To run the online loopback 
test, do the following:

1. To start an admin session, enter the following command and press the Enter 
key.

admin start

2. To run the online loopback test, enter the following command and press the 
Enter key. 

test port x online
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3. A series of test parameters are displayed on the screen. Press the Enter key 
to accept each default parameter value, or type a new value for each 
parameter and press the Enter key. The TestLength parameter is the 
number of frames sent, the FrameSize (256 byte maximum in some cases) 
parameter is the number of bytes in each frame, and the DataPattern 
parameter is the pattern in the payload. Before running the test, make sure 
that the device attached to the port can handle the test parameters.
SANbox2 (admin) #> test x online

A list of attributes with formatting and current values will 
follow. Enter a new value or simply press the ENTER key to 
accept the default value. If you wish to terminate this 
process before reaching the end of the list press 'q' or 'Q' 
and the ENTER key to do so.

  TestLength    (decimal value, 1-4294967295)   [100    ]

  FrameSize     (decimal value, 36-2148)        [256    ]

  DataPattern   (32-bit hex value or 'Default') [Default]

  StopOnError   (True/False)                    [False  ]

  Do you want to start the online test? (y/n) [n]

4. After all parameter values are defined, type Y and press  Enter to start the 
test.
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Uptime Command
Displays the elapsed time since the switch was last reset and reset method.

Authority User

Syntax uptime
Examples The following is an example of the Uptime command:

SANbox2 #> uptime

  Elapsed up time  : 0 day(s), 2 hour(s), 28 min(s), 44 sec(s)

  Reason last reset: NormalReset



A – Command Line Interface
User Command

A-68 59022-05 B

Q

User Command
Administers or displays user accounts. 

Authority Admin. The List keyword is available with User authority.

Syntax user
accounts
add
delete [account_name]
list

Keywords accounts
Displays all user accounts that exist on the switch.
add
Add a user account to the switch. After this command is executed, the 
administrator will be prompted for the information needed to establish the user 
account. A switch can have a maximum of 15 user accounts. Account names are 
limited to 15 characters; passwords are limited to 31 characters.
delete [account_name]
Deletes the account name given by [account_name] from the switch.
list
Displays the list of users currently logged in and their session numbers. Provides 
the same function as the Show Users command. This keyword is valid for User 
authority and does not require an admin session.

Examples The following is an example of the User Accounts command:
SANbox2 (admin) #> user accounts

  Current list of user accounts

  -----------------------------

  admin        (admin authority = True)

  user1        (admin authority = False)

  user2        (admin authority = False)

  user3        (admin authority = True)
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The following is an example of the User Add command:
SANbox2 (admin) #> user add

      Press 'q' and the ENTER key to abort this command.

  account name (1-15 chars)      : user3

  account password (4-20 chars)  :

  please confirm account password:

  should this account have admin authority? (y/n) [n] : y

  OK to add user account 'user3' with admin authority?

  Please confirm (y/n): [n] y

The following is an example of the User Delete command:
SANbox2 (admin) #> user del user3

  The user account will be deleted.  Please confirm (y/n): [n] y

The following is an example of the User List command:
SANbox2 (admin) #> user list

  Current list of users logged in

  -------------------------------

  snmp@OB-session1, logged in since: Mon Apr 21 09:20:38 2003

  snmp@IB-session2, logged in since: Mon Apr 21 09:20:38 2003

  admin@IB-session3, logged in since: Mon Apr 21 09:20:56 2003

  admin@IB-session4, logged in since: Mon Apr 21 09:20:56 2003

  admin@OB-session5, logged in since: Mon Apr 21 09:33:52 2003

  admin@OB-session10, logged in since: Mon Apr 21 10:11:36 2003 (in admin mode)

  admin@OB-session11, logged in since: Mon Apr 21 11:01:09 2003

  admin@IB-session12, logged in since: Mon Apr 21 11:42:11 2003

  admin@OB-session14, logged in since: Mon Apr 21 13:09:19 2003

  root@OB-session15, logged in since: Mon Apr 21 13:20:03 2003
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Whoami Command
Displays the account name, session number, and switch domain ID for the Telnet 
session.

Authority User
Syntax whoami
Examples The following is an example of the Whoami command:

SANbox2 #> whoami

User name:        admin@session2

Switch name:      SANbox2

Switch domain ID: 1 <0x1>
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Zone Command
Manages zones and zone membership on a switch.

Authority Admin authority and a Zoning Edit session. Refer to the ”Zoning Command” on 
page A-78 for information about starting a Zoning Edit session. The List, 
Members, and Zonesets keywords are available with User authority and do not 
require a Zoning Edit session.

Syntax zone
add [zone] [members]
copy [zone_source] [zone_destination]
create [zone]
delete [zone]
list
members [zone]
remove [zone] [members]
rename [zone_old [zone_new]
type [zone] [zone_type]
zonesets [zone]

Keywords add [zone] [members]
Specifies one or more ports/devices given by [members] to add to the zone 
named [zone]. A zone can have a maximum of 256 members. [members] can 
have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.
Alias name

The application verifies that the [members] format is correct, but does not validate 
that such a port exists.
copy [zone_source] [zone_destination]
Creates a new zone named [zone_destination] and copies the membership into it 
from the zone given by [zone_source].
create [zone]
Creates a zone with the name given by [zone]. An zone name must begin with a 
letter and be no longer than 64 characters. Valid characters are 0-9, A-Z, a-z, _, 
and -. The zoning database supports a maximum of 1000 zones.
delete [zone]
Deletes the specified zone given by [zone] from the zoning database. If the zone 
is a member of the active zone set, the zone will not be removed from the active 
zone set until the active zone set is deactivated.
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list
Displays a list of all zones and the zone sets of which they are members. This 
keyword is valid for User authority and does not require a zoning edit session.
members [zone]
Displays all members of the zone given by [zone]. This keyword is available with 
User authority and does not require a Zoning Edit session.
remove [zone] [members]
Removes the ports/devices given by [members] from the zone given by [zone]. 
[members] can have one of the following formats:

Domain ID and port number pair (Domain ID, Port Number). Domain IDs and 
port numbers are in decimal. Ports are numbered beginning with 0.
6-character hexadecimal device Fibre Channel address (hex)
16-character hexadecimal worldwide port name (WWPN) with the format 
xx:xx:xx:xx:xx:xx:xx:xx.
Alias name

rename [zone_old] [zone_new]
Renames the zone given by [zone_old] to the zone given by [zone_new].
type [zone] [zone_type]
Specifies the zone type given by [zone_type] to be assigned to the zone name 
given by [zone]. If you omit the [zone_type], the system displays the zone type for 
the zone given by [zone]. [zone_type] can be one of the following:

soft
Name server zone
hardACL
Access control list hard zone. This keyword is case sensitive.
hardVPF
Virtual private fabric hard zone. This keyword is case sensitive.

zonesets [zone]
Displays all zone sets of which the zone given by [zone] is a member. This 
keyword is available with User authority and does not require a Zoning Edit 
session.



A – Command Line Interface
Zone Command

59022-05 B A-73

Q

Examples The following is an example of the Zone List command:
SANbox2 #> zone list

 

  Zone        ZoneSet

  -------------------

  wwn_b0241f

              zone_set_1

 

  wwn_23bd31

              zone_set_1

 

  wwn_221416

              zone_set_1

 

  wwn_2215c3

              zone_set_1

 

  wwn_0160ed

              zone_set_1

 

  wwn_c001b0

              zone_set_1

 

  wwn_401248

              zone_set_1

 

  wwn_02402f

              zone_set_1

 

  wwn_22412f

              zone_set_1

The following is an example of the Zone Members command:
SANbox2 #> zone members wwn_b0241f

  Current List of Members for Zone: wwn_b0241f

  ---------------------------------

  50:06:04:82:bf:d2:18:c2

  50:06:04:82:bf:d2:18:d2

  21:00:00:e0:8b:02:41:2f
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The following is an example of the Zone Zonesets command:
SANbox2 #> zone zonesets zone1

  Current List of ZoneSets for Zone: wwn_b0241f

  ----------------------------------

  zone_set_1 
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Zoneset Command
Manages zone sets and zone set membership across the fabric.

Authority Admin authority and a Zoning Edit session. Refer to the ”Zoning Command” on 
page A-78 for information about starting a Zoning Edit session. The Active, List, 
and Zones keywords are available with User authority. You must close the Zoning 
Edit session before using the Activate and Deactivate keywords.

Syntax zoneset
activate [zone_set]
active
add [zone_set] [zone_list]
copy [zone_set_source] [zone_set_destination]
create [zone_set]
deactivate
delete [zone_set]
list
remove [zone_set] [zone_list]
rename [zone_set_old] [zone_set_new]
zones [zone_set]

Keywords activate [zone_set]
Activates the zone set given by [zone_set]. This keyword deactivates the active 
zone set. Close the Zoning Edit session before using this keyword.
active
Displays the name of the active zone set. This keyword is available with User 
authority and does not require a Zoning Edit session.
add [zone_set] [zone_list]
Adds a list of zones and aliases given by [zone_list] to the zone set given by 
[zone_set]. Zone and alias names are delimited by spaces in [zone_list]. This 
keyword requires a Zoning Edit session.
copy [zone_set_source] [zone_set_destination]
Creates a new zone set named [zone_set_destination] and copies into it the 
membership from the zone set given by [zone_set_source]. This keyword requires 
a Zoning Edit session.
create [zone_set]
Creates the zone set with the name given by [zone_set]. A zone set name must 
begin with a letter and be no longer than 64 characters. Valid characters are 0-9, 
A-Z, a-z, _, and -. This keyword requires a Zoning Edit session. The zoning 
database supports a maximum of 256 zone sets.
deactivate
Deactivates the active zone set. Close the Zoning Edit session before using this 
keyword.
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delete [zone_set]
Deletes the zone set given by [zone_set]. If the specified zone set is active, the 
command is suspended until the zone set is deactivated. This keyword requires a 
Zoning Edit session.
list
Displays a list of all zone sets. This keyword is available with User authority and 
does not require a Zoning Edit session.
remove [zone_set] [zone_list]
Removes a list of zones given by [zone_list] from the zone set given by 
[zone_set]. Zone names are delimited by spaces in [zone_list]. If [zone_set] is the 
active zone set, the zone will not be removed until the zone set has been 
deactivated. This keyword requires a Zoning Edit session.
rename [zone_set_old] [zone_set_new]
Renames the zone set given by [zone_set_old] to the name given by 
[zone_set_new]. You can rename the active zone set. This keyword requires a 
Zoning Edit session.
zones [zone_set]
Displays all zones that are members of the zone set given by [zone_set]. This 
keyword is available with User authority and does not need a Zoning Edit session.

Notes A zone set must be active for its definitions to be applied to the fabric.
Only one zone set can be active at one time.
A zone can be a member of more than one zone set.

Examples The following is an example of the Zoneset Active command:
SANbox2 #> zoneset active

  Active ZoneSet Information

  --------------------------

  ActiveZoneSet    Beta

  LastActivatedBy  Remote

  LastActivatedOn  Mon Apr 21 09:20:56 2003

The following is an example of the Zoneset List command:
SANbox2 #> zoneset list

  Current List of ZoneSets

  ------------------------

  alpha

  beta
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The following is an example of the Zoneset Zones command:
SANbox2 #> zoneset zones ssss

  Current List of Zones for ZoneSet: ssss

  ----------------------------------

  zone1

  zone2

  zone3
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Zoning Command
Opens a Zoning Edit session in which to create and manage zone sets and zones. 
Refer to the ”Zone Command” on page A-71 and the ”Zoneset Command” on 
page A-75.

Authority Admin. The List keyword is available with User authority.
Syntax zoning

active
cancel
clear
edit
history
limits
list
restore
save

Keywords active
Displays membership information for the active zone set including member zones 
and zone members.
cancel
Closes the current Zoning Edit session. Any unsaved changes are lost.
clear
Clears all inactive zone sets from the volatile edit copy of the zoning database. 
This keyword does not affect the non-volatile zoning database. However, if you 
enter the Zoning Clear command followed by the Zoning Save command, the 
non-volatile zoning database will be cleared from the switch.

edit
Opens a Zoning Edit session.
history
Displays a history of zoning modifications including the following:

Time of the most recent zone set activation or deactivation and the user who 
performed it
Time of the most recent modifications to the zoning database and the user 
who made them.
Checksum for the zoning database

Note: The preferred method for clearing the zoning database from the switch 
is the Reset Zoning command.
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limits
Displays the maximum limits imposed on the zoning database for the number of 
zone sets, zones, aliases, members per zone, members per alias, and total 
members.
list
Lists all fabric zoning definitions. This keyword is available with User authority.
restore
Reverts the changes to the zoning database that have been made during the 
current Zoning Edit session since the last Zoning Save command was entered.
save
Saves changes made during the current Zoning Edit session. The system will 
inform you that the zone set must be activated to implement any changes. This 
does not apply if you entered the Zoning Clear command during the Zoning Edit 
session.

Examples The following is an example of the Zoning Edit command:
SANbox2 #> admin start

SANbox2  (admin) #> zoning edit

SANbox2  (admin-zoning) #>

.

.

SANbox2  (admin-zoning) #> zoning cancel

  Zoning edit mode will be canceled.  Please confirm (y/n): [n]   y

SANbox2  (admin) #> admin end

The following is an example of the Zoning List command:
SANbox2 #> zoning list

 

  Active ZoneSet Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31
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                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:c3 

 

  Configured Zoning Information

 

  ZoneSet     Zone      ZoneMember

  --------------------------------

  wwn

              wwn_b0241f

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        21:00:00:e0:8b:02:41:2f

 

              wwn_23bd31

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:23:bd:31

 

              wwn_221416

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:14:16

 

              wwn_2215c3

                        50:06:04:82:bf:d2:18:c2

                        50:06:04:82:bf:d2:18:d2

                        10:00:00:00:c9:22:15:
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Appendix B
Graphing Port Performance

SANsurfer Fabric View is an optional application that displays port performance 
using graphs. SANsurfer Fabric View plots data communication rates and total 
errors for selected ports as shown in Figure B-1. When graphing data 
communication rates, you can choose either frames/second or KB/second.

Figure B-1.  Fabric View Graphs

This appendix describes how to do the following:

Start SANsurfer Fabric View
Display graphs
Arrange graphs in the display
Customize graphs

B.1
Starting SANsurfer Fabric View

To start SANsurfer Fabric View from within SANbox Manager, open the topology 
display and select Start Fabric View from the Switch menu.
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B.2
Displaying Graphs

To display graphs, do the following:

1. Open the Fabric menu and select Add Fabric or click the Add button. Enter 
a fabric name and an IP address in the Add a New Fabric window. Include a 
login name and a password if required.

2. Set the graphing options and polling frequency. By default, SANsurfer Fabric 
View plots total bytes transmitted and received at a polling frequency of once 
per second. Refer to ”Customizing Graphs” on page B-3 for information 
about changing what is plotted and how it is plotted.

3. Select a switch icon in the Fabric Tree to display a graph for each logged-in 
port on that switch; or display a graph for a single port by clicking on the 
switch entry handle and selecting one or more ports.

4. You can move graphs around individually by clicking and dragging, or you 
can arrange them as a group. Refer to ”Arranging Graphs in the Display” on 
page B-2 for more information. To remove a graph, click the graph Close 
button. To remove all graphs, open the View menu and select Close All 
Graphs.

SANsurfer Fabric View can access only one fabric at a time. To access another 
fabric, you must first remove the current fabric. To remove a fabric, open the 
Fabric menu and select Remove Fabric or click the Remove button.

B.2.1
Arranging Graphs in the Display

To arrange and size graphs in the display, open the View menu and select Tile 
Graphs Vertically, Tile Graphs Horizontally, or Cascade Graph Panels.

Tiling vertically sizes and arranges the graphs in the longest columns 
possible.
Tiling horizontally sizes and arranges the graphs in the longest rows 
possible.
Cascading overlaps the graphs so that all graphs are at least partially 
visible.
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B.2.2
Customizing Graphs

You can customize the graph polling frequency, what is plotted in the graphs, and 
the graph color scheme. To set the polling frequency for all graphs, open the 
Graph menu and select Set Polling Frequency.... Enter an interval in seconds 
(0–60) in the dialog box and choose the OK button.

To choose what is to be plotted, open the Graph menu and select Options.... This 
opens the Modify Graph Display shown in Figure B-2.

Figure B-2.  Modify Graph Display

To modify the graph display, do the following:

1. Choose the units for the graph:
Select the Show Bytes Data on Graph check box to plot data in 
KBytes/second
Select the Show Frames Data on Graph check box to plot data in 
frames/second.
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2. Choose what data type to plot. For example, if you selected Show Frames 
Data on Graph in step 1, you can plot one or all of the following:

Total frames transmitted and received (Total Frames)
Total frames transmitted (Total Tx Frames)
Total frames received (Total Rx Frames)

In addition to these, you can also plot total errors by selecting the Total 
Errors check box.

3. Display or hide the unit grid. Select the Display Grid on Graph check box to 
display the unit grid.

4. Choose the color scheme for the graph. You can select the color for each 
data type, the unit grid, and the background by clicking the corresponding 
color field or button. In each case, you can choose a color using the 
swatches, Red-Green-Blue (RGB), or Hue-Saturation-Brightness (HSB) 
method.

Swatches – Click the Swatches tab. Select a swatch from the palette 
and choose the OK button.
HSB – Click the HSB tab. Select a color using any of the following 
methods and choose the OK button:

Click in the color palette.
Select the H, S, or B button and use the slide to vary the selected 
value.
Enter values in the H, S, or B input fields.

RGB – Click the RGB tab. Select a color by moving the slides to adjust 
the values for red, blue, and green; or enter values in the input fields. 
Choose the OK button.
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Appendix C
Messages

This appendix lists the SANbox Manager messages by task, dialog, or display. To 
find a message and what to do about it, consider what task you are performing, 
and refer to the corresponding subsection.

”Fabrics File—Open, Save” on page C-1
”Add a Fabric” on page C-2
”Network Properties Dialog” on page C-3
”Switch Properties Dialog” on page C-4
”Port Properties Dialog” on page C-8
”Faceplate Display” on page C-10
”Load Firmware Dialog” on page C-13
”Firmware Fallback Dialog” on page C-13
”Port Loopback Test Dialog” on page C-15
”Extended Credits Dialog” on page C-17
”Zoning Dialog” on page C-17
”Restore Configuration Dialog” on page C-20
”Save Fabric View” on page C-20
”Trap Configuration Dialog” on page C-21

C.1
Fabrics File—Open, Save

Table C-1. Fabrics File – Open, Save Messages 

Message User Action

Failed opening fabrics list file filename. Verify that the specified file exists on a file 
system that is reachable, and that the user 
has permissions to read the file.

Failed saving fabrics list file filename. Verify that the specified file system is 
reachable, and that the user has 
permissions to write to the file system, to 
the directory, and to the file.
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C.2
Add a Fabric

Table C-2. Add a Fabric Messages 

Message User Action

Fabric fabricname already exists!
Or
Fabric name already in use.

Specify a name for the fabric that is not 
already assigned to an existing fabric.

Invalid IP Address Verify that the IP address specified is 
syntactically correctly.

The entry switch is of a type that is not 
supported.

The switch hardware or firmware version 
of the switch at the specified IP address is 
not supported. Choose the IP address of a 
different switch, or update the firmware 
using Telnet or the appropriate version of 
the application.

The maximum number of management 
sessions on the entry switch has been 
exceeded.

The application cannot establish a session 
with the fabric because too many sessions 
are already open. Close any other 
application or Telnet sessions to the fabric 
and try again.

Unable to login to switch. Reason: … Verify that the user name and password 
entered in the dialog box are valid login 
information for an account on the switch 
specified by the IP address field.

Unknown host hostname. Verify that the host name specified for the 
IP address is a valid hostname for a switch 
in the fabric, and that the switch is 
reachable from the user’s workstation.

Verify correct user name and password 
and retry.

Either the user name or password is 
incorrect. Enter the correct values and 
retry.
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C.3
Network Properties Dialog

Table C-3. Network Properties Dialog Messages

Message User Action

Attempt to change snmp community 
strings failed.
Or
Attempt to change syslog configuration 
failed.

Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Unable to apply invalid syslog host 
address

Verify that either a syntactically correct IP 
address was specified for the syslog host, 
or that a host name was specified for a 
valid syslog host that is reachable from the 
user’s workstation.
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C.4
Switch Properties Dialog

Table C-4. Switch Properties Dialog Messages 

Message User Action

Attempt to change chassis name failed
Or
Attempt to set ISL security failed.
Or
Attempt to set in-band management failed.
Or
Attempt to change domain ID lock failed.
Or
Attempt to change SNMP configuration 
failed
Or
Attempt to change IP configuration failed 
Or
Attempt to change chassis configuration 
failed
Or
Attempt to change timeout values failed
Or
Attempt to change broadcast support 
failed

Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Changing the domain ID may cause the 
SANbox 1Gb switches to isolate from the 
fabric. Do you still want to make this 
change?

Verify that all information is valid and retry 
the configuration change. Consult the 
documentation for valid configurations.
Valid domain IDs must be in the range 1 to 
239, and must be unique within a fabric. If 
the fabric contains SANbox with E_Port 
switches, then all domain IDs must be in 
the same range of sixteen values: 1…16, 
17…32, and so on.

Disabling in-band management will make 
the switch unreachable. Do you wish to 
continue with this change?

If this feature is disabled, this switch will no 
longer be manageable through this 
session to the fabric.
If this is acceptable, then continue; 
otherwise cancel the operation.
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Duplicate domain ID specified. Verify that all information is valid and retry 
the configuration change. Consult the 
documentation for valid configurations.
Valid domain IDs must be in the range 1 to 
239, and must be unique within a fabric. If 
the fabric contains SANbox with E_Port 
switches, then all domain IDs must be in 
the same range of sixteen values: 1…16, 
17…32, and so on.

If you set this inband switch offline you will 
need an ethernet connection to the switch 
to put it back online. Do you want to set 
switch offline?
Or
If you set this inband switch in diagnostics 
mode you will need an ethernet 
connection to the switch to put it back 
online. Do you want to set switch in 
diagnostics mode?

These changes will prevent the application 
from communicating with the switch in the 
fabric. Before applying the changes, verify 
that the switch is reachable through its 
own Ethernet port, then add a new fabric 
(Fabric>Add Fabric) at the switch’s own IP 
address.

IP configuration changes will not take 
effect until switch is reset.

The new IP configuration has been set on 
the switch, but the user has decided not to 
reset the switch at this time. Arrange a 
time when it is acceptable to disrupt 
communications between the hosts and 
storage systems, then reset the switch to 
make the changes effective.

Modification of IP configuration will require 
a switch reset to take effect. The reset may 
disrupt traffic. Do you wish to continue?

This configuration information will not 
become effective unless the switch is 
reset. Resetting a switch in the fabric will 
cause the servers and storage systems 
attached to the fabric to lose 
communications until the switch reset is 
complete and the fabric has re-initialized. 
If this is acceptable, then continue; 
otherwise cancel the reset operation.

Table C-4. Switch Properties Dialog Messages (Continued)

Message User Action
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Out of range domain ID specified. Verify that all information is valid and retry 
the configuration change. Consult the 
documentation for valid configurations.
Valid domain IDs must be in the range 1 to 
239, and must be unique within a fabric. If 
the fabric contains SANbox with E_Port 
switches, then all domain IDs must be in 
the same range of sixteen values: 1…16, 
17…32, and so on.

Received error in attempting to edit switch 
configuration.
Or
Received error in attempting to save 
switch configuration.
Or
Received error in attempting to activate 
switch configuration.

Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Reset will complete shortly. There will be a 
brief loss of connectivity with switch.

Wait for the switch to become reachable 
again. This may take up to one minute.

The new domain ID specified is invalid.
Unable to apply invalid chassis/fabric ID 
values

Verify that all information is valid and retry 
the configuration change. Consult the 
documentation for valid configurations.
Valid domain IDs must be in the range 1 to 
239, and must be unique within a fabric. If 
the fabric contains SANbox with E_Port 
switches, then all domain IDs must be in 
the same range of sixteen values: 1…16, 
17…32, and so on.

Table C-4. Switch Properties Dialog Messages (Continued)

Message User Action
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Unable to apply changes. Failed to obtain 
admin privileges.

Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
telnet login, or any application.

Unable to apply invalid timeout values
Or
Unable to apply invalid IP address
Or
Unable to apply invalid trap address
Or
Unable to apply invalid subnet mask
Or
Unable to apply invalid gateway address
Or
Unable to apply invalid ARP timeout value

Verify that all information is valid and retry 
the configuration change. Consult the 
documentation for valid configurations.
Valid domain IDs must be in the range 1 to 
239, and must be unique within a fabric. If 
the fabric contains SANbox with E_Port 
switches, then all domain IDs must be in 
the same range of sixteen values: 1…16, 
17…32, and so on.

Table C-4. Switch Properties Dialog Messages (Continued)

Message User Action
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C.5
Port Properties Dialog

Table C-5. Port Properties Dialog Messages 

Message User Action

Invalid value entered for BB credits.
Or
Failed to set I/O stream guard change.
Or
Failed to set new BB credits.
Or
Request to save and activate config failed.
Or
Received error in attempting to edit switch 
configuration.
Or
Received error in attempting to save 
switch configuration.
Or
Received error in attempting to activate 
switch configuration.

Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Received error in attempting to release 
admin privileges

The application did not receive a required 
response from the switch. This may be 
caused by a momentary or extended loss 
of communications with the fabric.
First refresh the information in the display 
to determine whether the changes took 
effect. If not, retry the changes.
If the error persists, determine whether 
communications with the switch have 
stopped, and resolve any network 
problems. When communication with the 
fabric has resumed, return to the 
application to view the properties for the 
port and verify whether the changes took 
effect. If not, then retry the changes.

Request to save and activate config failed. Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.
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Unable to apply changes. Failed to obtain 
admin privileges.

Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
Telnet login, or any other application, and 
then retry the operation.

Unable to confirm that port changes were 
successful.

The application did not receive a required 
response from the switch. This may be 
caused by a momentary or extended loss 
of communications with the fabric.
First refresh the information in the display 
to determine whether the changes took 
effect. If not, retry the changes.
If the error persists, determine whether 
communications with the switch have 
stopped, and resolve any network 
problems. When communication with the 
fabric has resumed, return to the 
application to view the properties for the 
port and verify whether the changes took 
effect. If not, then retry the changes.

Unable to successfully configure port as a 
TL target.
Or
Unable to successfully apply port speed 
change.
Or
Unable to successfully apply port state 
change.
Or
Unable to successfully apply port mode 
change.

Verify that the data is valid, that the user 
has permissions to modify the 
configuration on the switch, that the switch 
is reachable in the fabric, and that the 
fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Table C-5. Port Properties Dialog Messages (Continued)

Message User Action
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C.6
Faceplate Display

Table C-6. Faceplate Display Messages 

Message User Action

Failed to clear the trap log. Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Necessary information is missing for this 
switch. Firmware version on this switch is 
unsupported.

The user has attempted an action which 
cannot be completed because it requires 
information from the switch which the 
switch does not support. Update the 
firmware on the switch to the latest 
version.

Necessary information is missing for this 
switch. Retry later.

The user has attempted an action which 
cannot be completed until specific 
information has been retrieved from the 
switch. This condition usually corrects 
within several seconds.
If the condition doesn’t correct itself, verify 
that the switch is reachable in the fabric, 
and that the fabric is reachable from the 
user’s workstation. When the switch is 
reachable again, then wait for the 
application to retrieve complete 
information from the switch (this may take 
up to one minute), or refresh the display.

One of the selected ports is currently in 
use as a donor port to allow for extended 
credits on another port. Modifications to 
donor ports are not permitted.

Unselect the donor ports, and then retry 
the operation.

Port reset failed
Or
Request to reset to factory defaults has 
failed.
Or
Request for switch reset failed

Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
change.
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Request for switch reset failed because 
admin access was not available.

Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
telnet login, or any application, and then 
retry the operation.

Reset will complete shortly. There will be a 
brief loss of connectivity with switch.

Wait for the switch to become reachable 
again. This may take up to one minute.

Resetting the switch will disrupt traffic. Do 
you wish to continue?
Or
Deactivating the active zone set will 
disrupt traffic. Do you wish to continue?

The requested action will cause the 
servers and storage systems attached to 
the fabric to lose communications until the 
switch reset is complete and the fabric has 
re-initialized. If this is acceptable, then 
continue; otherwise cancel the operation.

Resetting to factory defaults will disrupt 
traffic and cause current switch 
configuration to be lost.

This action is disruptive to the fabric. Verify 
that this is the action that you wish to take.

Showing Last Known State The switch state displayed by the 
application cannot be updated because 
the switch has become unreachable. 
Verify that the switch is reachable in the 
fabric, and that the fabric is reachable from 
the user’s workstation.

The file currently exists. The selected switch archive file already 
exists. If it is acceptable to overwrite the 
file, then continue. Otherwise, return and 
select a different archive file.

The online port loopback test can only be 
performed on a single port at a time. There 
are multiple ports selected. Continue with 
loopback test on first selected port

Select only a single port, and then retry the 
operation.

Table C-6. Faceplate Display Messages (Continued)

Message User Action
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The zoning information you are about to 
edit is incomplete. If you apply changes 
you will possibly lose zoning information.

The application has not been able to 
completely read the current zoning 
database from the switch. If the user edits 
the incomplete database information and 
applies the changes, then any information 
which has not been read from the switch 
will be lost.
If this is acceptable, then continue. 
Otherwise, verify that the switch is 
reachable in the fabric, and that the fabric 
is reachable from the user’s workstation 
then refresh the display and verify that the 
zoning database has been completely 
read, then retry the operation.

Unable to perform request. Switch is 
currently unreachable.

Verify that the switch is reachable in the 
fabric, and that the fabric is reachable from 
the user’s workstation, then retry the 
operation.

You can not perform this operation 
in-band.

Isolate the switch from the fabric, connect 
directly to the Ethernet port, and retry the 
operation.

Zone set deactivation failed. Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

Table C-6. Faceplate Display Messages (Continued)

Message User Action
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C.7
Firmware Fallback Dialog

C.8
Load Firmware Dialog

Table C-7. Firmware Fallback Dialog Messages 

Message User Action

Attempt to revert to fallback firmware failed The switch was unable to fall back to the 
previous firmware. Correct the problem 
specified and retry the operation.

Request to get admin privileges failed. Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
Telnet login, or any application, and then 
retry the operation.

Switch must be reset to activate fallback 
firmware. A reset will disrupt traffic. Reset 
now?

The firmware will not begin executing the 
fallback version until the next time the 
switch is reset. The user may reset the 
switch now, but resetting the switch is 
disruptive to the fabric.
If this is acceptable, then continue. 
Otherwise, schedule an appropriate time 
during maintenance to reset the switch.

Table C-8. Load Firmware Dialog Messages 

Message User Action

Bad checksum/CRC for the firmware 
image or incorrect firmware image for this 
type of switch.

Select the correct firmware file for this 
switch.

File was not found. Verify that the firmware file specified 
actually exists, or specify a new firmware 
file.

Firmware image had a bad CRC or was 
invalid for this type of switch.

Select a valid firmware image for this type 
of switch and retry the operation.
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Firmware upload complete. The switch 
must be reset to activate new firmware. 
Reset now?

The new firmware will not be executed 
until the switch is reset. Resetting a switch 
in the fabric will cause the servers and 
storage systems attached to the fabric to 
lose communications until the switch reset 
is complete and the fabric has reinitialized. 
If this is acceptable, then continue; 
otherwise cancel the reset operation.

Firmware upload status unknown. Image 
has been uploaded, but confirmation from 
the switch was not received.

The application lost communications with 
the switch while the switch was unpacking 
the firmware image. If the problem was 
temporary, examine the firmware versions 
on the switch to verify that the firmware 
was unpacked correctly, or upload a new 
firmware image to the switch.

The flash memory on the switch may be 
too small for this image.

Select an appropriate firmware image for 
this type of switch and retry the operation.

Unable to load firmware. An unspecified error has occurred. Verify 
that the user has permissions to modify 
the configuration on the switch, that the 
switch is reachable in the fabric, and that 
the fabric is reachable from the user’s 
workstation, then retry the firmware 
upload.

Unable to read file. Verify that the firmware file specified exists 
and is readable by the user, on a file 
system readable by the user, or specify a 
new firmware file.

Table C-8. Load Firmware Dialog Messages (Continued)

Message User Action
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C.9
Port Loopback Test Dialog

Table C-9. Port Loopback Test Dialog Messages

Message User Action

Attempt to put port in diagnostic state has 
failed. Unable to continue with port test.

Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
change.

External port test requires a loopback 
device be plugged into the selected port. 
Click "OK" when loopback device is 
installed.

Verify that a loopback device is attached to 
the port before starting loopback test.

Failed to correctly restore port states for 
one or more ports.

Return to the faceplate view and select 
View>Port State to determine which port 
was not restored to its original state. 
Select the port, and then select Port>Port 
Properties to restore the port state.

Invalid frame count value.
Or
Invalid frame size. Must be 36 to 2148.
Or
Invalid hex pattern. Up to 8 hex digits 
allowed.

Verify that all information is valid and retry 
the loopback test.

No device detected in selected port yet. 
Test will not be run on empty port.

Verify that a loopback device is attached to 
the port before starting loopback test.
Verify that the port is online with an active 
login before starting the loopback test.

Request to get admin privileges failed. Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
telnet login, or any application, and then 
retry the operation.

Request to start loopback test failed.
Or
Request to stop loopback test failed.
Or
Request for loopback test results failed
Or
Request to reset loopback test results 
failed.

Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
change.
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Switch is currently unreachable. Unable to 
accurately report status of port test.

The application lost communications with 
the switch while the switch was running 
the loopback tests, and could not 
determine whether the tests completed. If 
the problem was temporary, restart the 
loopback tests.

The port selected for online port test must 
be online with active login.

Verify that the port is online with an active 
login before starting the loopback test.

Timed out on response notifications. Test 
terminated.

The application lost communications with 
the switch while the switch was running 
the loopback tests, and could not 
determine whether the tests completed. If 
the problem was temporary, restart the 
loopback tests.

Unable to perform loopback test on port ...
because port is not in diagnostic state.
because port is a donor port.
because there is already a port test in 
progress.
because there is already a port test in 
progress.

Correct the error indicated, and retry the 
loopback test.

Table C-9. Port Loopback Test Dialog Messages

Message User Action
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C.10
Extended Credits Dialog

C.11
Zoning Dialog

Table C-10. Extended Credits Dialog

Message User Action

Request for admin failed. Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
telnet login, or any application, and then 
retry the operation.

Request for extended credits failed Verify that the switch is reachable in the 
fabric, and that the fabric is reachable from 
the user’s workstation, then retry the 
operation.

Request to edit config failed.
Or
Request to save and activate config failed.

Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the operation.

Table C-11. Zoning Dialog Messages 

Message User Action

Error loading zoning Verify that the specified zoning 
configuration file exists on a file system 
that is reachable, and that the user has 
permissions to read the file.

Error returned from switch Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then refresh the zoning 
information from the switch to determine 
whether any of the zoning configuration 
has been applied.
If necessary, re-edit the zoning 
configuration and apply to the switch 
again.
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Error saving zoning Verify that the specified zoning 
configuration file exists on a file system 
that is reachable, and that the user has 
permissions to write the file.

Failed to obtain admin privileges Verify that another user is not currently 
modifying the switch configuration, using 
either the management application, or a 
telnet login, or any application, and then 
retry the operation.

Invalid name. Valid names start with a 
letter and valid chars include:

all alphanumeric chars [aA - zZ] [0 - 9]
symbols ['$', '_', and '-'

Select a valid name for the object and retry 
the operation.

Maximum number of zones created. Remove unnecessary objects from the 
zoning configuration and retry the 
operation.

No member(s) selected; nothing to add. Select the members to add, then retry the 
operation.

No response from the switch.
Or
Saving zoning data failed

Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then refresh the zoning 
information from the switch to determine 
whether any of the zoning configuration 
has been applied. If necessary, re-edit the 
zoning configuration and apply to the 
switch again.

The maximum number of members has 
been reached.
Or
The maximum number of members per 
zone has been reached

Remove unnecessary objects from the 
zoning configuration and retry the 
operation.

The Orphan set is a place a holder for 
zones that are not in a set. It can not be 
deleted.

Do not attempt to delete the orphan zone 
set.

Table C-11. Zoning Dialog Messages (Continued)

Message User Action
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The zone set you attempting to activate 
contains port based zoning and there are 
switches in the fabric that might not 
support this type of zoning. Some E_Ports 
may isolate. Do you wish to continue?

Not all switch vendors support port-based 
zoning. Consult the manual for these 
vendors’ switches to determine whether to 
apply this zoning configuration to the 
fabric.

The zoning configuration has been 
changed. Would you like to apply your 
changes?

The zoning configuration includes 
changes that have not been applied to the 
switch. Select Yes to apply the changes to 
the switch before continuing, or select No 
to discard the changes and continue.

There is already a zone by that name in a 
different Zone set. Would you like to add 
that zone to this Zone Set?

If the existing zone is the same as zone 
that the user wants to add to this zoneset, 
then continue. Otherwise, select a unique 
name for the new zone and retry the 
operation.

There is already a zone set with that 
name.
Or
There is already a zone with that name.
Or
There is already a alias with that name.

Select a unique name for the new object 
and retry the operation.

This zoning configuration exceeds the 
limits for this switch.

Remove unnecessary objects from the 
zoning configuration and retry the 
operation.

Unable to create alias. The zoning configuration already contains 
the maximum allowed zoning aliases. 
Delete any unwanted aliases and retry the 
operation.

You are about to save a zoning 
configuration that was not completely read 
in. Saving this version will make the 
incomplete database permanent.

An error was encountered while reading 
the zoning database from the switch, and 
so the database edited by the user may be 
missing some zoning information.

You have zones in the orphan zone set. 
These are not saved in the switch. Would 
you like to continue?

Orphan zones are not applied to the 
switch. If the orphan zones are to be 
applied to the switch, they must first be 
added to a configured zoneset. Orphan set 
is not saved on SANbox2 switches, and is 
used only in the application while 
configuring zoning information.

Table C-11. Zoning Dialog Messages (Continued)

Message User Action
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C.12
Restore Configuration Dialog

C.13
Save Fabric View

Table C-12. Restore Configuration Dialog Messages 

Message User Action

Failed parsing filename Verify that the file specified is a valid 
archive file, and retry the operation.

Possibly failed check switch! The application lost communications with 
the switch while restoring the archived 
configuration, and could not determine 
whether the operation completed. If the 
problem was temporary, retry the 
operation.

Restore failed! Verify that the user has permissions to 
modify the configuration on the switch, that 
the switch is reachable in the fabric, and 
that the fabric is reachable from the user’s 
workstation, then retry the configuration 
restore.

Table C-13. Save Fabric View

Message User Action

File “filename” already exists. Do you want 
to overwrite?

The specified view file already exists. 
Cancel, or continue to overwrite the file.
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C.14
Trap Configuration Dialog

Table C-14. Trap Configuration Dialog Messages

Message User Action

Invalid rising threshold
Or
Invalid falling threshold
Or
Invalid sample interval.

Verify that the information is correct and 
then retry.

You must wait for trap information to be 
read first.
Or
You must wait for alarm threshold 
information to be read first.

The application has not completely read in 
some configuration information which is 
needed for this operation. 

Wait until the information has been 
completely read and then retry.
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Notes
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Activity LED
A port LED that indicates when frames are 
entering or leaving the port.

Alias
A collection of objects that can be zoned 
together. An alias is not a zone, and can 
not have a zone or another alias as a 
member.

AL_PA
Arbitrated Loop Physical Address

Arbitrated Loop
A Fibre Channel topology where ports use 
arbitration to establish a point-to-point 
circuit.

Arbitrated Loop Physical Address (AL_PA)
A unique one-byte valid value assigned 
during loop initialization to each NL_Port 
on a Loop.

ASIC
Application Specific Integrated Circuit

BootP
A type of network server.

Buffer Credit
A measure of port buffer capacity equal to 
one frame.

Class 2 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports wit h acknowledgment provided.

Class 3 Service
A service which multiplexes frames at 
frame boundaries to or from one or more 
N_Ports without acknowledgment.

Domain ID
User defined name that identifies the 
switch in the fabric.

E_Port
Expansion port. A switch port that 
connects to another FC-SW-2 compliant 
switch.

Expansion Port
See E_Port.

Fabric Management Switch
The switch through which the fabric is 
managed.

Fabric Name
User defined name associated with the file 
that contains user list data for the fabric.

Fan Fail LED
An LED that indicates that a cooling fan in 
the switch is operating below standard.

FC-PLDA
Fibre Channel Private Loop Direct Attach

Flash Memory
Memory on the switch that contains the 
chassis control firmware.



Glossary-2 59022-05 B

SANbox2-8c/16 Switch Management
User’s GuideQ

Frame
Data unit consisting of a start-of-frame 
(SOF) delimiter, header, data payload, 
CRC, and an end-of-frame (EOF) 
delimiter.

FRU
Field Replaceable Unit

Heartbeat LED
A chassis LED that indicates the status of 
the internal switch processor and the 
results of the Power-On Self-Test.

Initiator
The device that initiates a data exchange 
with a target device.

In-Order-Delivery
A feature that requires that frames be 
received in the same order in which they 
were sent.

Input Power LED
A chassis LED that indicates that the 
switch logic circuitry is receiving proper DC 
voltages.

IP
Internet Protocol

LIP
Loop Initialization Primitive

Logged-In LED
A port LED that indicates device login or 
loop initialization status.

Management Information Base
A set of guidelines and definitions for the 
Fibre Channel functions.

Management Workstation
PC workstation that manages the fabric 
through the fabric management switch.

MIB
Management Information Base

NL_Port
Node Loop Port. A fibre channel device 
port that supports arbitrated loop protocol.

N_Port
Node Port. A fibre channel device port in a 
point-to-point or fabric connection.

Over Temperature LED
A chassis LED or a power supply LED that 
indicates that the switch or power supply is 
overheating.

POST
Power On Self Test

Power On Self Test (POST)
Diagnostics that the switch chassis 
performs at start up.

Private Device
A device that can communicate only with 
other devices on the same loop.

Private Loop
A loop of private devices connected to a 
single switch port.

SANbox Manager
Switch management application.

SFP
Small Form-Factor Pluggable transceiver
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Small Form-Factor Pluggable Transceiver
A transceiver device, smaller than a 
Gigabit Interface Converter, that plugs into 
the Fibre Channel port.

SNMP
Simple Network Management Protocol

Target
A storage device that responds to an 
initiator device.

VCCI
Voluntary Control Council for Interference

Worldwide Name (WWN)
A unique 64-bit address assigned to a 
device by the device manufacturer.

WWN
Worldwide Name

Zone
A named set of ports or devices that can 
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A
Access Control List zone 3-11, 3-23
account name 3-1, 3-3, 4-23, A-1, A-70
active zone set 3-9
Active Zoneset data window 3-9
Admin authority A-3
Admin command A-4
administrative state

configured 4-14, 5-9
current 4-14, 5-9
port A-38
switch 4-14, A-25

alarm
configuration 4-8, A-29
configuration display A-54
log 4-10, A-24, A-44

Alarm Log data window 4-8
alias

add members 3-25, A-5
copy A-5
create 3-24, A-5
delete A-5
delete members A-6
description 3-12
display list A-5
display members A-6
remove 3-25
rename A-6

Alias command A-5
Arbitrated Loop Physical Address A-38
authentication

trap 4-19
user 3-1

auto save
fabric view file 2-10
zoning configuration 3-13, 3-14

B
beacon 4-11, A-24
BootP 4-18

broadcast 4-15, A-44
browser

location 2-10
requirement 2-1

C
chassis

LEDs 4-3
status A-44

Command Line Interface A-1
command syntax A-2
commands A-3
Config command A-7
configuration

activate A-7
archive 4-21
backup 4-21, A-7
copy A-7
delete A-7
edit A-7
list A-7
reset A-19
restore 4-21, 4-22, A-8
save A-8

Configured Zonesets data window 4-7
contact 4-19
CRC error 4-9
credits 5-11

D
data window

Active Zoneset 3-9
Alarm Log 4-8
Configured Zonesets 4-7
description 2-16, 2-19, 2-22
Link 4-6
Name Server 4-3, 5-8
Port Information 4-7, 5-7
Port Statistics 4-6, 5-4
Switch 4-4
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tabs 2-16
database

fabric 3-3
zoning 3-16

date 4-11
Date command A-9
Decode error 4-9
default

configuration 4-23
visibility 3-13, 3-14

disk space 2-1
domain ID

conflict 3-12
description 4-14
lock 4-14

domains A-45
donor port 5-2, 5-10, 5-11, A-45
Dynamic Host Configuration Protocol 4-18

E
E_Port

isolation 3-15, 4-15
self-discovery 5-10

Error Detect Timeout 4-16
event logging

by component A-35, A-57
by port A-36, A-57
by severity level A-57
display A-57
restore defaults A-36
save settings A-36
settings A-57
severity level A-36
start A-37
stop A-37

expansion port 5-2
external test 5-13, A-64

F
F_Port 5-10
fabric

add 3-3
database 3-3

delete 3-4
discover interval 2-10
displaying information 3-7
loop port 5-2, 5-10
management 3-1
merge 3-15
port 5-2, 5-10
rediscover 3-4
status 3-7
tree 2-15
zoning 3-10

Fabric View
arrange graphs B-2
customize graphs B-3
start B-1

fabric view file
auto save 2-10
open 2-8, 3-4
password 2-8
save 3-4

faceplate display 2-12, 2-20
factory defaults 4-23, A-19
Fallback command A-10
Fan Fail LED 4-3
Fibre Channel address 3-22
firmware

fallback version 4-23, A-10
image file 4-23, A-13
install with SANbox Manager 4-23
list image files A-13
remove image files A-13
retrieve image file A-13
unpack image A-13
version A-49

FL_Port 5-10

G
gateway address 4-18
generic

loop port 5-2, 5-10
port 5-2, 5-10

graphic window 2-16
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H
hardware status 4-3
Heartbeat LED 4-3
help 2-11
Help command A-11
History command A-12

I
I/O Steam Guard 5-11
Image command A-13
inband management 3-2, 4-15
Input Power LED 4-3
internal test 5-13, A-64
inter-switch link 3-2
IP

address 4-18
configuration 4-18

ISL monitoring 4-9

L
link

delete 3-6
selecting 2-18
status 2-17

Link data window 4-6
link state database A-45
Lip command A-14
log

archive A-35
clear A-35
event A-35, A-57
power-on self test A-48

logged in users A-49
Logged-In LED 4-14
login

limit 2-8, 3-3, A-1
monitoring 4-9

logout monitoring 4-9
loop port A-14

fabric 5-10
generic 5-2, 5-10
translated 5-10

Loop Port Bypass A-38

Loop Port Enable A-38
loopback test 5-13
loss of signal monitoring 4-9

M
maintenance mode 4-23
management workstation 2-1
manufacturer information A-61
media status 5-4
memory

activity A-45
requirement 2-1

menu structure 2-13
messages C-1

N
name server

display A-45
export to file 4-11
zone 3-11

Name Server data window 4-3, 5-8
network

configuration reset A-19
discovery 4-18
interfaces A-45
properties 4-17

node-to-node test 5-13

O
online

help 2-11
test 5-13, A-64

operating systems 2-1
orphan zone set 3-20
Over Temperature LED 4-3
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